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Overview

This guide will teach you how to use the tools and features found within PlanSwift®
Takeoff and Estimating Software. All users must agree to accept and abide by the End
User License Agreement, which can be found at www.PlanSwift.com. This guide is not

meant to be a step-by-step “walk through” document, although it can be used as a
reference for getting the work done.

This guide consists of four sections. The first section is Key Features, which covers
managing jobs and pages, creating takeoffs and annotations, using shortcuts and
hotkeys, and integrating with Excel. The second section is Customizing PlanSwift, which
covers using templates, parts, and assemblies, estimating, creating reports, installing
plugins, and using some of the advanced features. The third section is Managing
PlanSwift Licenses, which covers activations and how licenses work. The fourth section
is FAQ, which covers frequently asked questions.

PlanSwift also provides a knowledgebase and videos in addition to this User Guide.

If you encounter technical difficulties, consult this guide (including the FAQ section of
this user manual) or contact the technical support department at:
PlanSwift® Technical Support
support@PlanSwift.com
1-888-752-6794 Ext. 2

PlanSwift also offers additional training. For training options, contact the training
department at:
PlanSwift® Training Department
training@PlanSwift.com
1-888-752-6794 Ext. 4



http://www.planswift.com/
https://support.planswift.com/support/solutions
https://www.youtube.com/user/planswift/videos
mailto:support@PlanSwift.com
mailto:training@PlanSwift.com

Key Features

PlanSwift Professional is an easy-to-use software platform due to its user-friendly
interface and features. The instructions in this section will guide new users through the
basics of starting a job, managing pages, performing takeoffs, creating annotations and
overlays, using specialty takeoff items, using shortcuts and hotkeys, and integrating
with Excel. We highly recommend purchasing a training package for accelerated
learning and faster customization.

The PlanSwift Professional Ul/UX utilizes the Windows Ribbon framework. Similar in
functionality and appearance to the Microsoft Office 2007 Fluent user interface, the
Ribbon framework is composed of a ribbon command bar that exposes the major
features of PlanSwift Professional through a series of tabs at the top of the application
window and a right-click context menu system.

PlanSwift Professional utilizes sidebars on the left and right sides of the main
application window. These sidebars can be resized, reordered, collapsed, or undocked
to maximize working space within the main application window.

PlanSwift Professional frequently utilizes “split buttons” inside the ribbon command
bar: these are a composite control from which the user can select a primary feature
from an upper button or select one of multiple secondary features from a drop-down
list below.



Managing Jobs

At the very top left corner of the PlanSwift window, you’ll see what is referred to as
the PlanSwift Button, which has the PlanSwift logo on it (Fig. 1-A).
1. Clicking on the PlanSwift Button gives you quick access to PlanSwift’s job
management tools:
Creating a New Job
Opening a Job
Printing a Job
Job Properties
Reloading a Job
Importing Jobs and Templates
Closing a Job
Exiting PlanSwift.
2. Onthe right side, it also provides a list of Recent Documents.

Home | page Tools View Estimating Templates Settings Reports Help Plugins search

Recent Documents

New
1 Comm Center - Main Building
2 Sample Plan
COpen Job .
3 Community Center Job - YourTown
4 Sample Plan -- Estimating Tab
Print

5 Sample Plan 2 -- Estimating Tab

B Sample Plan - User Guide Complete
Job Properties
7 Morms Nursery

& Miller Concert Hall
Reload Job
9 Happy Hollow Golf Course - Copy

A Happy Kids Day Care Center
Import Jobs and Templates

EO§&VFEmIMD

B 11111
c1n
Close Job
D Sample Plan - Zone Tool Plugin
E Rand Template - Rand Construction Template
Exit
E play - Play File
T TR
Figure 1-A



Creating a New Job

To create a new job:
1. To create a new job in PlanSwift, click on the New button in the Job Group of the
Home tab ribbon-bar (Fig. 1-B).
This opens a New Job dialog.
Enter a Job/Quote #.
Enter a description in the Description field.
Select the New Job Location.
Select the Measurement Type.
Click on Next to continue the dialog.

N o vk wDN

S Home e Tools View Estimating Lists Templates Settings Reports Help Plugins Iﬂll_l

sEn @« QAQQ Y = My

Mew | Open Print  Email Back  Fwd Zoom Fit Zoo Zoom Pan Scale  Dimension Area Llnear Se
Job Page Cut i

Job Mavigate Measure

Pages, Bookmarks “ || @ New Job 0 %

— -~ T

Search: | | by Enter the job # and descri select the Location' for the job. This is where the

: job information and digital will be stored,
FHE Al 1 Community Center - Sam... H
A1.2 Floor Plan - Samp... = &
A1.4Roof Plan - Sample Plans o= ITH s # E=erzime

A2, 1Exterior Elevation - Sample Plans |nmunity Center J°b| |Y°U|'T°U\|'l|
E1.0 Electrical Plan - Sample Plans
M2. 1 HVAC Plan - Sample Flans

L1.0 Landscape Flan - Sample Plans

C1.1Site Plan - Sample Plans H ﬁ

Mew Job Location: I MeasurementType:I

Local w English w

MNotes:

G b dodd PP

There is already a job with that job number!

A new folder will be created which will store the job information and plan image files:
C:%Program Files [#86)4PlanSwift] 050 atahStorages L ocals) obssCamnunity Center Job

7

E.E Show Me How

Caral

Figure 1-B



The next three dialog boxes and the Browse For Folder window shown in Figure 1-C
allow you to select the image files, change any conversion settings, and then create the
new job.

8. Click on Browse to open the Browse For Folder window

9. Navigate to and select the folder where your plans are located. Your plan files

could be stored either locally or on a network.

10. After clicking on Ok, the pages may be selected by clicking on the checkboxes

11. If you want all of them, click on Check All.

12. Click on Next.

& Mew Job - O bt 3 4.00

Image Files
Select the image files for the digital plans that you want on this job.

Folder: 1 Browse For Folder »

-] & 27855, 1950W. Seni
-[] = Azalia Flower Compa
-[] £ Battle Lines Tour Co
- Citizens Prime Bank
-] & Comm Center 2

-] & Community Center Job
- Community Center Job1
-[] = Community PlayYard P
- Happy Hollow Golf Co
-] = Happy Hollow Golf Co1
-[] = Happy Kids Day Care
- Imagine Concert Hall
- Imagine Concert Halll
-[] & Lexington Commerdial
- Miller Concert Hall

-] © Minja Karate Center
- Morms Nursery

-[] = rand's Warehouse
.11 Samnle Plan

| Cg\ Files (x86)Planswift 10'\Data\Storages\Local\Jobs - | Browse
- 123 M, Duplex Projec

- Desktop
@ OneDrive - Planswift Software LLC
a Dave Hansen
v [ This PC
_J 30 Objects
[ Desktop
@ Documents
Jr Downloads
J& Music
&= Pictures
m Videos
v g Windows (C)
Dave
PerfLogs
Program Files

W Program Files (x86)

E-E Show Me How Back

Make Mew Folder oK

Cancel

Figure 1-C
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13. The Convert Settings dialog window allows for the selection of conversion

settings (Fig. 1-D).
14. Select any settings you want and clic

k on Next.

15. Click on Finish in the Ready to Create Job dialog window to create the job. This

will load the job’s pages that you selected earlier.

D

@ Mew Job — O >
Convert Settings
Select the zettings for converting image files to be used by PlanSwift.

PDF

Convert FDF filez to TIF [ Recommended |
Grayscale (16 shades)
Other Formats
Corvert CAL files to TIF
]

Corert DUV files to TIF
“naote: PlanSwift will not be sble to load these formats if they are not converted.

Multi-Fage TIF
Split multi-page TIF files into separate files.

Large TIF files
Dawnsize large TIF files.

Fage Maming
Use Page Mame Default

=Us= [Titie] for the image title, [pg#] for the page number, and [-] for a dash if there is 3 page it
additionsl text a5 necessany to the formuls. Single images will not display a page number,

[Title][-IPg#]

Cancel

e

Ready to Create Job

FlanSwift iz now ready to create your new job. Click "Finizh" to continue,

PlanSwift is now ready to create your new job.

Once you dick "Finish™, PlanSwift will create the new job, copy image files, and then
open the new job.

Back

E-E Show Me How

E -E Show Me How Back

15

Cancel

Figure 1-D

16. Figure 1-E shows the name of the job at the top of the Main menu ribbon-bar.

-

PlanSwift Professional 10.2 - Community Center Job

o |

Owverlay  Image

[+

Annotations Mote

Highlighter

Annotations

Figure 1-E
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As you perform takeoffs on the Community Center job plans in PlanSwift, those
takeoffs are automatically saved. When you close PlanSwift and then reopen it, the last
job you were working on is automatically opened.

Opening an Existing Job

To open an existing job:

Click on the Open button on the PlanSwift Main menu ribbon-bar (see Fig. 1-F).
This will open the Open Job window.

Scroll to and click on the job you wish to open.

If you have a long list of jobs and know the name of the job, type the job’s name
into the Search field, and the jobs with that name will be displayed.

5. After selecting the job, click on Open Job to open the job.
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Figure 1-F
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Creating a SwiftJob

Jobs in PlanSwift can be saved and compressed by “zipping” them into a single file. ZIP
is an archive file format that supports lossless data compression. PlanSwift replaces
the typical .zip extension with a .Swiftlob extension for easy identification and
portability or for backup. The data that is saved includes all plan pages, takeoff data,
notes, bookmarks, attachments, and other data critical to the job. Zipping a Swiftlob is
equivalent to a “Save As” function: zipping a job does not remove (or delete) the job
from PlanSwift. To create a SwiftJob:

1. Click on Zip SwiftJob (Fig. 1-G).

2. Navigate to the location where the file is to be saved.

3. Give the zipped file a File Name.

4. Click on Save to zip the job.
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Figure 1-G
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The Unzip Swiftlob button allows the zipped files to be unzipped into PlanSwift. To

unzip a SwiftJob:

1. Click on Unzip Swiftlob (Fig. 1-H).
2. Navigate to the location where the zipped file is located.

3. After clicking on the file to be restored, its name will appear here.

4. Click on Open, and the file will be unzipped. A status bar will show the progress.
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Figure 1-H
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This opens the Import Swift Job window (Fig. 1-1).
Select the Job Location (Local or a network storage location).
Name the job.

Click on Ok to begin the importation.

0 o N oW,

If a job already exists in the same location with the same name, PlanSwift allows
job overwriting.

10. The Import Swift Job window shows the status of the job as it loads.

Import Swift Job = S

Job Location: o A job with this name already exists,
Local i Do you want to overwrite it?

Job Name:

.Cummunt.y Center Job

Import Swift lob >

Loading Ttems...

E1.0 Electrical Plan - Sample Plans

Figure 1-I
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Page Management

PlanSwift can import several types of image files, including PDF, TIFF, CAD, etc. Once
imported into PlanSwift, we refer to these image files as pages.

Setting the Scale

Accurate takeoffs require each page’s scale to be set correctly. PlanSwift provides
options for you to set the scale automatically or manually. When it is set automatically
or manually, your scale will only be as accurate as the image file you imported.

PlanSwift will not be held responsible for any loss
associated with improperly scaled pages.
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Setting the Scale Automatically

To set the scale automatically:
1. Click on the drop-down half of the Scale button (see Figure 2-A) to open a drop-
down menu that allows for setting the scaling automatically.
2. If your page has a scale value or you already know the value, select that value
from the drop-down menu. This will scale your page for both the X- and Y-axes.
3. Note that the Standard selection at the top of the drop-down menu is an
alternate way of opening the manual method of scaling.

4. These markers indicate whether the scaling has been added to the page and the
direction that it has been performed in (horizontally, vertically, or both).
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Figure 2-A
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5. Once the scale is set, it is highly recommended that you verify known
dimensions—both horizontally and vertically—on each page to ensure the scale
is set correctly. To verify the scale, the dimension tool is required. Click on the
Dimension button, then, using the crosshairs for alignment, click on two Points
of a marked vertical dimension (see Fig. 2-B), and a red dimension line and its
measurement will appear.

6. Then click another two Points of a marked horizontal dimension, and its
dimension and measurement will also appear. Press ESC to terminate the
Dimension tool. (The Dimension tool is covered under Adding and Specifying

Dimensions.)

Lists Templates Settings Reports Help Plugins

RQAQQY o = Mg i e K

lom Fit Zoom Zoom Pan Scale  Dimension Area  Linear Segment Count Single Send
Page In Qut ) ' u % Click ~ Data

Zoom / Pan Measure Takeoff

LOBBY

12'-9 1/2"

12-81/2°

Figure 2-B
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Setting the Scale Manually

To set the scale manually:

1. Click on the top half of the Scale button (Figure 3-A).

2. This opens the Scale window.

3. The Standard tab allows you to enter a known dimension (feet, inches, and
fractions of an inch.

4. Click the Apply Scale to all pages checkbox if you want the scale to be applied to
all pages.

5. Click the Automatically create dimension line checkbox if you want a dimension
line created.

6. Click on OK to move to the next step.

7. If you clicked on the Apply Scale to all pages checkbox, then a Warning box
appears to warn that applying this scale to all pages may cause errors in
measurements and calculations if all pages are not truly at the same scale. Pages
must support DPI, or they cannot be auto-scaled. Acknowledge the warning by
clicking OK.

Lists Templates Seftings Reports Plugins -

A QQ e 1 o K o/ |

oom Fit Zoom Zoom Pan Seale | Dimension Afea  Linear Segment Count Single end Ne Annaotations  Highlighter Note  Owerlay
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Warning
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B e |\ WARNING: Applying this scale to all pages may cause Ero

errors in measurements and calculations if all pages are
not truly at the same scale. If a page doesn't support
DRI, it will not be auto scaled.

Do you want to continue?

o | [ ]

Figure 3-A
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8. Click the first Point on the plan for the selected dimension. It may be helpful to
press the M hotkey to magnify the image to place the Point more accurately
(Fig. 3-B).

9. Click the second Point at the other end of the dimension.

10. After both Points are selected, and if you selected the Automatically create
dimension line checkbox, then a green dimension line and the dimension
measurement (in red) will appear. If you didn’t check the Automatically create
dimension line checkbox, then neither the dimension line nor the measurement
is displayed.

? X A

7![ l| a6 - 10"
=4 Click Mext Poink !|I
\ OIOII 5
'\_\ /
i
i 36' - 10" 5
‘e 36'-10 :]
|l N
Figure 3-B

Note: it is recommended that you scale your page in both the X-axis and the Y-
axis. The procedure is the same for the Y-axis as the X-axis, except that you will
choose a dimension in the Y-axis to scale.
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11. After a page has been scaled for both the X- and Y-axes, if you then attempt to
rescale the page, the Scale window will display a Clear Scale option to allow the
scale to be cleared (Figure 3-C). Clicking on Clear Scale and answering Yes to a
confirmation (Yes/No) question clears the scale value for the current page. The
Scale command can also be undone by clicking on the Undo command on the
Main ribbon-bar menu immediately after the scaling operation.

L4

Scale
Standard . F--5 L ketic
Feet Inch
| ¥
ﬂl DII

Atk

Fraction
"

[ ] &pply Scale to all pages. Clear 5 cale
Automatically create dimenzion line
Show Me
EFE o @ 0k x Cancel |
Figure 3-C
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12. The Auto tab in the Scale window (Figure 3-D) allows you to scale the page in

the same manner as you do when you click on the Scale drop-down menu. The
Auto tab allows you to apply an automatic scale to all pages, whereas the Scale

drop-down menu only does the current page.

13. The F-I-S tab in the Scale window is used by truss designers to input dimensions

in Feet, Inches, and Sixteenths.

14. The Metric tab in the Scale window allows for scaling in metric.
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Renaming Pages

PlanSwift allows you to rename pages individually or as a batch.

Renaming Individual Pages

Individual pages may be renamed from the Home, Page, Tools, or View tabs on the
Main ribbon-bar menu. To rename an individual page:
1. In the Pages, Bookmarks window, right-click the page to be renamed (Fig. 4-A).
2. Click on Properties on the drop-down menu.
3. This opens the Properties window for the selected page.
4. Enter the new name for the page in the Name field, then click on Ok. This
renames the page and closes the Properties window.
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Figure 4-A

23



Batch Renaming Multiple Pages

The Batch Rename Pages (Fig. 5-A) function makes renaming multiple pages easy. To

rename several files:

1.

0 0 N o

Go to the Pages, Bookmarks window and click on the page you want to start the
renaming process with.

. Click on the Batch Rename Pages button in the Rename/Sort group on the Page

tab of the Main ribbon-bar menu

This is the Batch Rename Tool window.

The current name of the page appears both in the Current: field and in the New:
field.

The directional arrows allow you to select the corner of the page to be shown in
the view.

Figure 5-A shows the bottom-right corner of the page selected.

Click on the New: field and type the new name.

Click on Save & Next to proceed to go to the next page.

If you want to view the previous page, click on Save & Prev. If there are any that
you do not want to rename, click on Save and Next (or Save & Prev.) without
providing a new name.
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Importing Additional Pages

Additional pages can be added to a job in either of two ways:
1. From the Home or Page tab, click on the green + in the Pages, Bookmarks
window, or
2. From the Page tab, click on the Add Pages button (Fig. 6-A).
Either of these actions opens the Add Pages window.
4. If you want to select a new page from existing image files, click on From Image
Files and click on Next. This opens the Image Files window (Fig. 6-B).
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Figure 6-A
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5. Click on Browse to locate the folder with the image files in the Browse for Folder
(Figure 6-B).

6. Click on OK after you click on the location.

7. Click on the checkbox (or boxes) for the image file (or files) that you want to add
to this job.

8. Click on Next.
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Figure 6-B
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9. This opens the Convert Settings window (Fig. 6-C). Make any changes in this

window.
10. Click on Next.

11. This opens the Ready to Add Files window.

12. Click on Finish to add the file.

# Add Pages

Convert Settings

Select the settings for converting image files to be used by PlanSwift,

“ Add Pages

{ Ready to Add Files

PlanSuwift iz now ready to add the selected pages to your job. Click "Finizh" to continue.

FDF
Convert PDF filez to TIF [ Recommended |

Other Formats
Convert CAL files to TIF
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Multi-Page TIF
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“Use [Title] for the image title, [pg#] for the page number, and [-] for 3 dash if there is &
additional text a5 necessany to the formula. Single images will not display 3 page number.

Planswift iz now ready to add the selected pages to your job.

Once you dick "Finish”, Planswift will convert the new image files, if needed, and copy them
into the job.

Show Me
How

g

Show Me
How

Figure 6-C
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13. If you want to add a blank page, click on Blank Page from the Add Pages
window (Fig. 6-D).

14. Click on Next.

15. This opens the New Blank Page window.

16. Enter the Name, Width, Height, DPS, and Scale.

17. Click on Finish to add the blank page.

18. If you want to use an image stored on your clipboard, click on From Clipboard,
then click on Finish. Whatever is stored on your clipboard will be placed on the
new page. If nothing is stored in your clipboard, then From Clipboard will not be

selectable.
“ Add Pages X “ Add Pages >
( Add Pages i !'New Blank Page
Select what type of page you would like to add i Enter infarmation for new blank page.

Name:

OFrom Image Files Width: Inches

(® Blank Page R
Height: |24 ~ Inches

From Clipboard .

DPI (50 =
t Scale: [1/4"=10" ~

Show Me Sh Me
| B How Concel | o Showh Back Cancel

Figure 6-D
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Creating Folders for Pages

To create a new folder for pages:
1. Click on the yellow folder button in the Pages, Bookmarks window (Fig. 7-A).
2. In the New Page Folder window, enter the name for the folder and click on OK.
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Adjusting the Page or Folder Order

To move a page or folder within a job:

1.

In the Pages, Bookmarks window, click on the page or folder to be moved and
drag the page (or folder) up or down to the location it is to go (Fig. 8-A).

If you want the page (or folder) to be placed inside a folder, click and drag it
until the folder you want it placed in is highlighted by a blue box, then release
the cursor.

If you want the page to be placed in-between either folders or other pages, click
and drag it until you see a blue line in between the items where you want it,
then release the cursor.
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Figure 8-A
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4. An alternate way of adjusting the page order is to click on the page reorder
button to open the Adjust Pages Order window (Fig. 8-B).

5. Click on the folder and use the four small arrow buttons to move folders up or
down and left or right in the hierarchy.

6. The large up and down arrow buttons move a selected file to the top or bottom

of the list.
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Managing Page Tabs

PlanSwift permits you to open multiple pages, each on a different tab, close the tabbed
pages, and undock tabbed pages so that different pages may be displayed on multiple
monitors.

Opening and Closing Tabbed Pages

To open a page in a new tab:
1. Right-click on any page (in this case the A1.1 Community Center page) in the
Pages, Bookmarks window to open a right-click menu (Fig. 9-A).
2. Click on Open in new tab option.
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Figure 9-A
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3. The Al1.1 Community Center now appears on two separate tabs (Fig. 9-B).
Clicking on either one of the tabs makes the clicked-on tab’s page active. Clicking
on a different page in the Pages, Bookmarks window opens the selected page in
the active tab. Takeoffs may be performed on any active tabbed page.

4. To close a tab, right-click on the tab to be closed and click on Close. Note that
clicking on New Tab on this right-click menu also creates a new tab but with a

blank page.
Pages, Bookmarks «“ 41.2 Floor Plan - Sample Plans Al.2 Floor Pla
o T Mew Tab
[ | T
+ OB NLOS s

Search: by Undock
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Figure 9-B

Undocking a Tabbed Page

To undock a tabbed page:
1. Right-click on the tabbed page you want to Undock to open the drop-down
menu (Fig. 9-C).
2. Click on Undock.
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Figure 9-C
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3. The undocked page appears in a new window (Fig. 9-D). Clicking and dragging
on the title bar of the undocked page allows you to drag it to another monitor or
wherever else you want it.
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To re-dock an undocked page back to a tabbed page:
1. Right-click on an undocked page to open a drop-down menu (Fig. 9-E).
2. Click on Close to dock the page back to a tabbed page.
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Performing Basic Takeoffs

Performing—or digitizing—a takeoff inside of PlanSwift Professional is easy. PlanSwift
has four basic measuring (or takeoff) tools, which are identified as takeoff items or
types: Area, Linear, Segment, and Count (PlanSwift also has specialty takeoff items
detailed in Accessing Specialty Takeoff Items).

Creating New Takeoff Items

Newly created takeoff items can be used for performing your takeoffs on the fly;
takeoff items can also be modified and saved as templates for future use in digitizing
your takeoffs. Creating templates is covered in Creating and Organizing Templates.

Area Takeoff

Area takeoffs are useful for calculating areas for concrete, carpet, flooring, roofing,
pavement, sod, grids, joists, etc. The top half of the Area button performs an area
takeoff. The drop-down half is a drop-down menu that provides area takeoffs with
more powerful functions, such as creating an area takeoff with a single click,
calculating area costs by the square foot, and performing area takeoffs for roofs, cubic
yards, grids, and joists. Area takeoffs may also include arcs, multiple measurements (or
sections), and cutouts (or subtracted sections). To perform an area takeoff:
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1. Click on the top half of the Area takeoff button (Fig. 10-A), or simply press 1 on

the keyboard.
In the Properties — [Area] window, enter a name for the area in the Name field.

Select a Color for the takeoff.
Select a Fill Type. It can be Solid, Hatch Pattern, or Texture; then click on Ok.

Digitizer Record is now turned on.
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9.

Click where you want the Area takeoff to begin. This will establish the first Point,
which is the starting Point of the takeoff item (Fig. 10-B).

Move to the next Point and click again. Note that a blue line appears while in
Digitizer Record mode. Note also that pressing Ctrl + Z will undo any Point’s
placement.

Move to the third Point and click. You now see the color of the takeoff that you
selected.

Move to the fourth Point and click.

10. Right-click at the fourth Point and select Stop from the right-click menu (or

press the Esc key or click on the Digitizer Record button or press C on the
keyboard) to turn off record and complete the takeoff.

The right-click menu gives you another option, which is New Section. Selecting
New Section also stops the takeoff you just completed, and it then allows you to
move to a new section and continue the takeoff just as if you are at Step 6 again.
This “new section” takeoff is a continuation of the first takeoff.
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Figure 10-B

38



11. Figure 10-C shows two area sections (12 and 13) totaling 832.9 SQ FT.
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Figure 10-C

Note: There are two modes for performing area takeoffs. The default record mode is
Record: Point-to-Point. The alternate mode is Record: Box-Mode, which allows you to

simply click and drag a box (or click two Points to form a box) when the digitizer is
turned on. This mode can only be changed when the Digitizer Record is on and is

toggled between the two modes by clicking the Record Mode button located at the
bottom of the main window (Fig. 10-D).
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Figure 10-D
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Linear Takeoff

Performing a Linear takeoff is like performing an area takeoff. Linear takeoffs are

useful for calculating materials such as gypsum board, studs, fencing, siding, masonry,

piping, HVAC ducting, electrical runs, linear cubic yards, etc. Linear takeoffs may

include arcs and multiple measurements (or sections). To perform a linear takeoff:
1. Click on the top half of the Linear button on the Home tab menu or press 2 on

the keyboard (Fig. 11-A).

This opens the Properties — [Linear] window.

Give the linear takeoff a name.

Select a color for the takeoff.

Click on Ok to begin the takeoff.

Move the cursor crosshairs to the first Point of the takeoff.
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7. Press the M key on the keyboard to magnify the Point for greater accuracy and
click on the location where you want to begin the takeoff (Fig. 11-B).

8. Click on the second Point, using the magnifier as needed.

9. Click on the third Point to perform the linear takeoff. Note that pressing Ctrl + Z
will undo any Point’s placement.

10. Click on the fourth Point.
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Figure 11-B
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11. Click back at the beginning Point, then right click and click on Stop on the drop-
down menu or press C or Esc on the keyboard to close the linear (Fig. 11-C).
12. The red line depicts the linear takeoff and is 77.1 feet in length.
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Note: There are two modes for performing linear takeoffs. The default record mode is
Record: Point-to-Point. The alternate mode is Record: Box-Mode, which allows you to
simply click and drag a box (or click two Points to form a box) when the digitizer is
turned on. This mode can only be changed when the Digitizer Record is on and is
toggled between the two modes by clicking the Record Mode button located at the
bottom of the main window (Fig. 11-D).
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Segment Takeoff

Performing a Segment takeoff is like performing a linear takeoff. Segment takeoffs are

used for calculating any segmented items, such as beames, joists, segment cubic yards,

wall areas, hip-valley, etc. Segment takeoffs are performed with one or more single-

line measurements (or sections) and may include arcs. To perform a segment takeoff:

1.

o v A WD

Click on the top half of the Segment button on the Home tab menu or press 3 on
the keyboard (Fig. 12-A).

This opens the Properties — [New Segment] window.

Give the segment takeoff a name.

Select a color for the takeoff.

Click on Ok to begin the takeoff.

Move the cursor crosshairs to the area of the takeoff.

{G) Home | page Tools View Esti

— *
=
New Open Print  Email

Job

Job Mavigate

Back  Fwd

Zoom

Lists

Fit
Page In
Zoom / Pan

Qaaq

Zoom Zoom  Pan

Out

Reports Help Plugins Eﬂy

o aplq[ ¥ B

Area  Linear | Segment | Count

o
(47

Scale  Dimension
- Click ~  Data

Measure Takeoff

Single Send

Pages, Bookmarks «

T+ LOS

' A1.1 Community Center - Sam...
dl| A1.2Floor Plan - Sample Flans =

832.9 s
: I:I Game Room Linear 771
Al.4RoofPlan - Sample Plans

2.1 Exterior Elevation - Sample Plans
1.0 Electrical Plan - Sample Plans

12. 1HVAC Plan - Sample Plans

1.0 Landscape Plan - Sampl...
C1.15ite Plan - Sample Plans H

all g%

LR i R

o P

e#l

I
|

*

N

Mame
‘Parkmg Lot Lines Segments ‘

Calar Fill Type

Solid

older:

Input

-

Ok Cancel

Advanced E.E

Figure 12-A

43




7. Click on the beginning and end of each parking lot line, treating each as an
individual segment. Press M on the keyboard if you wish to magnify the area for
more accuracy (Fig. 12-B). Note that pressing Ctrl + Z will undo any Point’s
placement.

8. The completed segments are shown to the right.
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Count Takeoff

Performing a Count takeoff requires familiarity with performing an area takeoff. Count
takeoffs are useful for counting items such as electrical sockets, lighting fixtures, fans,
doors, vents, trees, etc. To perform a count takeoff:

1. Click on the top half of the Count button on the Home tab menu or press 4 on
the keyboard (Fig. 13-A).
This opens the Properties — [New Count] window.
Give the count takeoff a name.
Select a color for the takeoff.

vk wn

Select a shape for the count item. Shapes to choose from are Circle, Square,
Triangle, Plus, or Diamond. Keep Circle as the choice.

Click on Ok to begin the takeoff.

Move the cursor crosshairs to the first item to be counted for the takeoff and

o

click on the item. Here you will do a tree count takeoff.
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8. Click on the remaining tree items and press Esc to stop the takeoff (Fig. 13-B).

Note that pressing Ctrl + Z will undo any Point’s placement.

9. The tree count takeoff value is 20.
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Creating a New Section of a Takeoff Item

PlanSwift provides two ways to create new sections of existing takeoffs. The first way
creates a New Section on the current page using the New Section button. The second

way allows you to use a Continue With tool to create new sections on any pages

(including your current page) and have all of the takeoff values roll up into one total or
be broken down into totals for each page. Performing either New Section or Continue
With takeoffs requires familiarity with performing an area takeoff.

Creating a New Section using the New Section button

The New Section button allows you to quickly add one or more new sections to an
existing area, linear, segment, or count takeoff on the same page.

To perform a New Section area takeoff:

1. Select the takeoff item that you want to add a new section to by clicking on it
(Fig. 14-A).

2. Click on the top half of the New Section button on the Home tab (or press
the N key on the keyboard, or right-click on an area you want to add a new
section to and select New Section from the drop-down menu, or double-click
on the takeoff item) to start a new section.

3. Digitizer Record is now turned on.

4. Perform the takeoff the same as you would perform an area takeoff.

5. Click on the Digitizer Record button to turn off record and complete the
takeoff. Pressing the Esc key or right-clicking and selecting Stop from the
right-click menu may also be used to turn off record. Note that pressing Ctrl +
Z will undo the last Point’s placement.
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Creating a New Section on a Different Page Using Continue With

The Continue With feature allows you to quickly add one or more new sections to an

existing area, linear, segment, or count takeoff on a different page (or pages) and keep

a running total of the measurements.

1.
2.

Go to the page (the A1.2 Floor Plan) where you want to takeoff the new section.
In the Pages, Bookmarks window, hover over a takeoff (Tile Floor) that is on a
different page until the green “Continue With” button appears, and click on the
green button.

. This turns on the Digitizer Record button. Perform the takeoff on the A1.2 Floor

Plan.

The new Floor Tile takeoff section now also appears on the A1.2 Floor Plan.
Note that the first Floor Tile takeoff section measures 830.0 square feet and the
second one measures 127.3 square feet.

Open the Takeoff Summary sidebar window.

The total (830.0 + 127.3) of both sections is now displayed, which equals 957.23.

Takeoff Summary «
Pages, Bookmarks « P ==
“+toucLOe 3 emTETEEes
Search: rat ' seere x
Single  Send [ Digitizer | mew [ A1.2 Floor Plan - Sample Plans -
FFMllleA 1, 1 Community Center - Sample Plans Click ™ Data Record ™ | Section ™ y
(238 §A1.2 Floor Plan - Sample Plans Record g E°mm?'; FRoom ng';; = :j (<]
" — -~ Carpet Brown .
g Carp.et Brown 1702.5 sqFr . -] Carpet Brown y,702.50 [l
11 Footing 526 M 11 Footin 2,60 W
’Q Roof Area 3.0 = Pa Book k & 83 s i )
03 Rest Room Tie ORI ges, Bookmarks Roof Area 3,794.25 ¥
! N 4 7 Rest Room Tile .55 Il 0
1" outSide Wall Area 2697.8 s T 9 T4+ O® = '
e ® 3-6 Door Cut Out 1167sgrr Il 9 E ame Y
& ® 6-0 by 8 Door Cut Out 96.0 sg T o] Search: x = II:J:T\E;E ent E'Eg = ’ |
£ Conference Room Carpet w28 MY FHEl] AL 1 Community Center - Sample Plans = E OuiSidegWaII Area 2 597IS4 :j
. AL.3 Floar Plan - Sample Plans H G- 9 E‘ A1.2 Floor Plan - Sample Plans o g e b Exterior Wall Area Cutout :212:?0 [ | =
- v [ Carpet Brown 1702550 R W I )
e IR S pveean omd
&l A2.1Exterior Elevation - Sample Plans & 7 Roof Area 3.0 -] : 030 by & Doar Cut Out DIDD )
-l E1.0 Electrical Plan - Sample Plans H -+ | 37 Rest Room Tile 299 Y : * Tree Znunt ZDIDD ] j
(&l M2.1 HVAC Plan - Sample Plans = ! ~1°1 outside Wall Area 2697.8 so T J f: Livear 26,50 — s,
] L1.0 Landscape Plan - Sample Plans [ + * 3-6 Door Cut Out 1675 MY L] Conference Room Carpet 4‘32‘}'6 = :j
-l C1.1site Plan - sample Plans H 4 M3 * 6-0 by 8 Door Cut Out 96.0 s T v 5 Area P oluo e
M onference Room Carpet 4928 W £ Tile Floor 95?' 23 o
| B8k ile Floor 1273sorr IR ® ) b
=Ii&ll A1.3 Floor Plan - Sample Plans [ | e — “‘
m Tile Floor 830.0 sq T ¥ foocsCacianagks
fl 41,4 Roof Plan - Sample Plans o @ i+ Takeoff Summary
[l A2.1Exterior Elevation - Sample Plans & | Notes
[&ll] E1.0 Electrical Plan - Sample Plans -
[&ll] M2, 1 HVAC Plan - Sample Plans 1 0
# ﬂ L1.0 Landscape Plan - Sample Plans e P
’ﬂ C1.1 Site Plan - Sample Plans H &

Figure 14-B

49



The Continue With option is also available on two different right-click menus:

=

With.

w N

Either of these opens the Continue With window.

D

that you can perform a new section takeoff.

. Or right-clicking anywhere on a page and selecting Continue With.

Right-clicking on any existing takeoff item (Fig. 14-C) and selecting Continue

. Click on the takeoff item (Tile Floor), then on Ok to turn on Digitizer Record so
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Subtracting from Sections

Performing a Subtract from Section takeoff requires familiarity with performing an
area takeoff. Subtracting from sections is useful for subtracting areas for things such as
islands, countertops, planters, etc. There are two ways to cut out sections. One is with
a “Point-to-Point,” and one is with a Box.

Subtracting Using Point-to-Point (P2P)

To subtract from a section using Point-to-Point:
1. Select the area (by clicking on it) that you want to subtract a section from (see
Fig. 15-A).
2. Right-click to display the drop-down menu and select Subtract from Section
(P2P).
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3. Perform a takeoff around the area to be subtracted from that section (Fig. 15-B).
Note that pressing Ctrl + Z will undo any Point’s placement.

Figure 15-B
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Subtracting Using Box

To subtract from a section using Box:

1. Select the area (by clicking on it) that you want to subtract a section from (see
Fig. 15-C).

2. Right-click to display the drop-down menu and select Subtract from Section
(BOX).
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Figure 15-C

3. Click and drag a box over the area to be subtracted from that section. Multiple
boxes may be drawn to subtract areas. Pressing Ctrl + Z will undo any Point’s
placement. Press Esc or right-click and select Stop or click on the Digitizer
Record button to stop the takeoff (Fig. 15-D).

Figure 15-D
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Copying and Pasting Takeoff Items

Area, linear, segment, and count takeoff items can all be copied and pasted. Copying
and pasting takeoff items require familiarity with performing takeoffs and can save
considerable time in performing repetitive takeoffs. One or more items can be selected
and copied either into an existing item or into a new item. Items can also be copied at
specified increments in any direction (from 0 to 360 degrees). Pasted items may need
to be moved. Moving items is covered in Moving a Takeoff Item.

Copying and Pasting One or More Takeoff Items

To copy one or more items:

1. Select the item or items you want to copy by either clicking on them while
holding the Shift or Ctrl key or by dragging a box over the items (Fig. 16-A).

2. Right-click on one of the selected items and select Copy from the drop-down
menu to copy the items.

3. Right-click on the upper-left Point where you want the new item to be pasted.

4. Click on Paste to open the Confirm Copy Section window.

5. If you want the copy to be pasted into the same item, select Paste sections into
same item. If you want it pasted into a new item, select Paste sections into a
new item.

6. Click on Ok to paste the stored item or items.

7. The copied items appear at the location clicked on in Step 3.
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Using Linear Copy to Paste Takeoff Items in a Specified Direction

Performing a linear copy and paste is Initiated only by a hotkey. To copy a takeoff item

(or items) and paste them in a specific direction:

1.

O 0N W;

Select the takeoff item (or items) to be copied (in this case a linear parking
diagonal line) (Fig. 17-A).

. Press Ctrl + Right Arrow key on the keyboard to open the Move Objects

window.

. Enter the distance to the right that you want the copied item to be placed (this

can be determined using the Dimension tool if you do not know the distance).
These parking lines are 9’ 3-7/8” apart.

Enter the angle that the copies are to be laid out. The Right-Arrow key is 0
degrees, Left is 180, Up is 90, and Down is 270; any angle, such as 95 or 187
degrees, is also acceptable. For this example, use 0.00 degrees.

Click on Ok.

In the Linear Copy window, enter the number of copies of the item (10).

Click on Ok.

The ten linear takeoffs are now copied.

The total linear value of the 11 parking diagonals is 221.7 FT.
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Manipulating Points
Using Snap, Ortho, Freehand, and Verify Points

1. The Snap, Ortho, Freehand, and Verify Points tools are at the bottom of the
PlanSwift window. They can be clicked on at any time to toggle them on
(highlighted) or off (un-highlighted) (Fig. 18-A). Each of them is discussed below.

3 Takeoff Summary

. Notes

o

|3333.9, 4168.0 | Snap. |0\rthn |FreeHand |Verify Poin

Figure 18-A

Using Snap

Snapping is useful for creating takeoffs using Points from previously created takeoffs
or CAD drawings. To turn on Snap, click the Snap button or press F3 on the keyboard.
Snap, when turned on, snaps the cursor to the nearest Point when your cursor
crosshairs get close to that Point. When a Point is snapped to, a red square marker
appears on that Point. When that marker is visible, clicking will automatically match
your new takeoff to the existing Point (Fig. 19-A). Note: snapping works only for
existing Points created in PlanSwift and for CAD Points on imported CAD drawings but
will not work for vector Points on imported PDF or TIFF drawings.
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Figure 19-A
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Using Ortho

Ortho makes it easy to keep lines at 90-degree or 45-degree angles. To turn Ortho on,
click the Ortho button or press F8 on the keyboard. Note: Ortho can be temporarily
enabled or disabled anytime by holding the Shift key on the keyboard. With Ortho
turned on, when you begin to get close to either a 90-degree or a 45-degree angle, the
cursor automatically jumps to the 90- or 45-degree position. In Figure 20-A, if the
cursor is moved any closer to the 90-degree horizontal wall than it already is (see #1),
then it will automatically jump to the wall (see #2). Observe that the cursor is just a bit
closer to the wall (see #3) than it was for #1. Ortho makes it easy to ensure that
vertical lines stay vertical and horizontal lines stay horizontal.

FI:; Click Next Point [
10'4 1/8"

[*1 Click Nexet Point [EEEET
11'8 7/16"

Figure 20-A
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Using Freehand

Freehand can be useful for curved areas, such as bushes or gardens or even electrical
wires where a freehand style might be useful. It is only available for use with Area and
Linear takeoffs. To perform a freehand takeoff:
1. Click on the Freehand button to toggle freehand to on (Fig. 20-B).
2. Click on the Linear takeoff button (or click on Area to do an area freehand).
3. Enter a name for the electrical circuit in the Properties — [Linear] window (for
areas it is the Properties — [Area] window.
Select a color for the takeoff.
5. Click on Ok.
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Figure 20-B
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6. Click on the beginning of the electrical wire and hold the mouse button down
until “Freehand” appears and begin moving your mouse freehand (Fig. 20-C).
Note: if you make a mistake, release the mouse button, then press the
Backspace key on the keyboard as many times as necessary to correct the
mistake; to continue freehand, hold down the mouse button as before.

7. Complete the freehand drawing and press Esc (or the C on the keyboard or right-
click and select Stop from the drop-down menu) to end the takeoff.

8. The takeoff measures 22.7 FT.
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Figure 20-C
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Using Verify Points

Verify Points can make takeoffs more accurate. To turn on Verify Points, click Verify
Points or press F6 on the keyboard. Verify Points will not work with Freehand enabled.
With Verify Points enabled, each time you digitize a Point, a window will pop up called
Verify Entry. The Verify Entry window (Fig. 21-A) has two tabs that allow you to specify
distance and angles in two ways:

1. The Horizontal & Vertical tab allows you to specify by horizontal and vertical
distances. In Figure 21-A, the roof line takeoff (see #3) in blue measures 24’ 8”
horizontally and 10’ 4” vertically. If you want to change the values, enter the
new values and click on Ok.

2. The Angle & Distance tab allows you to specify by slope angle and slope
distance. In Figure 21-A, the roof line takeoff (see #3) slope distance is 26" 9”; its
slope angle is 22.7 degrees. If you want to change the values, enter the new
values and click on Ok.

Verify Entry r/‘ n Verify Entry !/' n

Horz. B Vert, Distance * Angle B Distance Horz. B Vert, Distance  Angle B Distance
T IR |9 Bl Elo E
T fe do i AT
e

= =]
=
/'l/

Figure 21-A
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Moving Points

PlanSwift provides a way to move a Point to a specified location. To move a Point:

1. Click on the Point you want to move, then click on an Arrow key on the
keyboard that corresponds to the direction you want the Point to be moved (in
this case the right-arrow key) (Fig. 22-A).

2. This opens the Move Points window.

3. Enter the distance in feet, inches, and fractions that you want the Point moved
to the right. In this case, enter 2/, 0”.

4. To change the angle, enter the angle in degrees in the Angle field. Enter 22.

5. Click on Ok.

6. The Point is now moved to the peak of the roof.

Maove Points >
Standard | F-1-5 " Metric
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Figure 22-A

64



Moving a Takeoff Item

PlanSwift provides several ways to move one or more takeoff items. This is particularly
useful after copying and pasting a takeoff item and it isn’t in the correct position.

Moving Takeoff Items to a Specified Location

To move takeoff items to a specified location:

1. To select a takeoff item, click on the item you want to move. To select multiple
items, hold Shift and click on each of the items (either in the Pages, Bookmarks
window or on the drawing itself), or click and drag the cursor over the items to
select them. Click on an Arrow key on the keyboard that corresponds to the
direction you want the items to be moved (in this case the right-arrow key) (Fig.
22-B).

2. This opens the Move Objects window.

3. Enter the distance in feet, inches, and fractions that you want the Point moved
to the right. In this case, enter 2’”.

4. To change the angle, enter the angle in degrees in the Angle field. Leave this
value at zero.

5. The takeoff of the two items is now moved to the right 2’.
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Figure 22-B
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Moving Items with the Mouse

To move items with a mouse:
1. Select the takeoff item or items as described under Moving Takeoff Items to a

Specific Location.

2. Hold down the Alt key, left click on the item (or items), and drag the mouse to
move the item or group of items to a new location.

Moving Items Using the Right-Click Menu’s Move Selection

To move items with the right-click menu move selection:
1. Select the takeoff item or items as described under Moving Takeoff Items to a
Specific Location (Fig. 22-C).
2. While holding the cursor directly over one of the selected takeoff items, right-
click the mouse to open the right-click drop-down menu.
3. Select Move from the drop-down menu.

4. Left-click and hold on any of the selected items and drag the mouse to move the
item or items to a new location.
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Figure 22-C
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Establishing Points While in Digitizer Record Mode

PlanSwift allows you to specify the distance and angle of the next Point for an Area,
Linear, Segment, or Count takeoff using the Add Line command:
1. The Digitizer Record must be on (showing red).
2. After clicking to establish a Point for a takeoff, press an arrow key to establish
the general direction of the next Point. This opens the Add Line window (Fig. 22-
D),
3. Enter the distance and angle of the next Point.

N o/

Send | Digitizer | MNew Annotations  High
Data Record ™ N -
Rec
Add Line x

Standard “LF-I-5 . Metric

Feet Inch

angle: 0.00 |

[] offset paint (Do not draw line)

v ok x Cancel

Figure 22-D

Creating Arcs with Areas, Linears, and Segments.

Creating an arc line requires familiarity with performing an area takeoff. Areas, linears,
and segments may all utilize arcs, and the method for creating arcs is the same,
whether it is an area, liner, or segment arc.
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Area Arc

To perform an area arc:

1. Click on the top half of the Area button on the Home tab (Fig. 23-A).

Enter a name for the takeoff.
Select a color and click on Ok to begin the takeoff.
Click on the first Point.

vk wn

Click on the second Point, which begins the first arc, then press the A key on the

keyboard. Note that pressing Ctrl + Z will undo any Point’s placement.

o/

Click on the middle of the arc for the third Point.

7. Click on the fourth Point, which is the end of the first arc (this creates a smooth

arc line).
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8. Click on the fifth Point, which completes the straight line to the second arc and
press the letter A again (Fig. 23-B).

9. Click on the middle of the arc.

10. Click at the end of the arc (this completes the second arc).

11. Complete the straight line and press the letter A again.

12. Click on the middle of the final arc.

Al F'u:uint|

I 7
31'3 51'!8" | {1l 3'0 7/8"

/

/

.'Iﬂ T

e ?.'I -
/ ;f
/ /
/ ’ /
/ /
!

Figure 23-B
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13. Complete the takeoff by pressing the Esc key (or by clicking on Digitizer Record
button or by right-clicking and selecting Stop from the drop-down menu or by
pressing the letter C on the keyboard) (Fig. 23-C).

14. Click on the takeoff again, and each of the arc Points is visible.

Figure 23-C
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Linear and Segment Arcs

Drawing linear and segment arcs work identically to an area arc, except that you select
top half of the Linear button or the top half of the Segment button on the Home tab
menu.

Creating Closed Circles with Areas and Linears

PlanSwift makes drawing area and linear circles simple. To draw a linear circle with a
50-foot diameter:

1. Click on the top half of the Linear button on the Home tab ribbon bar (Fig. 24-A).
This opens the Properties - [Linear] window.
Enter a name for the linear circle.
Select a color for the item.

vk wn

Click on the Point where the circle is to begin (we’ll place this linear circle over a
50’ dimension line.
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Figure 24-A
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6. Press the A key on the keyboard to specify an arc, and then click on where the
circle diameter should extend to (Fig. 24-B). This defines the middle Point of the
circle’s arc. The diagram shows the magnifier (pressing letter M on the
keyboard) being used to more accurately place the middle Point.

7. Move the cursor anywhere off that Point and then press the C key to close the
arc.

8. The linear circle is completed and closed.
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Figure 24-B

72




Creating Annotations

Annotations such as dimensions, notes, legends, revision clouds, rubber stamps, sticky

tabs, highlights, and images can be very helpful when estimating. Default settings for
label, note, dimension, legend, and highlighter annotations may be changed under
Annotations in the Settings tab of PlanSwift.

Adding and Specifying Dimensions

The Dimension tool is useful to determine dimensions or to specify dimensions of most
any aspect of items on plans or pages. Note that the Dimension tool does not store
measurements in a way that is practical to use for estimating. When doing takeoffs,
use the Area, Linear, Segment, and Count tools, not the Dimension tool, to digitize
and store measurements on pages.
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Adding Dimensions

To add a dimension:

1. To add a dimension for a section of a building, click on the Dimension button on
the Home tab ribbon-bar (Fig. 25-A).

2. Click on the first Point, using the crosshairs to line up the dimension. It may also
be helpful to press the M key on the keyboard to magnify the area for a more
accurate dimension.

3. Click on the second Point of the dimension to complete that dimension. You can

now click a new Point to start another dimension or press Esc to end the
dimension tool.
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Figure 25-A
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Specifying Dimensions

To specify a dimension:

1.

To specify a dimension, click on the Dimension button on the Home tab ribbon-
bar (Fig. 25-B).

2. Click on the first Point where you want the dimension to begin.

Click on an Arrow key (Right, Up, Left, or Down) on the keyboard for the general
direction that you want the dimension line to go. This opens the Add Line
window.

Enter the distance in Feet, Inches, and Fractions of an inch for the dimension.

If you selected the Right arrow key in step three, the Angle field will display as 0.
Up would display as 90 degrees, Left as 180 degrees, or Down as 270 degrees.
Alternately, you can enter any value between 0 and 360 degrees into the Angle
field.

If you want to offset the dimension, check the Offset point box.

Click on Ok to draw the dimension line. If you clicked on the Offset point box,
then the dimension line will not be drawn; rather, the starting Point will be
offset by the Feet, Inch, Fraction value, and you can now press an Arrow key
(back to Step 3) to begin the dimension line from the new offset location.

A dimension line specified at 35’ 8” and 10 degrees is shown.
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Figure 25-B

Adding Notes

The Notes tool is useful to place notes on pages. To create a note:

1.

vk W

Click on the Note button in the Annotations group on the Home tab ribbon-bar
(Fig. 26-A).

Click and drag over area where you want to place the note.

This opens the Properties — [New Note] window.

In the Text field, type the text of the note.

Most of the fields are self-explanatory. Enter the text size (in pixels) or use the
default of 1. Note the default text sizes can be changed in the Settings of
PlanSwift.
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6. Click on the Scaled checkbox if you want the note’s text size to be scaled to the
scale of the page.

7. The Auto Size checkbox automatically sizes the note to be no larger than needed
for the note itself.
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Figure 26-A
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Showing a Legend

Legends containing takeoff names and values may be placed anywhere on a page. By
default, the legend is not displayed. The default can be changed in the PlanSwift
settings. To display the legend:

1. Right-click on any non-takeoff area on the page (Fig. 27-A).

2. From the drop-down menu, click on Show Legend to display the legend.

3. The legend appears in the bottom-left corner of the plan.

4. The size of the legend can be changed by clicking on the legend and dragging any
of the eight selectable Points. It can be moved by clicking and dragging on it.
Clicking on it and pressing delete allows you to delete the legend. Pressing Ctrl +
Z will undo any action performed on the legend.
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Adding Revision Clouds, Rubber Stamps, Sticky Tabs,
Highlights, and Images

Revision clouds, rubber stamps, sticky tabs, highlights, and images allow for

considerable flexibility in annotating your pages.

Adding Revision Clouds

A revision cloud is used to indicate that certain areas of a drawing contain revisions. A
revision cloud may include a date/time stamp. To create and use revision clouds:
1. Click on the top half of the Annotations button
2. Or click on the bottom-half of the Annotations button, then Revision Clouds,
and then Revision Cloud) (Fig. 28-A).
3. Click on four Points defining the size of the cloud.
4. Press the Esc key or the C key to complete the cloud. Pressing Ctrl + Z will undo
any Point placements.
5. Clicking on Configure Revision Clouds allows you to specify a time stamp and
change other properties of the cloud.

PlanSwift Professional 10.2 - Sample Plan

© / g e

tations | Highlighter MNote Overlay Image

w3 Configure Revision Clouds...
|® Revision Cloud

l Revision Cloud i

d Section
Record

Revision Clouds »
<" Rubber Stamps  »
Sticky Tabs

»

/""-.
/ ] 12
; 1 12 > . .
=7 S
(=) Click Mext Point
10'8 15/16" |
NS
Figure 28-A

79



Adding Rubber Stamps

Rubber stamps are a great way of indicating progress, approvals, updates, etc.
PlanSwift provides several pre-formatted ones and permits the addition of a date/time
stamp as well. You can also add new stamps and delete stamps. To create and use
rubber stamps:

1. Click on the drop-down half of the Annotations button on the Home tab ribbon-
bar and hover over the Rubber Stamps selection until its submenu appears (Fig.
28-B).

2. Click on the desired stamp.

3. Click on the page where you want the stamp to appear. Examples of default
stamps are shown.

4. If you want to reconfigure any of the rubber stamps or add stamps of your own
design, click on Configure Rubber Stamps selection, and a range of options are

available.
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Adding Sticky Tabs

Sticky tabs are arrows with labels and may also include a date/time stamp. You can
choose from default ones or create your own and attach notes to them. To create and
use sticky notes:
1. Click on the drop-down half of the Annotations button and click on Sticky Tabs
(Fig. 28-C).
2. Click on the desired sticky tab.
3. Click and hold on the first Point where you want the sticky tab’s arrow to point
to.
4. Drag the cursor the length you want for the tab.
5. This is the primary label.
6. Sticky tabs can be created and configured by clicking on Configure Sticky Tabs.
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Adding Highlights

Users can add highlights to pages with the Highlighter tool found on the Home tab
ribbon-bar. Yellow is the default color. To highlight an area:
1. Click on the drop-down half of the Highlighter button to select a color for the
highlighting (Fig. 28-D).
2. Click on the top half of the Highlighter button.
3. Click and hold the left mouse button and drag a box over the area to be
highlighted.
4. Release the mouse button. Click and drag again to draw another highlighted
area or press Esc to stop the highlighter tool.
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Adding an Image to a Page

Users can add images to pages with the Image tool found on the Home tab ribbon-bar.
To add an image:

1. Click on the Image button on the Home tab ribbon-bar (Fig. 28-E).

2. In the Open window, navigate to the image you want to place on the current
page.

3. Click on the desired image so that its name shows in the File name field.

4. Click on Open, which will close the Open window.
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5. You are now prompted to click two Points for the placement of the image. You
can then drag the Points to resize and place the image (Fig. 28-F). Images can
also be copied, pasted, and locked in place using commands on the image’s
right-click menu.
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Adding an Overlay of a Page

The Overlay tool allows you to place, or overlay, a separate page from your plans onto
your current page. There are two types of overlays. The Standard Overlay type allows
you to overlay a plan page on top of your current page, like a transparency, which is
typically used for comparing multiple levels of the plan. The Comparative Overlay type
allows you to compare two versions of the same page after a revision so that you can
see additions and deletions. Additions are shown in red, deletions in blue. Both overlay
types use the same procedure. To create a standard overlay:

1. With the page open that you want to overlay a page on top of, click on the
Overlay button on the Home ribbon-bar tab (Fig. 29-A).
This opens the Overlay Type window.
Select Standard Overlay.
Click on Next.
This opens the Select Overlay window.

o vk wN

Type the name of the overlay into the Name field.
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7. Click on the Color field’s drop-down menu to select a color.

8. The available overlays are listed in the large window and can be clicked on to
select one, or you can type the name of an overlay into the Search field.

9. After selecting an overlay, click on Finish.
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10. The overlay is now displayed.
11. A Confirm window asks if you want to align the overlay. Click on Yes (Fig. 29B).
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12. You are now prompted to click the first alignment Point on the overlay (Fig. 29-
C).

13. Three more steps have you aligning the overlay, clicking the second Point, and
aligning the second Point so that the overlay is exactly over the original plan.
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Figure 29-C
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14. If you don’t line it up correctly, hover over the new overlay in the Pages,
Booksmarks window until the re-do button appears, then click on the button
(Fig. 29-D) and start the four alignment steps over again. Note that you can
zoom and pan as normal while performing the alignment steps.
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15. Figure 29-E shows a comparative overlay of a landscaping plan overlaying a site
plan. Notice that plants are shown in red as additions, topography numbers are
shown in blue as deletions, and the rest is shown in black as unchanged.
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Accessing Specialty Takeoff Items

PlanSwift provides specialty takeoff items that are available from the Area, Linear,
Segment, and Count drop-down menus located on the Home tab ribbon-bar. These are
the Single Click Area, Linear, and Count takeoffs, the Roof Area takeoff, the Price Per
SQ FT Area takeoff, the Area Cubic Yards takeoff, the Grid Tool Area takeoff, and the
Joist Tool Area takeoff.

Single-Click Area Takeoff

Single-click area takeoffs are another means to perform an area takeoff and can be
faster to perform than conventional takeoffs. Single-click area takeoffs utilize the
digital lines on plan pages as well as user-inserted “cut-lines” to restrict the area size to
the desired area. Single-click area takeoffs also only measure areas inside of the plan
lines, so if an area you are measuring needs to include, say, the area under a four-inch
wide wall, then you may be better off using the standard area takeoff tool. To perform
a single-click area takeoff:
1. Click on the Single Click button on the Home tab ribbon-bar menu (Fig. 30-A).
2. Select CutLine from the drop-down menu.
3. The right-side door will need a cutline to contain the area takeoff inside the
room. Click on the two Points indicated for the beginning and end of the
cutline (longer cut-lines are more effective than shorter cut-lines).
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4. A red cut-line appears (Fig. 30-B).

5. Click on the Single Click button again and select Area from the drop-down
menu.

In the Properties - [Area] window, enter the Name for the takeoff.

Select a color.

Select afill.

. Select a folder if desired.

10. Click on Ok.

11. Click in the area where you want the one-click takeoff.
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12. An array of one-click icons now fills the area (Fig. 30-C). If you have more
than one area to include, click those areas next. Each time you click a new
area, the fill will be placed in the previous area.

13. After you have selected the area(s) you want, press Esc to fill in the final area
you clicked on.

14. Note that the top-left door line arc stopped the area takeoff from filling the
area behind the arc of the door.

15. To fill this area, click on the takeoff, zoom in on it, and drag the cursor to
select the area shown.

16. Upon selection, the selected Points become highlighted in green.

17. Press Del to delete the green-highlighted Points.

18. The takeoff now reflects the actual shape of the room area.

# Left Click to Takeoff, Esc to Stop,

Figure 30-C
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Single-Click Linear and Count Takeoffs

Single-click linear and count takeoffs work identically to the single-click area takeoffs.

To perform a single-click linear or a single-click count takeoff:
1. Click on the drop-down half of the Single Click button and select Linear (or
Count) from the drop-down menu (Fig. 31-A), then follow the steps for a single-
click area takeoff.
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Roof Area Takeoff

Performing a Roof Area takeoff requires familiarity with performing an area takeoff.
Roof area takeoffs differ from other area takeoffs because roofs also have a pitch
component. To perform a roof area takeoff:

1. Click on the drop-down half of the Area button (on the Home tab ribbon-bar)

and select Roof Area from the drop-down menu (Fig. 32-A).

2. In the Properties — [Roof Area] window, enter the name of the takeoff into the
Name field.
Enter the pitch (5) in the Pitch field.
Select the color of the takeoff.
Select the Fill Type.
Enter a folder name if desired.
Click on Ok.

N o v bhkw
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8. The Digitizer Record turns on (Fig. 32-B).

9. Perform the takeoff as you would an area takeoff. For more accuracy, use the M
(hotkey) to magnify each corner

10. Click on Point 10.

11. Click on Point 11.

12. Click on Point 12.
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13. As you click on each of the corners, the fill you chose is displayed up to the
Point of your latest click. Click on the fifth Point (Fig. 32-C).

14. Click on the sixth Point.

15. Click on the seventh Point.

16. Right-click on the seventh Point and select Stop from the drop-down menu. This
completes the roof takeoff, except for the front section. If you want to include
the front section, then instead of clicking on stop, click on New Section on the
drop-down menu and continue to perform the takeoff of the front section in the
same manner.
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Figure 32-C

95




Price Per SQ FT Area Takeoff

Performing a Price Per SQ FT Area takeoff requires familiarity with performing an area
takeoff. PlanSwift makes it easy to figure out the price per square foot for areas. To
perform a price per square foot takeoff:
1. Click on the drop-down half of the Area button and select Price Per SQ FT from
the drop-down menu (Fig 33-A).
2. Inthe Properties — [Price Per SQ FT] window, enter the name of the takeoff into
the Name field.

3. Enter the price in the Price Per SQ FT field.
4. Select the color of the takeoff.
5. Select the Fill Type and enter a folder name if desired.
6. Click on Ok.
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7. The Digitizer Record is now turned on. Perform the takeoff by clicking on all

corners (
8. With the

inside and outside) of the concrete pad (Fig. 33-B).
digitizing done, right click on the last Point and select Stop from the

drop-down menu.
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9. The square footage of the pad shows as 13,529.6 SQ FT in the Pages, Bookmarks
window (Fig. 33-C).
10. Click on the Estimating tab on the Home tab of the Main ribbon-bar menu.
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11. Note that the Cost Total of the pad is $40,588.89 in the Estimating window.
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Area Cubic Yards Takeoff

Performing an Area Cubic Yards takeoff requires familiarity with performing an area
takeoff. PlanSwift makes it easy to figure out cubic yards calculations using area
takeoffs. To perform an area cubic yards takeoff:

1. Click on the drop-down half of the Area button and select Area Cubic Yards (Fig

34-A).

2. In the Properties — [Area Cubic Yards] window, enter the name of the takeoff
into the Name field.
Enter price per cubic yard into the Price Per CU YD field.
Enter the depth of the pad in inches into the Depth (Inches) field.
Select the color of the takeoff.
Select the Fill Type and enter a folder name if desired.
Click on Ok.
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8. The Digitizer Record is now turned on. Perform the takeoff by clicking on all
corners (inside and outside) of the concrete pad (Fig. 34-B).
9. With the digitizing done, right-click on the last Point and select Stop from the

drop-down menu.
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10.The total cubic yards of concrete (166.8 cubic yards) is displayed in the Pages,
Bookmarks window (Fig. 34-C).
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11. The cost total for the concrete is also calculated as well (Fig. 34-D).
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Grid Tool Area Takeoff

Performing a Grid Tool Area takeoff requires familiarity with performing an area
takeoff. The Grid Tool Area takeoff is useful for automatically calculating a grid on top
of an area; from that calculated grid, you can determine quantities of rebar, tile, T-bar
(or dropped) ceilings, or other similar items. To perform a grid tool area takeoff:

1. Click on the drop-down half of the Area button and select Grid Tool from the
drop-down menu (Fig. 35-A).

2. This opens the Properties — [Grid Tool] window.

3. Enter a name for the grid takeoff.

4. To generate the grid automatically, click on the Automatically Generate
checkbox.

5. Select the color of the takeoff.

6. Select a Fill Type: Solid, Hatch Pattern, or Texture.

7. Select the angle for the rebar (0 is vertical, 90 is horizontal, or anything in-
between). This value will be ignored if the Select Parallel Side checkbox is
checked.

8. Select the vertical spacing (by default in inches).

9. Select the horizontal spacing (by default in inches).

10. If you click on the Select Parallel Side checkbox, then any angle value entered in
the Angle field will be ignored, and the software will prompt you to draw a line
that the rebar should be parallel to.

11. Click on Select Start Point if you want to be prompted to click where you want
the starting Point to begin.

12. Click on Count Intersections if you want the intersections to be counted; this
could be useful to count the number of rebar high chairs needed.

13. Click on Ok.

103



|15 Templales Seftings Reporis Help Plugins |Searl:h || Undo | PlanSwift Professional

Fit

Zoom Zoom

Page In Out

Zoom / Pan

QAQ P - = -

Pan Scale  Dimension Area

-

[ o Bl »

Linear Segment Count Single Send Digitizer MNew
& i = Click ~ Data ™ Recard Section

-

Measure . singleClick Area poff Record

30D

e/

Annotations

-

H

¥ Roof Area _.I/
@ Price Per SO FT

)
01&-'1’

Area Cubic Yards
|_ Grid Taol

W Joist Tool

#* Properties - [Grid Tool] x

MName

—. |Rebar Takeoff |

v Automatically Generate

Color
= | |~ |

Fill Type
[Solid -

Angle

—> ¥ =
Vertical Spacing Herizontal Spacing

v Select Parallel Side v Select Start Point M Count Intersections

| Input |ndu'anced|| Form HE_,E‘

L0 0 W@ ﬁ

BB

4 -0

x il b, T T T T T = T A =

Figure 35-A

104



14. Perform the steps to do an area takeoff, then right-click and select Stop (Fig. 35-

B).

15. Click on the first Point to select a parallel line.

16. Click on the second Point to select a parallel line.

17. Click on the start Point location.
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Figure 35-B
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18. The grid now appears beginning at the start Point (Fig. 35-C).

19. Hovering the cursor over the diagram shows the area’s square foot reading
(535.4 SQ FT).

20. The Pages, Bookmarks window displays the grid’s properties.

21. The area takeoff for the rebar is 13316.8 SQ FT.

22.The grid’s calculated linear footage is 888.1 FT.

23.The number of intersections is 1480.
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24. Click on the Estimating tab of the PlanSwift main menu (Fig. 35-D).

25. Rebar lengths are shown in this view.

26. This view also shows the number of intersections where rebar high chairs may
be needed.
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Joist Tool Area Takeoff

Performing a Joist Tool Area takeoff requires familiarity with performing an area
takeoff. The Joist Tool Area takeoff is useful for automatically calculating joists, rafters,
and rake walls (to calculate stud lengths). When using the Joist Tool for rafters, the
rafter application requires a slope to be entered. To perform a joist tool area takeoff:

1.

Click on the drop-down half of the Area button and select Joist Tool from the
drop-down menu (Fig. 36-A).

. This opens the Properties — [Joist Tool] window. Enter a name, such as “First

Floor Joist Takeoff”, for the joist takeoff.
Enter the joist type, such as TJI-560, in the Joist Type field.
Enter the length calculation method to be used in the Length Calculation field.
The drop-down menu options are:
a. None (which will produce a joist length in feet and inches)
b. Nearest Foot (which rounds the value up to the next whole foot number)
c. Nearest Even Foot (which rounds the value up to the next even foot)
d. Nearest 2 Feet (which rounds up to the nearest whole number, adds one
and then, if the result of that is odd, adds one more). For this calculation,
select Nearest Even Foot.

. Enter the joist direction in the Joist Direction field. The drop-down menu options

are:

a. First Two Points (joists will be parallel to the first two Points of your
takeoff)

b. Horizontal (joists will be drawn horizontally)

c. Vertical (joists will be drawn vertically)

d. Select Parallel Side (allows you to draw joists parallel to a side of the plan
by selecting two Points). If this is selected, then the Automatically
Generate option is disabled.

Select Parallel Side.

Enter the on-center spacing in the O.C. Spacing field. Values in the drop-down
menu are: 8, 12, 16, 19.2, 24, 32, or you can enter a different value. Select 24.
The Pitch field is used for rafters. Enter zero for joists. For rafters, enter the pitch
of the rafter. Leave this blank or at zero.

108



8. The Min Length is the shortest size of material available for purchase. Leave
blank.

9. The New Length is the length of the material that will be ordered. Leave blank.

10. Select the color in the Color field for the takeoff.

11. Select the Fill Type in the Fill Type field (Solid, Hatch Pattern, or Texture).

12. The Group Sections is used when you have multiple joist sections that are all
the same. As an example, a five-story building might have the same joist design
for each floor. By breaking out each of the sections (floors) separately, it is easier
to estimate the cost of each floor. Do not select this.

13. Clicking on Generate Parts will generate a part for each joist in the Estimating
screen and will group joists of the same length into the same part. Select this.

14. Clicking on Automatically Generate will generate the joist takeoff locations
automatically after the area takeoff is completed, but only if the Select Parallel
Side joist direction is NOT selected. If you need to add double joists or split
joists, you may not want to select the Automatically Generate option. For this
exercise, do not select this.

15. Clicking on Show Labels will generate labels showing the length of each joist.
Select Show Labels.

16. Click on Ok to continue.
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17. Starting at the arrow, perform the takeoff using the standard takeoff procedure
(Fig. 36-B).

18. Complete the takeoff by selecting Stop from the right-click menu or by pressing
the Esc key.
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Figure 36-B
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19. Click on the completed takeoff to select it, which highlights the takeoff in a red

border (Fig. 36-C).
20. Four selections now appear:

a.
b.
C.
d.

Draw Joists/Rafters (which draws the joists/rafters)
Clear Joist/Rafters (which clears any drawn joists/rafters)
Regenerate Totals (which regenerates totals)

Split Joists/Rafters (which splits joists/rafters).

Click on Draw Joist/Rafters.

21. You are prompted to click on the first Point for placement of the joists, then to

click at the second Point (at the other end of the same joist); this creates all of
the single joists.
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22.The “First Floor Joist Takeoff” shows 862.1 SQ FT, and the total length of all joists
measures 410.8 FT (Fig. 36-D).

23. The label shows ten 28-FT joists, four 26-FT joists, two 10-FT joists, and two 6-FT
joists.
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24. If you need to double one of the joists, click on a joist to select it so that it is
highlighted in red (Fig. 36-E).

25. The Add Double Joist button now appears. Click on it.

26. The doubled joist appears next to the one that was selected.

27. The note automatically updates to show eleven 30-FT joists.
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28. If you want to split the joists and rafters, click on the “First Floor Joist Takeoff”
area (Fig. 36-F).

29. Click on the Split Joist/Rafters button.

30. Click on the first Point (the left side of the dropped beam in this example).

31. Click on the second Point (the right side of the dropped beam in this example).
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32. The split joists appear. Note that the 28-FT joists are now split into a 12-FT and
an 18-FT joist (which makes 30 total feet). The extra two feet are added because
the rounding option was set to Nearest Even Foot, and each of the joists had a
foot added to them (Fig. 36-G).
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33. If you want to change the rounding properties or any other joist properties,
double-click on the area takeoff (or right-click on the area takeoff and select
Properties from the drop-down menu) (Fig. 36-H).

34. After making any changes to the properties, click on Ok to close the Properties
window.

35. Click on Regenerate Totals to have the properties updated.
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36. Click on the Estimating tab of the PlanSwift Main menu (Fig. 36-I).
37. The joist estimates are listed in the Estimating screen.

Home Page Tools View ‘E-’-timaﬂﬂﬂ‘ Lists Templates Seftings Reporis Help Plugins

N NG e O N O=BYS % O QLT
[ L4 el
Mew  Mew Mew  Mew New New New New NewFrom | Delete | Print Columns Filter Refresh Properties Expand  Collapse | Expert  Import
Folder~ Item~ Area~ Linear~ Segment® Count™ Assembly™ Part™  Type~ - All All To Excel  Template
Estimate Clipboard Adjust
Estimating Layouts < | PlanSwift Layouts\Basic Layout
- H + 0 c # Name Description Qty Units  CostEach CostTotal Markup % Price Each Price Total Color
- il |First Floor Joist Takeoff s62.11)sQFT | s0.00)0.00 ol so.0|  $0.00mem
=l # PlanSwift Layouts f [secton se211ls5rT | =
Waste % ) §r, [TI1-560 Flack Jacket 433.73|FT 50.00|0.00 of  s0.00 $0.00
i Round Qtys ", [TJ1-560 Flack Jacket- 5
a Ttem # -*., |TJ1-560 Flack Jacket- 6|FT
i Division ", [TJ1-560 Flack Jacket- 12[FT
i, Assembly Total ", [TJ1-560 Flack Jacket- 18[FT
i, Multiply and Location ", |T31-560 Flack Jacket- 12|FT
i, Takeoff View *., [TI1-560 Flack Jacket- BT
i, wall Area *, [TI1-560 Flack Jacket- 12|FT
i Qty and Qty 2 ., [TI560 Flack Jacket- 18|FT
~hal, WBS +", [TI1-560 Flack Jacket- 1T
[l Takeoff Data -, [TI1-560 Flack Jacket- 18|FT
o, Default +"., [TII-560 Flack Jacket- 10[FT
& PS Layouts ", [T71-560 Flack Jacket- 18[FT
", |TJ1-560 Flack Jacket- 10[FT
", |TJ1-560 Flack Jacket- 18[FT
", [TI1-560 Flack Jacket- 10[FT
-*, [TI1-560 Flack Jacket- 18[FT
-*., |TI1-560 Flack Jacket- 10|FT
", [TJ1-560 Flack Jacket- 2[FT
", [TJ1-560 Flack Jacket- 10[FT
", |T31-560 Flack Jacket- 2|FT
", |TJ1-560 Flack Jacket- 12|FT
", [TI1-560 Flack Jacket- 18[FT
-*, [TI1-560 Flack Jacket- 12|FT
-*., |TJ1-560 Flack Jacket- 18|FT
", [TJ1-560 Flack Jacket- 12[FT
", [TJI-560 Flack Jacket- 18[FT
", |T31-560 Flack Jacket- 12|FT
", |TJI-560 Flack Jacket- 18[FT
", |[TJ1-560 Flack Jacket- 12|FT
", [T1-560 Flack Jacket- 18[FT
-*, [TI1-560 Flack Jacket- 12|FT
-*., |TI1-560 Flack Jacket- 18|FT
", [TJI-560 Flack Jacket- 12[FT
", |[T31-560 Flack Jacket- 18|FT
", |TJ1-560 Flack Jacket- 12[FT
", |TJ1-560 Flack Jacket- 18[FT
-0 [TJ1-560 Flack Jacket @ 18 15 50.00|0.00 of  s0.00 $0.00
-0 [TJ1-560 Flack Jacket @ 12 11 0.00(0.00 of  s0.00 $0.00
- [TJI-560 Flack Jacket @ 2' 2 0.00/0.00 of  so.00 $0.00
@ [TJI-560 Flack Jacket @ 10 6 £0.00/0.00 of .00 £0.00
@ [TI1-560 Flack Jacket @ 6' i W[ sooojooo of .0 £0.00
=] |T1-560 Flack Jacket
P— £367.20 MAX=20.0( $53539,98

Figure 36-I

118



Shortcuts and Hotkeys

Shortcuts for Zooming, Panning, and Navigating Pages

PlanSwift provides shortcuts for Zooming, Panning, and Navigating Pages.

Zooming

Four zoom commands are available from the Zoom/Pan group on the Home tab
ribbon-bar (Fig. 37-A). PlanSwift provides several ways of invoking these commands:

1. Clicking on Zoom, then selecting an area of the page by clicking and dragging the
cursor over an area of the page selects the area that is drug over and zooms in to
display the selected area. An alternate way of zooming into a selected area is to
press the F10 function key and drag over the area with the mouse.

2. Clicking on Fit Page displays the entire plan page in the viewing window and
pans the image so that the image is centered in the viewing window. An
alternate way of fitting the page to the window is to press the F7 Function key.

3. Clicking on Zoom In zooms in about 30% each time it is clicked on. A second way
of zooming in is to use the mouse wheel, and a third way is to press the number
pad’s + (plus) key. The number pad zoom functions are smoother and only zoom
in or out about 10%.

4. Clicking on Zoom Out zooms out about 30% each time it is clicked on. A second
way of zooming out is to use the mouse wheel, and a third way is to press the
number pad’s = (minus) key.

%‘ Home | Page Tools View Estimating Lists Templates Settings Re

LR = QAR Q J

Mew  Open Print  Email Back Fwd Zoom Fit Zoom  Zoom Pan
Job Page In Cut

Job Mavigate Zoom / Pan

—

00600

Figure 37-A
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Panning

The Pan option can be initiated in three ways:
1. Click on the Pan button on the Zoom/Pan group on the Home tab ribbon-bar

(Fig. 37-B) and drag with the left mouse button held down.

"cf) Home | pPage Tools View Estimating Lists Templates Settings Re

SeE, QaaQqQd

Mew Open Print  Email Back Fwed Zoom Fit Zoom  Loom Pan
Job Page In Chut
Job MNavigate Zoom / Pan

(—)

Figure 37-B

2. Click and hold the right mouse button while dragging. This automatically
highlights the Pan button on the Main ribbon-bar menu as you drag to pan the

image.
Estimating Lists Templates Settings Reports Help Plugins jearc
QARAAQ % < &
L4
Fwd Zoom Fit Zoom Zoom Pan Seale  Dimension Area
Page In Out W S
gate Zoom / Pan Measure
<
< :
& P e
& £ il ] I
@ i 7 ﬁ
i I i i
6 =Y :
b4 Right-click
¢ & :
] and drag
@

Figure 37-C

3. PresstheE, D, F, and S keyboard keys to scroll up, down, left, and right,
respectively.
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Navigating Pages

The Navigate arrows options are available from the Navigate group on the Home tab
ribbon-bar (Fig. 37-D). To navigate from page to page:
1. The left navigate arrow opens the previous page. An alternate way of moving to
the previous page is the Pg Up keyboard key.

2. The right navigate arrow opens the next page. An alternate way of moving to the
next page is the Pg Dn keyboard key.

.Jﬁ:/l Home | page Tools View Estimating Lists Templates Settings Re

SE o, 4'" QARR{ Q M

Mew Dpen Print  Email Back Zoom Fit Zoom  Zoom Pan
Job Page In Out
Job Mavigate Zoom / Pan

Figure 37-D
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Using and Customizing Keyboard Hotkeys

PlanSwift provides a means to customize hotkeys:

- Data Starage

1. The Zoom to Fit and Zoom hotkeys can be changed here (Fig. 38-A).
2. The Scroll Up, Scroll Down, Scroll Left, and Scroll Right hotkeys can be
changed here.
3. The Magnifier hotkey can be changed here.
4. The number-pad zoom (Smooth Zoom In and Smooth Zoom Out) can be
changed here.
5. The numbers 1, 2, 3, and 4 are used to start new areas, new linears, new
segments, and new counts and can be changed here.
6. Digitizer Record, New Section, Toggle Image/Estimating Window, and the
New Note can be changed here.
#%) Home Page Tools View Estimating Lists Templates = Seftings | Reports Help Plugins ===
=
Licensing

- General Keyboard Hotkeys
- Company
- Keyboard Hotkeys Primary Secondary Primary Secondary
I
;;z:naj;an Zoom ta Fit: |F? | |Nc-ne | Smaoth Zoom In: |Num + | |Nc-ne |
- Annatations Zoom: |F10 | [Mone | Smeoth Zoam Out: [Mum- | [Mone |
- Giraphi ) i )
T;iioIESTools Previous Zoom: [More | |[Mone | Mew :Area.
- Snapping Serall Up |E | |Nc-ne | e MHew Linear:
- Motifications ' MNew Segment: -3
-~ Digitizer T ablet 9 Soroll Diowin: |D | |NC'”E | Mew Count:
- Puopety Gougs Seroll Left: |5 | [Mone | '
vanee Scroll Right: |F | |None | Start#Stop Point B ecording: EI
3 G Mew Section:
Magnifir: |M | |N0ne | Toggle Image/E stimating “wfindow:
Create Eookmark: |B | |N0ne | New Nate: l:l
Search Bookmarks: |Nnne | |None | .
Continue Witk |N|:-ne | |None |
Toggle Digitizer Snap:
Togale Angle Shap [Orthal:
Toggle Werify Points:
[uick Search:

Figure 38-A

122




Integration with Excel

PlanSwift makes it easy to send takeoff and estimating data to Microsoft Excel. Data
between PlanSwift and Excel is managed in three key ways:

1. Exported to Excel using the Export to Excel feature.
2. Imported from Excel using the Excel Import Tool plugin.
3. Live-linked with Excel using PlanSwift’s Integration with Excel feature.

Besides easily being able to Export data to Excel, PlanSwift’s Integration with Excel
provides the ability to live-link to and update Excel WorkBooks in real-time, initiate and
add to PlanSwift takeoffs, navigate easily from Excel takeoff values to PlanSwift takeoff
values, assign multiple properties to a single takeoff, export Excel templates from Excel
back into PlanSwift, and unlink a job. This functionality is provided via a PlanSwift
Ribbon-bar Tab and via a Right-click Menu.

PlanSwift Ribbon-bar Tab

The PlanSwift Ribbon-bar Tab (Fig. 39-A) is visible once PlanSwift is installed and Excel
is started.

H ©- H MNew Sample Plan Play te
File Hame Insert Page Layout Formulas Data Review View Help ACROBAT PlanSwift Q Tell me wha
Ty =
]
@O O
Connect Unlink
Connection Takeoff Digitizer Utilities Export
B 5 fe || 1710.89
A B C D E F G H ]
1 -
2 |
Figure 39-A

1. Click on the PlanSwift Ribbon-bar-Tab (Fig. 39-A) so that the PlanSwift Ribbon-
bar icons are visible.
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Connecting to and Disconnecting PlanSwift from Excel

Connecting to Excel links PlanSwift and PlanSwift Excel Integration into a live-link so
that the powerful features in Microsoft Excel and PlanSwift can be utilized. To connect
and disconnect PlanSwift from Excel:
1. Open PlanSwift and open the job that you want to link the PlanSwift Excel
Integration.
2. Open Excel to the spreadsheet to which you want PlanSwift linked and click on
the PlanSwift Ribbon-bar Tab.
3. In Excel, click on the Connect (green orb) icon (Fig. 39-B). Once you are
connected, the other PlanSwift icons on the PlanSwift Excel Ribbon-bar will be

available.

H = MNew Sample Plan P
Home Insert Page Layout Farmulas Data Review View Help ACROBAT PlanSwift
(9/ | [ ] -
Connect Unlink
Connection Takeoff Digitizer Utilities Export

B& - S 1710.89
A [ B | c [ D [ E | F [ G [ H

1 —

2 =

Figure 39-B
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4. To disconnect from PlanSwift, click on the Disconnect (red orb) icon (Fig. 39-C).

H s MNew Sample Plan F
Home Insert Page Layout Formulas Data Review i Help ACROBAT PlanSwift @&
oy c@OE 0 H T
0 é) I: I o 1
Disconnect Unlink  Area Linear Segment Count Continue New Go to Select Export to
With  Section  Page Existing ltem = PlanSwift
Connection Takeoff Digitizer Utilities Export
B6 e B || 1710.89
A B s [ D [ E [ F | G | H [ [
1_
2_
Figure 39-C

Initiating PlanSwift Takeoffs from Excel

PlanSwift takeoffs may now be initiated from within Excel by following the procedure
below. Note that PlanSwift must be open and a job and a floorplan selected before
beginning a takeoff. To initiate an area takeoff from Excel:

1. Click on a cell in the spreadsheet where you want the new area value to be
stored (Fig. 39-D).

E —
Home Insert Page Layout Farmulas Data Review View
@ & Tltive © 1
Disconnect Unlink  Area Linear Segment Count Select Export to
Existing [tem  PlanSwift
Connedtion Takeoff Digitizer Utilities Export
B3 - Je
A B C . D . E . F . G
1 —
: I:'/
3 |Garage Pad Area i
4

Figure 39-D
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2. Click on the Area icon in the Takeoff group of the Excel PlanSwift Ribbon-bar

(Fig. 39-E).

File

Home

=]

Insert

]

Formulas

Page Layout

Data

Review

@ & Ll == L
% o 1

Disconnect Unlink  Area Linear Segment Count Select Export to

Existing [termn  PlanSwift
Connection Takeoff Digitizer Utilities Export
B3 w7 Fx
A B E E

1 -

2

3 |Garage Pad Area | _I

4

Figure 39-E

3. A Properties - [New Area] window appears in PlanSwift allowing you to give
a Name to the area takeoff (Fig. 39-F). Enter a name of your choice and click Ok.

¥ Properties - [MNew Area] 4

Mame

_..--"""-.
|New Area T |

Color Fill Type

I - | o -

Input

Advanced E-E Ok

Figure 39-F

Cancel

PlanSwift is now ready for you to perform an area takeoff. Perform the takeoff, and the
takeoff value will appear in the cell you selected. That value and the name of the
takeoff will also appear in PlanSwift. The Linear, Segment, and Count takeoffs all work
similarly to the Area takeoff you just performed. If you make any changes to the
takeoffs in PlanSwift, those changes are automatically updated through the PlanSwift
Excel Integration, as long as Excel remains connected to PlanSwift.
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Adding New Sections to Takeoffs

The Digitizer group Continue With and New Section icons, which work identically in
Excel, are used to digitize (or add) a new section to a takeoff. Follow the procedure
below to add a new section to an existing takeoff. Note that PlanSwift must be open
and a job and a floorplan selected before you can add a new section to a takeoff. To
add a new section to a takeoff:
1. Click on an active takeoff cell (containing a takeoff value) within your linked
Excel spreadsheet to activate these icons (Fig. 39-G).

Home Insert Page Layout Farmulas Data

Disconnect Unlink  Area Linear Segment Count | Continue Mew Go to Select Export to
With  Section | Page Ewisting ltem  PlanSwift
Connection Takeoff | Digitizer Utilities Export
B4 - Jx 18.32
A B C D E F G H

LI SR TS B LS

| 118.32'_| 24,52

Figure 39-G

2. Click on either Continue With or New Section.

3. PlanSwift is now ready for you to add to your takeoff. Perform the takeoff in
PlanSwift, and the value of the new section will be added to the existing takeoff
value in the linked Excel spreadsheet. That added value will also be reflected in
PlanSwift. If you make any changes to the takeoffs in PlanSwift, those changes

will automatically be reflected in Excel, as long as you remain connected to
PlanSwift.

127



Navigating from Excel Takeoff Values to PlanSwift
Takeoff Values

The Go to Page option (Fig. 39-H) in the Utilities group of the PlanSwift Ribbon-bar
Tab allows you to select a takeoff value from your linked spreadsheet and click on Go
to Page to jump to the page and location of the takeoff value in PlanSwift. After the
jump, the PlanSwift page where the takeoff value is located is automatically
highlighted in reverse video. To move from an Excel cell’s takeoff value to the takeoff
in PlanSwift:

1. Click on the linked cell where the takeoff value is that you want to find in

PlanSwift.
2. Click on Go to Page.

3. Click on the page in the Select Page window (Fig. 39-1).
4. Go to PlanSwift. The page where the takeoff value is located will be highlighted.

Open the page by clicking on the +, if necessary, to view the takeoff value (Fig.
39-J).

Insert Page Layout Farmulas Data

Dl @E O H 1
I"= o 1
Disconnect Unlink  Area  Linear Segment Count  Continue  Mew Go to Select Export to
With  Section  Page Euisting ltern  PlanSwift
Connection Takeoff Digitizer Utilities Export
B6 - K || 1710.89
A B C D | E . F . €]
1 -
2_
3_
4_
5
6 |carpet Brown | 1?10.89‘!
7 |Perimeter of Carpet Brown 367.15

Figure 39-H
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Figure 39-I
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Figure 39-J
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Assigning Multiple Properties to a Takeoff Using 'Select
Existing Item’

The Select Existing Item option allows you to assign multiple properties to a single
takeoff (or item). Follow the procedure below. Note that PlanSwift must be open and a
job and a floorplan selected before you can assign a different property to a takeoff.
1. Click on an empty cell in the linked spreadsheet where you want the value of the
new property assignment to be stored.
2. Click on Select Existing Item (Fig.39-K).

ect Unlink  Are: r Segment Count Select Export to
Existing [tem  PlanSwift
Connection Takeoff Digitizer Utilities Export

Figure 39-K

130



3. Inthe Select Existing Item window (Fig. 39-L), click on the item in the left
column that you want to use (in this case we are selecting "Carpet Brown" which
has an "area" property of about 1710 square feet), and then, in the right
column, click on Linear Total. (Some examples of properties that you might want
to use are Area, Linear Total, Qty, Section Count, Segment Count, and Depth,

and others are available.)

Enter text to search... L) Find Clear fiem =
LaunchAction
4 (5| Takeoff — Linear Total
I*1 Exterior Trim
I"7 | Exterior Rock Load
7 Excterior Siding Location
7 Restrooms
I | Game Room Varkup %
7 Offices Markup Each
o Interior Doors Markup Total
[T Conference Room
I*1 Exterior Walls Name
I"1 Interior walls OrderIndex
"7 | Common Room
! Phase
"7 | Carpet Brown
= Mew Area Point Count
v Carpet Mottled Price Each
v Tile
= New Area Price Total
I*1 Footing Qty
o Basic Area e
Figure 39-L
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4. The result in the linked Excel spreadsheet cell B7 is 367 linear feet (Fig. 39-M),
which is the linear perimeter in feet of the 1710 square-foot Carpet
Brown takeoff area (shown in cell B6 of Fig. 39-M). Thus, without having to
perform the takeoff twice (once for the carpet area and once for the perimeter
of the room, one takeoff can perform both area and perimeter properties.

B o -

Home Insert Page Layout Formulas

@ & Dltixie G
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Perimeter of Carpet Brown 367.15

Figure 39-M
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Right-Click Menu

Figure 39-N shows the Right-click Menu. As with the PlanSwift Ribbon-bar Tab,
the Right-click Menu is only fully functional when PlanSwift is connected to Excel.
When it is not connected, then only the Connect button is functional (Fig. 39-0).
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Figure 39-0
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Unlinking a Job

The Unlink option on the PlanSwift Ribbon-bar Tab (Fig. 39-P) is generally used only
when two WorkBooks are accidentally linked to one PlanSwift job. This allows for
unlinking a spreadsheet from the PlanSwift job. You are asked to confirm twice. Once

you confirm, all cells are unlinked, although their values remain in the Excel

spreadsheet.

e | s Book1 - Excel
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Figure 39-P
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Customizing PlanSwift

In addition to being easy to use, PlanSwift Professional is also a powerful software
platform due to its customization features and options. In this section, users will be
introduced to templates, parts, assemblies, estimating layouts, reports, plugins,
advanced features, and an overview for developers. We highly recommend purchasing
a training package for accelerated learning and faster customization.

Templates Overview

PlanSwift provides a sample library of prebuilt templates, parts, and assemblies. These
are found in the Templates tab as custom tabs (Fig. 40-A).

1. Sample Templates

2. Sample Parts

3. Sample Assemblies

‘_"ﬁ/’ Home Page Tools View Estimating Lists | Templates

e [ ]
° W
w1 &
Mew MNew MNew Mew Mew Mew Mew
Folder~ ltern~™ Area~ Linear™ Segment™ Count~ Assemnbly -

& Sample Templates |[[] Sample Parts | ¥ Sample Assemblies

O 60 6

Figure 40-A

With PlanSwift, users can build custom templates to their specific needs and easily
modify them. Templates can save users countless hours. PlanSwift also makes available
for purchase Starter Packs with pre-setup templates for various construction
specialties, such as concrete, flooring, roofing, siding, etc.

We will define templates, parts, and assemblies in this and subsequent sections.
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1. Figure 40-B shows the Sample Templates.

Search

§
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Custom Templates

{E‘] 01.0 Gen Reguirements (Div 01.00.00)

+-)|02.4 Demolition {Div 02.40.00)

=HC|03.0 Concrete (Div 03.00.00)
- [ |Concrete Area

03.0 Concrete (Div 03.00.00)

£0.00

If:l Concrete Slab - Cuvd

03.0 Concrete (Div 03.00.00)

£0.00

Concrete Footing - CuYd

03.0 Concrete (Div 03.00.00)

£0.00

Concrete Grade Beam - Cud

03.0 Concrete (Div 03.00.00)

£0.00

# * |Concrete Spot Footing - Cu'd

03.0 Concrete (Div 03.00.00)

£0.00

{a 03 2 Concrete Reinfording (Div 03.20.00)

{3 |04.0 Masonry (Div 04.00.00)

#H{3|05.0 Metals (Div 05.00.00)

{E] 05.4 Metal Framing (Div 05,40,00)

{3 |06.1 Rough Carpentry (Div 0.10.00)

{E] 0&.2 Finish Carpentry (Div 06,20,00)

+C5|07.2 Thermal Insulation (Div 07.21.00)

% |07.3 Roofing (Div 07.30.00)

(07,4 Siding (Div 07.40.00)

+-5h|08.0 Openings (Div 08.00.00)

- (09.2 Gypsum Board (Div 09.20.00)

#-C|09.3 Tiling (Div 09.30.00)

+C5)|09.5 Ceilings (Div 09.50.00)

£2|03.6 Flooring (Div 09.60.00)

& {3)|09.9 Painting (Div 09.90.00)

#H{3)|10.0 Spedalties (Div 10.00.00)

{3 |22.0 Plumbing (Div 22.00.00)

(3| 23.0 HVAC (Div 23.00.00)

{3 |26.0 Electrical (Div 25.00.00)

#H{3|32.1 Paving and Bases (Div 32.10.00)

{E] 32.9 Landscaping and Planting (Div 32.90,00)

Figure 40-B
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2. Figure 40-C shows the Sample Parts.
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£
£
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£
£
£
£
£
£
£
£
£
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Figure 40-C
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3. Figure 40-D shows the Sample Assemblies.

-“?‘J Home Page Tools View Estimating Lists | Templates | Settings Reports Help Plugins I:
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>:'iJ Concrete Slab (priced per CU YD) 4" Thick 4000 PSI 150
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F#-1*1 |Interior Trim Assembly
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£

- I=1 [Painted Wal
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L T o e T o e

Figure 40-D

The display of these templates is controlled with two different ways. The first way is
shown in Figure 40-E, which shows a drop-down menu that lists the available
templates. Those that have boxes around them are displayed as a tab. Clicking on a
template toggles the display of the box (and thus the display of the tab) on or off.
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Template Tools /
['q'j':- Sample Templates Sample Parts lﬁ Sample Assemblies l hd
[Name etion [Division @ Sample Takeoff Templates
Eak Custom Templates P— ﬁ Parts and Assemblies
#H3{01.0 Gen Requirements (Div 01.00.00) __“"-—-—-..___’ =
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alozo Concrete Reinforcng (Div 03, 20,001
Figure 40-E

The second way is by right-clicking the tab itself (Figure 40-F). This menu allows you to
view the properties, create a new tab, delete the tab, export the tab, compile the tab,
hide a tab, and display any hidden tabs.

yd
[5:- Sample Temnplates l[:] Sample Parts |ﬁ Sample Assemtﬁ!«.’_‘—
ame Properties...
EHE |Custon'| Advanced Assemblies New Tab
I“_'lj 2%2 Accoustical Ceiling Tile Delete Tab
=7 |Slab on Grade Export
- |Concrete Slab (priced per CU YD) Compile Tab PsI
- |#4 Rebar (priced per LES) Hide Tab 568 LBSFT
- [1° Gravel {priced by Tons) | : .
& |15 mil Vapor Barrier {priced per Roll) | Hidden Tabs @ Ssmple Takeoff Templates [
&5 Concrete Labar (priced per 5Q FT) Pour, Smoot ﬁ Parts and Assemblies :
-4 |Rebar Labor (priced per Hour) Tie, Bend an i
! Links |
EEI--I:] Concrete Footing Assembly
#-]*1 |Wood Framing Assembly How To Examples :
EEI--I:] Drywall Wall Assembly Test Template |
- Tew [Tmtarine Trim Accarmbly

Figure 40-F
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The same templates visible as tabs are also visible in the Templates window (Fig. 40-
G). A drop-down menu allows you to select whether Sample Templates, Sample Parts,
or Sample Assemblies are displayed in the Templates window. This window allows you
to initiate takeoffs from it (turn on the digitizer) using any template listed by clicking
on the green button left of the template and then performing the takeoff.

Templates ¢ » Templates 3

H2lkBOoe 2B O e
i Sample Templates i | i:- Sample Templates w |
O

Sample Parts =3 01.0 Gen Requirements (Div 01.
SampIE _ﬁs'semblies N . Ej u
#-5)03.0 Concrete (Div 03.00.00) 11 silt Fence -
@ 03.2 Concrete Reinfordng {Div ( E Temporary Fendng [ |
#C2)04.0 Masonry (Div 04.00.00) e Water Line Stub [ |
#2)05.0 Metals (Div 05.00.00) o ® Temp. Utility Pole
# (2 05.4 Metal Framing (Div 05.40.C 2 02.4 Demoiition (Div 02.40.00)
[ 06.1 Rough Carpentry (Div 06.1 #1303.0 Concrete (Div 03.00.00)
[EJ 06.2 Finish Carpentry (Div 06, 2( #(303.2 Concrete Reinfordng (Div (

{E:I 07.2 Thermal Insulation (Div 07,
*-[107.3 Roofing (Div 07.30.00)
#-(207.4 Siding {Div 07.40.00)
*-[108.0 Openings (Div 08.00.00)
#(209.2 Gypsum Board (Div 09.20.(
#-C2)09.3 Tiling (Div 09.30.00)
#(2)09.5 Ceilings (Div 03.50.00)
*-[209.6 Flooring (Div 09.50.00)
#1093 Painting (Div 09.90.00)
-3 10.0 Spedialties (Div 10.00.00)
(3 22.0 Plumbing (Div 22.00.00)
- [C3123.0 HVAC (Div 23.00.00)
(2 26.0 Blectrical (Div 26.00.00)
&J 32.1 Paving and Bases (Div 32.:
#3329 Landscaping and Planting (

Figure 40-G
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Key Features of the Templates Tab

The Templates tab ribbon-bar provides tools to assist in creating, organizing, and
modifying new takeoff item templates.

Creating and Organizing Templates

The first nine of the Template tab buttons are “split buttons”, meaning they have two
functions (Fig. 40-H). The top half of each of these eight buttons allows you to create
new Folders, Items, Areas, Linears, Segments, Counts, Assemblies, Parts, and Types;
the drop-down half of the buttons create each of the preceding items as Sub-ltems.
(Note that once items are created and then further modified, the items can be copied
and pasted to save the user time in making further modifications, rather than “starting
from scratch” with new items for each new template.)

%‘ Home Page Tools View Estimating Lists | Templates | Settings Reports

[ - [ ]
® ﬁ \

i 1 O
Mew Mew Mew Mew Mew Mew Mew Mew  Mew from

Folder~ Item~ Area~ Linear™ Segment~ Count™ Assembly~ Part~ Type ~
Temp

Figure 40-H
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The top half of the New from Type button opens the New from Type window, which
allows you to select a type for a new template (Fig. 40-1).

|;|_ T

Reports Help Plugins

0O B =0 %

Mew | Mew from || Delete | Columns Mew Form Properties Refresh

= Part=| Type- Tab Layout
Template Tools
[[Price Each |Color |
—
—
—
= Mew from Type et

[
P 03 select the type for this new template,
[

bee 0 Search: | |
pv 04 | # () Avea Dropdown

| B0 Soripted Tools

#13) Count Dropdavn

+-1) Linear Dropdown

¥ 13 Segment Dropdown

# I Rubber Stamps

£ 3 Revision Clouds

| B 5 Sticky Tabs

| B Al

Figure 40-I
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Advanced users can also turn on the Types tab from within the Settings tab (Fig. 40-J).

(Caution: using and customizing Types is for advanced users. We highly recommend

purchasing a training package for accelerated learning and faster customization.)

#3) Home Page Tools View Estimating Lists Templates Settings R

License
Manager *
Licensing
Data Storage
General Interface Settings
Compary
Keyboard Hotkeys Color Scheme:
Inkesface Blue B
<oom / Pan [ Show Undes The Hood Screen
Graphics [7] Show Types Tab n Templates Screen

Ve

o 7 o ©
New New

#3) Home Page Tools View Estimating Lists Templates  Settings Reports Help P

N

New New New New New New New fr
Folder - Item~ Area~ Linear- Segment- Count- Assem Part~  Type
G- Sample Templates | () Sample Parts | ) Sample Assembles &

[Name |[Desaption |lPrice Each |l|Cdor |
# ()| Area Dropdown | |  —
+ 1) | Saripted Tools | | |

Figure 40-)
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Modifying Templates

The Templates tab ribbon-bar also provides tools to assist in modifying takeoff item
templates (Fig. 40-K).

y |5E.ar|:h || IIhdo |
ugins

[ == [

Columns Mew  Form  Properties
Tab  Layout

Figure 40-K

1. The Columns button on the Templates tab (Fig. 40-L) allows you to add rows or
delete rows with the green (+) or red (X) buttons, select the Data Type, select
whether the row should be Visible, select whether to Show Units, and to specify
the Format.

“* Templates Columns Xt

Visible | Show Units | Format

Color Mumber
Phase Text
Cost Each Number
Waste % Mumber
Markup % Number
Division Text
Qty Text
Icon Text
Assembly Total Text
Round Qtys Text

I U U AN A

Oooooooooodo

Figure 40-L
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2. The New Tab button creates a new template tab (Fig. 40-M). The storage

location is set to Local by default. If you have set up other network drives within

PlanSwift settings, then you can select a different storage location for the
templates to be saved to.

Mew Template Tab >

Mame:
[

Storage:

Local

W Ok * Cancel

Figure 40-M
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3. The Form Layout button allows you to layout the form for a template (Fig. 40-N).

~o®l o @ A Q| m o < 0 |
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Template Tools
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ffame |[Descrntion ] [owison |[Price Each _{[color ]
43 |-— Custom Templates I g ' . .
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HHiD 024 Demolition {Div 02.40.00) 4 |
= {23(02.0 Concrete (Div 03.00.00) / + 4+ e
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04,0 Masanry (Div 04,00,00) | Scalad Scaled

05.0 Metals {Div 05.00.00)
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06. 1 Rough Carpentry (Div 06. 10.00)
05.2 Finish Carpentry (Div 06.20.00)
07.2 Thermal Insulation {Dev 07.21.00)
07.3 Roofing Div 07.30.00)

07.4 Siding (D 07.40.00)

08.0 Openings (Div 08.00,00)

09.2 Gypsum Board (Div 09.20.00)
09.3 Tiing (Div 09.30.00)

09.5 Ceiings (Div 09.50.00)

09.6 Fioaring (Div 09.60.00)

09,9 Painting (Dév 09.90.00)

10.0 (Div 10.00.00)

22,0 Plumbing (Div 22,00.00)

23.0 HVAC (Div 23.00.00)

26.0 Blectnical (Div 26.00.00)

32,1 Paving and Bases (Div 32.10.00)

32.9 Landscaping and Planting (Div 32.90.00)

0000000000000 00000000

[Fo] #o

Figure 40-N

4. The Properties button displays the properties of the template. Each item in
PlanSwift has its own properties window. Each property window includes three
view options: Form, Advanced, and Input. The default for most items is the
Form view. Figure 40-O shows the Form view, Figure 40-P shows the Advanced
view, and Figure 40-Q shows the Input view.

# Properties - [Concrete Slab - Cu'd] >

['RandemColor] =

Ok Cancel

Figure 40-0
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#* Properties - [Concrete Slab - Cu'd] >

L BO| A+ - % 2 ()O-| 0|+ + 2| shownomal- = FM  Eens -

iame |Formula |inputunits [ Adjust [Resuit | output units [ 11 |a

frem
Type Area Avea Cbdl®
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o Cuk
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Estimating
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Pitch s 12 6 12 9|
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Cost Each $ 0.00 $ rdkall
Markup % ] % 0.00 % &9
Price Total [Qty] * [Price Each] H 0.00 $ a0
Multiphy 1 Time(s) 1 Time(s) FI1[m]
Round Qtys ] False Cuhdll
wal Heght o FT o FT |9
Assambly Total [sum{Price Total)] + [Price Total] 4 0.00 s FdE
Assembly Uit Price [Assembly Total] / [Qty] 8 .00 ' C.d 04 88)

L] |9 | [v]

- 100.00 Cukalm
cuFT |0.00 cuFT EFm
cuYD |n.00 cu YD [ =]
SQFT |0.00 |sgFT - JE5] ] |

| ok | Cancel |
Figure 40-P
' Properties - [Concrete Slab - CuYd] *
Hame [vahee |units
Description
Thidkness 4 N
Cokr 8,368, 736.00

bl | [samncsa||_Fom ][]

Figure 40-Q
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Exporting and Importing

When initially installed, PlanSwift includes three tabs, Sample Templates, Sample
Parts, and Sample Assemblies, where pre-built templates are stored.

Tabs can be created, deleted, hidden, redisplayed, exported, and imported. The Export
Tab (see #1 of Figure 40-R) exports the contents of the selected templates tab,

allowing you to select where the data will be saved and to provide a name for the data
(Fig. 40-S).

#%) Home Page Tools View Estimating Lists Templates = Settings Reports Help Plugins senvcy
[:l e® e : o | [ —— ¥
MNew MNew Mew Mew New New Mew Mew Newfrom | Delete Columns New Form Properties Refresh = Export Import
Folder - Item - Area- Linear- Segment- Count- Assembly- Part- Type- Tab Layout Tab Tab

Template Tools
& Sample Tempiates |[) Sample Parts |l Sample Assemblies

Figure 40-R

%
X

1 » ThisPC » Documents » my templates v 0 Search my templates el

Organize « Mew folder 1=z - o

~

I This PC Marme Date modified Type Size
_J 3D Objects # Sample Templates 2.5wiftTemplates 9/26/2018 10:19 AM  PlanSwift Templat... 454 KB
[ Desktop
@ Documents
; Downloads
J! Music
= Pictures
m Videos
i Windows ()

Q Metwork NE »

File name: | Ch\Users\Dave.Hansen\Documentshmy ternplatesh\Sample Templates 2.5wiftTemplates w

Save as type: | Swift Template Files (*.SwiftTemplates) ~

» Hide Folders Save Cancel

Figure 40-S
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The Import Tab (see #2 of Figure 40-R) imports a template that was previously saved
or created, allowing you to select the name for the template (Fig. 40-T).

“* Open *
u s> This PC » Documents » my templates v 0 Search my templates 2
Organize - Mew folder Bz~ M @
PDF Sample Plar ™ Mame Date modified Type Size
& OneDrive - Plansw # Sample Templates 2. 5wiftTemplates G/26/2018 119 AM  PlanSwift Terplat... 454 KB

[ This PC
_J 30 Objects
[ Desktop
Documents
* Downloads
J'ﬁ Music
&= Pictures
m Videos
o Windows ()

T T VP i RS z

File name:| cumentsimy templates\Sample Templates 2. 5wiftTemplates v| Swift Template Files (*.SwiftTen ~

Figure 40-T
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Parts Overview

The instructions below will guide new users through the basics of copying and pasting
parts and dragging and dropping parts. We highly recommend purchasing a training
package for accelerated learning and faster customization.

How to Copy and Paste Parts

Copying and pasting parts is handled similarly to copying and pasting an assembly. If,
for instance, you want to move Material 6 in Area Takeoff Item Example 2 to Area
Takeoff Item Example 1 (as shown in Figure 41-A), click on Material 6 (#1), then click
on copy (#2).

#3) Home Page Tools View Estimating Lists Templales | Settings Reports Help  Plugins uarch PlanSwift Professional 10.2 - Sample Plan & -
| 4
W 1 e © S < B E ~ : ¥ W = Py
New MNew MNew New New MNew New MNew Newfrom | Delete = Columns MNew Form Properties Refresh | Export Import Expand Collapse Copy Paste
Folder - Item- Area- Linear- Segment- Count- Assembly - Part- Type - Tab Layout Tab Tab All All =
Template Tools Clipboard Adjust
- Sample Templates | (] Samole Parts | @ Samole Assemblies | How To Bxamples v | Templates
[Hame [Bescrpbon [price Each sk ] WO
= {2) Top Level Folder Example 1 I
= [ Advanced Assembies  — How To Exampies ¥
= 10 | Area Assembly 1 I | B | oo Level Foider Examole 1
= B |Ares Takeoff tem Example 1 | 0 =HD) Advanced Assemblies
9 Material 1 [Bescripton 1 ] | = Cy Area Assembly 1 |
& Material 2 |Deseription 2 0 = [ Area TakeofF Item Exampie 1 [ |
¥ Material 3 |Description 3 il & Material 1
& Material 4 [Descripbon 3 [} 25 Material 2
@ ‘Mateﬂd 5 :Dewwwﬂ 1 o & Material 3
Lo 1 | ] 5 Material 4
= 7 |area Taeaff tem Exampie 1 | 0 ® materal 5
% |Material 1 |pescription 1 [ - Labar 1
| o = EF Area Takeoff Item Example 1
5 1 5 Material 1
0‘ { &5 Material 2
- { & Material 4
o ! @ Material 5
12 E—— &
= #*Labor 1
L | = £33 Area Takeoff Item Example 2 |
0 5 Material 6
L] 5 Materiad 7
0 &5 Material 8

Figure 41-A
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There are now two ways to paste the part. The first is to paste it at the same
hierarchical level of a selected item, and the second is to paste it as a sub-item of a
selected item. Figure 41-B shows the Paste button. Clicking on the top half of the
button pastes the part at the same hierarchical level of a selected item. Clicking on the
drop-down half of the button, then selecting As Sub-Item pastes the part as a sub-item
of the selected item.

— = x

‘iyﬁ_ Upper
| Paste | ‘ *

ﬁ' As Sub-Item |

Figure 41-B

Click on Area Takeoff Item Example 1, (#1 of Figure 41-C) then click on the top half of
Paste. As shown in Figure 41-C, Material 6 (#2) gets pasted at the same hierarchical
level as Area Takeoff Item Example 1 (#3).

#3) Home Page Tools View Estimating Lists Templates | Settings Reports

- ¥ [ o ©

New New  New New New New New New
Folder - Item - Area- Linear- Segment- Count- Assembly - Part

G- Sample Templates | (] Sample Parts | Samole Assemblies | How To Examples |

[Hame [Desaption
=1 |2 | Top Level Folder Example 1
= I | Advanced Assembies
= _f.nma Assembly 1
£ |Aren Takeoff Item E 1

I |Material 1 |Descriptan 1
5 |Matenal 2 : |Descripton 2
5 Materia 3 |[Descripton 3
@ |Material 4 |Descripton 3
5 Mterial 5 |

:Dcsrrpton 1
¥ (Labor 1 |

Descripbon 14

=) G | Area Takeoff Item Example 1

5 [Materal 1 _[pesarpton 1
@ Material 2 [Descripton 2
5 |Material 4 |Descripton 3
® atenal 5 |peserpton 1
@ [Labor 1

= 57 |Area Takeoff Item Example 2 |
& |Material 6 |Description 14
& Material 7 |Descriptan 18
& |Materal 8 [Description 1C
# |Labor 2

Figure 41-C

151



If you had selected the drop-down half of the Paste button, then Material 6 would be a
sub-item of Area Takeoff Item Example 1. Figure 41-D shows Material 6 as a sub-item
(#4).

#3) Home Page Tools View Estimating Lists Templates | Settings R

B ¥ [ v ©

New New  New New New New New
Folder- ltem - Area- Linear- Segment- Count- Assembly -

i3 Sample Templates | () Sample Parts | ) Sample Assemblies | How To Bxamples

EHED | |Top Level Felder Example 1 '
=} |3 | Advanced Assembbes
=) |Area Assembly 1
._;I Ar:nTmﬁ]h:m Example 1 |
5 [Material 1 |Description 1

= .Ma!mal 2 |Descripton 2
5 |Material 3 |Description 3
¥ I'-'lalmal 4 |Descripton 3
@ [Material 5 |Description 1
- P T—

rall |Laber 1

= 57 |Area Takeoff Ttem Example 1

Figure 41-D

Another way to adjust the hierarchy of an item, such as Material 6, is to use the Main
ribbon-bar arrow Adjust keys (Figure 41-E). The left and right Adjust arrows move the
item left and right (up or down) in the hierarchy, and the up and down Adjust arrows
keys move the item higher and lower in the list of items.

e +
Copy Paste
- +*

Clipboard Adjust

Figure 41-E
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A shortcut to the Copy and Paste and Past as Sub-Item selections is available with a
right-click menu. Figure 41-F shows the Copy, Paste, and Paste As Sub-Item options on
the right-click menu when Material 6 is right-clicked on.

5 |Material 3
& Ep}awd-}
& [Material 5
=
" |Labor 1

=1 £ |Area Takeoff Item
@ |Materal 1
& |Material 2
9 |Material 4
& [Material 5
 |Labor 1

= 6 |rea Takeoff ltem
5 [Materal 5
&9 |Material 7
@ Material8
7 |Labor 2

+ 5 |rea Takeoff ltem

=120 | Area Assembly 2

|Description 3
|Description 3
[Descriphon 1|

Properties...
Delete

Reload

Sort ame

Co

Paste P
Paste As Sub-Item
Col

Down

Fill With

# 11 |Materal 12
+ Tot |Material 14

Figure 41-F

Fill Sequence

Double-clicking on Material 6 allows you to change the name of the item and alter
other properties of the item (Figure 41-G). To change the name of Material 6, double-
click on the Material 6 name, type the new name and click on Ok.

& |Material 4 |pescriptan 3 o
& [Material 5 |Description 1 0|
]
" |Labor 1 , | 0|
= [ |Area Takeoff [tem E 1 | al
& [Material 1 [Descripton 1 I o
@ Material 2 - I
P Materiasl 4 | ¥ Properties - [Material 6] 4o
@ |Matenial 5 1
Plabor = o
= G |Avea Takeoff ltem g[Material § _
;Waste% o %
;Ma!‘hm% :G.EIEI 1%
I 3 :Descmbm Desu'phu'lm
@labor2 ' |
G area Takeof Tem Advanced || Form or || cancer ||
= (2 |rea Assembly 2 : ' ]
Figure 41-G
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Figure 41-H shows Material 6 renamed to Material 6A.

#%) Home Page Tools View Estimaling Lists Templates | Settings Reports Help Plugins S |:
= e © N

W 1 - Q I

New Mew Mew New New MNew MNew MNew New from | Delete = Colu

Folder- Item - Area~ Linear- Segment- Count- Assembly- Part-  Type-
Template Tools

G Sample Templates | () Sample Parts | §8 Sample Assemblies | How To Examples
|Na112 ”Dmuhm ][Pnc\e Each ]rCuhr

...

= 1) |Top Level Folder Examnple 1 | —
=) | Area Assembly 1 |
= 57 |Ares Takeoff Item Example 1 [ 0|
& [Material 1 |Description 1 al |

& |Matenial 2 |Descriphion 2 Al

& Matenal 3 |Descripton 3 0

& |Material 4 |Description 3 af

&0 |Materisl 5 |Description 1 0

J?‘:Labu'] I:II

= |Area Takeoff Item Example 1 | L

[~ ] ;Ha_renal 1 |Descriptian 1 0

& |Material 2 Description 2 0

Figure 41-H

Modifications that a user makes to templates, parts, and assemblies should always be
tested and verified by that user to ensure quantities and calculations are accurate.
PlanSwift cannot verify the accuracy of modifications made to templates, parts and

assemblies by the user.
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How to Drag and Drop Parts

Parts may be dragged and dropped from one assembly to another assembly. If, for
instance, you want to drag the Material 8 item from Area Takeoff Item Example 2 up
to Area Takeoff Item Example 1, click on Material 8 and drag it up to just below
Material 6A (see Figure 42-A) and release the mouse button.

#3| Home Page Tools View Estimating Lists Templates | Settings Reports Help Plugins search E
—— )
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=12 | Top Level Folder Example 1 | —_
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= ] | Area Takeoff Item Example 1 0 I
@ |Material 1 |Descripton 1 0
& [Material 2 | Descripion 2 o |
& |Material 3 |Descripton 3 0
=] :Mar.s'nal 4 :Desmclbm 3 ';l.'
&5 |Material 5 Descriphion 1 0
5 |Material 64 [Descripton 14 0
= Desaription 1€ o
# [Labor 1 0
Sl iy .Ne.a ‘-'a-oeclff:né b Exampie 1 | u
&P |Material 1 Descripbon 1 Q
@ |Material 2 Descripton 2 ol
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= [ |Avea Takeoff Itelh Example 2 | | 13.2| I
& [Material 6 Descripbon 14 0
& [Material 7 | |peseripton 18 o
# |Labor 2 0
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Figure 42-A

Notice that dragging the part this way moves the part from the Example 2 assembly to
the Example 1 assembly, not leaving behind a copy.

The Templates sidebar window is a summarized view of everything in the Templates
Tab. It is designed for easy dragging and dropping of parts and for quickly launching
takeoff templates and assemblies.

Parts may be dragged over from the Templates sidebar window into the Templates
Tab window; note that dragging any part from the Templates sidebar window makes a
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copy of it. If, for instance, you want a Material 7 item added to Area Takeoff Item
Example 1 as a sub-item, simply drag the Material 7 from the right Templates sidebar
window over on top of Area Takeoff Item Example 1 label and release the mouse
button. (Figure 42-B).
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Figure 42-B

Figure 42-B shows the Material 7 item in place after it was dropped on top of Area
Takeoff Item Example 1. In addition, the Properties — [Material 7] window
automatically opens, allowing the user to change any properties for Material 7. Click
on Ok to close the Properties — [Material 7] window.

Any modifications that a user makes to templates, parts, and assemblies
should always be tested and verified by that user to ensure quantities and
calculations are accurate. PlanSwift cannot verify the accuracy of modifications

made to templates, parts and assemblies by the user.
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Assemblies Overview

The instructions below will guide new users through the basics of copying and pasting
assemblies. We highly recommend purchasing a training package for accelerated
learning and faster customization.

How to Copy and Paste an Assembly

The purpose of copying and pasting an assembly is to allow the user to copy and then
modify the assembly for later use. As an example, you may want two different
assemblies: one might include a part, and another might have an alternative part or
not include that part at all. By copying one assembly and then modifying and renaming
the copy (for easy identification), you can have two different assemblies available,
allowing for easier and faster takeoffs. Figure 43-A shows the Templates Tab (#1) and
the Area Takeoff Item Example 1 assembly (#2). If you want to add another assembly
but with no Material 3, then you would click on the assembly you want to copy (#2),
click on Copy (#3), and then click on Paste (#4).
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Figure 43-A
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Figure 43-B shows the original (#1) and new Area Takeoff Item Example 1 assembly
(#2). To delete the Material 3 (#3) from the newly created Area Takeoff Item Example
1 assembly (#2), click on Material 3 (#3), click on Delete (#4), and click on OK in the
popup window to confirm the deletion.
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Figure 43-C now shows the two assemblies, one with (#1) and one without (#2) the

Material 3 item. You can now change the description of the duplicated Area Takeoff
Item Example 1 (#3) without the Material 3 item by double-clicking the duplicate Area
Takeoff Item Example 1 (#3).
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Figure 43-C

This opens the Properties — [Area Takeoff Item Example 1] window (Figure 43-D)
where you can change the assembly’s name to something like Area Takeoff Item

Example 1—No Material 3 to make it easier to identify.
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Click on Ok in the Properties window after you have entered the name. Figure 43-E
shows the new name.
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Figure 43-E

To perform a takeoff with the Area Takeoff tem Example 1—No Material 3 assembly,
go to the takeoff page, click on the green Record Button (see Figure 43-F) in the
Templates sidebar window, and then proceed to do your takeoff.
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Figure 43-F

Any modifications that a user makes to templates, parts, and assemblies should

always be tested and verified by that user to ensure quantities and calculations
are accurate. PlanSwift cannot verify the accuracy of modifications made to
templates, parts and assemblies by the user.
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Estimating Overview

The Estimating tab is a summary of the takeoffs for the current job. These takeoffs are
displayed in a grid, which is called a layout. Several layouts are available, including a
Basic Layout (Fig. 44-A) (this one is shown with a Sections Filter). Figure 44-B shows a
Default estimating layout. Layouts can be modified by adding or removing columns.
Each time a takeoff is performed, it adds a new row. Deleting a takeoff removes a row.

Takeoff totals appear at the bottom of the layout. New layouts may also be created

with the green “+” in the Estimating Layouts window (select an existing layout, click on

the green +, give the layout a name, and the new layout will be based on the layout

that was selected). PlanSwift provides a way to export estimating data to Excel.

Estimating data is also used for generating reports.
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Manipulating an Estimating Layout

Clicking on the Columns button on the Estimating tab ribbon-bar opens the Estimating
Columns window (Fig. 44-C).

Clicking on the green “+” allows you to add a new column to the layout and give it a
name. Clicking on the red “X” will remove a selected column from the layout.

The Estimating Columns window also allows you to see the Data Type, select whether
the column is Visible, select whether the units are visible (Show Units), and view the
Format. The red Close icon to the right of the red X closes the window.
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Rows can be moved up or down either by selecting, dragging, moving, and dropping
the rows into folders or using the up and down Adjust arrows (Fig. 44-D). The left and
right Adjust arrows will change a selected row’s hierarchical order, or items can be
dragged and dropped to a different parent item or folder on the layout.

The Templates, Input window allows for templates to be dragged and dropped onto
takeoffs in the Layout window. Templates are covered in Templates Overview.
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Figure 44-D

Exporting Estimating Data to Excel

To export data to an Excel spreadsheet, simply click on the Export to Excel button on
the Estimating tab (Fig. 44-E). This opens Excel, and the data is automatically exported
into a spreadsheet. Figure 44-F shows the data from Fig. 44-E in an Excel spreadsheet.
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2 sample Plan Takeoffs 0
3 Lobby 101 900.85 SQFT 0 0 0 0 0
4: Installation Contract Install only 1 EA 650 650 0 650 650
5 |Hardwood Flooring 40 5Q FT per box, 1/2" x 5" Qak Plank, Engineered 24.77 Box(s) 56.45 1398.27 0 56.45 1398.27
6: Ceiling Grid 300 SQ FT per Box 4 Box(s) 32.1 128.4 20 38.52 154.08
7 |Acoustical Ceiling Tile 2'x 4' Tiles 124 EA 2.2 272.8 20 2.64 327.36
3: Install Ceiling Grid and Tiles 900.85 SQ FT 0.45 405.38 0 0.45 405.38
9 Section 900.85 SQFT
T(i Residential Plan Takeoffs
11 New Area 0 SQFT 0 0 0 0 0
T{Three—cargarage 0 SQFT 0 0 0 0 0
13 | Exterior Trim Drip Edge 109.9 FT 0 0 0 0 0
14: Exterior Rock River Rock 264.91 SQ FT 0 0 0 4] 0
15 |Exterior Siding Vinyl Siding 405.44 SQFT o] o] 0 0 0
16: Restrooms Floor Tile 276.14 SQFT 0 0 0 4] 0
17 |Game Room Drywall Ceiling 627.59 SQFT o] o] 0 0 0
TEE Offices 2x4 Accoustical Ceiling Tile 322.74 SQFT 0 0 0 4] 0
19 | Interior Doors Solid Core 14 EA o] o] 0 0 0
2(£ Conference Room Carpet 505.54 SQ FT 0 0 0 4] 0
21 Exterior Walls Typical Wood Framed Wall 266.08 FT o] o] 0 0 0
22: Interior Walls Typical Metal Framed Wall 294.37 FT 0 0 0 0 0
23 | Common Room Hardwood Flooring 696.43 SQFT 0 0 0 0 0
24 | Carpet Brown 0 SQFT 0 0 0 0 0

Figure 44-F
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Reports Overview

The Reports tab provides a means to generate and organize reports using estimating
data from the Estimating tab. Reports are used to group, sort, filter, and “dress up” the
estimating data for a nicer presentation. PlanSwift provides both a basic report engine
and a Report Designer engine that allows for greater customization and “dressing up”.

The basic report engine utilizes several key features to refine what is included in the

reports and how the reports are displayed (including Customize, Report Settings,
Columns, and Page Setup).

The Report Designer engine is built on top of the Fast Reports engine and is not shown
on the ribbon-bar by default. All Report Designer reports are built on top of basic
reports.
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Basic Report Engine

Figure 45-A shows a basic report using the same estimating data as shown in Figure 44-
A. This report is filtering the estimating data to show All Items (by Type, by Folder) in
the Grid View.

Settings | Reports | help Puuging o | Und JPlanSwift Professional 10.2 - Sample Plan -- Estimating T.. - = X
e U S

llap Report | Export Export Export Export Export  ExportTo  Print

All Designer | To Excel toCSV toXML toHTML toPDF Excel Template

Export

Fig. 45-A

TH+0G 9.0 Reports\Reports for ALL Ttems\All Ttems (by Type, by Folder)
= @ 9.0Regorts Type
= 1(2) Reports for ALL 1
Lol Elon  Name " Desaription Qy Units CostEach Makup%  PriceEach  Price Total Division |
sk 41 Ttems (by Type) | |5 Type : Avea (5UM=8099.80, $91,422.95)
g‘ Al Items (by Folder, by Type) =1
g = Folder : Sample Plan Takeoffs (SUM=500.85, §12,945.21) ;
=& _n “::Tm’ i | | | [Egliobby 101 900.85 5Q FT $12.50 15 $14.37 $12,945.21|
| i ARParts (oy Location) || Folder : Takeoff (SUM=7138.95, §75,477.74) ;
ik, Al Farts (by Divison) | @9 vent_ By Sqry Jm) Ll oo _foon]
ok Al Parts (by Lke Ttems) L 23 |Roof Area FT $.20] 15 $3.68 $13,962.88|
Il Al Parts (by Folder) 7 Restrooms. Floor Tile FT $15.20| 15 $17.98 $4,826.93)
= 2 Reportsfor Pars B 3 Rest Room Tie FT $12.78| 15 $14.70 $3,966.79|
i, Material Parts (by Location) | | |Sp|ofe=s J2x4 Accoustical Cefing The LicJ £20.00) 154 £23.00 $A5.021
sk Labor Parts (by Lk ftems) | 7| Game Room |Drywal Cefing FT $10.50| 15, $12.53 $7,853.70
e, Equpment Parts (by Like Items) | | | 7 |Exterior Sidng Vinyl Siding FT $11.25 15 $12.94) $5,246.39
k. Subconiract Parts (by Lie Ttems] 7 [Exterior Rock |River Rock FT $30.00) 15 $34.50 $9,139.40|
:_.:l Materials Part (by Lie Items) B 23 |Ducting FT 0.00| 0 50.00 50.00|
| il Material Parts (by Folder) | £33 |Conference Room |Carpet FT .00 15, $10.35 $5,232.34
Ei@ I:eoxv_l!ewls | 3 |Common Room Hardwood Figoring ) FT $25.93 15 $29.89 $20,816.29
=0 Sﬂm‘f Reports || | |Gofarea T $0.00| 0 50.00 2.0
Takeoff with Markup by Folder G/area T .00/ 2 £0.00 .00/
k. T""""""‘“’::““ Type I 3 |Area 0/sQFT $0.00] 0 $0.00 $0.00|
1 Tobeoff Costvs | : =0.00, $0.00)
.'.‘a. Takeoff Cost
1 Takeoff with Markup T . G300 42 9nm
ﬁ Takeoff Summary H EAMELY m’ﬂmm] T T
E £ Detad Reports |3 #|mterior Doors soid Core 13]EA $120.00] 15 suman| $1,932.00]
1E3 Detaled - L{I‘ryn! mrodtsn-non,wm
. subcontract Summary List | | Type : Labor (SUM=200.85, $468.44)
1l Subcontract Summary by Fok Type : Linear (SUM=1205.57, §39,602.01) _
a Subcontract Costing by Folde|: : Takeoff (SUM=1209.57, $39,602.01)
b Subcontract Costvs Sel | 12 |Linear | 27562 FT 0 $0.00 $0.00|
=1 ) Detaled Material Reports 171 | Interior Walls Typical Metal Framed Wal 294,37 FT 15 $28.75 58,9634
ph Material Summary - Like Item: 11 [Footing | 2626[FT 15 $43.70 $11,475.62
i, Material Costing- Lie Items v 11 Exterior wals Typical Wood Framed Wal 266,08 FT 15, 5440 $17,135.55)
g_ Project Material Cost 11 [Exterior Trim Drip Edge 109.9 FT 15 $23.00 $2,527.70,
i, Material Cost vs Sel Type : Material (SUM=152.77, $2,069.47)
=12 Detaied Labor Reparts = Folder : Sample Plan Takeoffs (SUM=152.77, $2,069.47)
fsk Labor Costing with Markap 5 Hardwood Fisaring 140 SQFT per box, 1/2x 5" OskE, $56.45 15 8492 $1,608.07 9 Fnishes
s abce Ripurt |ceing Grid__ 1300 SQ FT per Bax $32.10 15| $36.92 $147.68|3 Fiishes
i, Labor Hours by Folder & | Acousbeal Ceing Tie 7 x4 Ties 2.2 15 $2.53 $313.72/9 Frishes
el T |15 Type : Price Per SQFT (SUM=0.00, $0.00)
Jo e 5 Folder : Takeoff (SUM=0.00, $0.00)
1§ preper sQeT osarT 2.00] O .00
: Roof Area (SUM=0.00, $0.00)
= Folder : Takeoff (SUM=0.00, $0.00) i
. | [ Wroof area [ 0/sqFT $0.00| 0] $0.00| $0.00]
i, Equipment Cost vs Sel El‘rvn: Sew-nm-m.um.un]
) Detaied Overhead (Other) )
= 123 Reports Showng Al Ttems | 28.13FT $0.00| 9 $0.00| $0.00
i, Detaled Estimate - Customer Cog
I, Detailed Estimate with Markup |_m mmrmau-m,swsm :
i, Project Costvs Sel | & nstallation Contract Instal only [ 1EA 550,00 15 s74n.50] §747.50
e, Project Costs
[# 1) vendor Requests
B Quote Summary
lﬁ Quate (by Division)
i, Quote
o, Bid Cost
$136,242.37
x (IsTakeoffltem = True) or (Type in (Matenal, Labor, Equipment, Subcontract, Other, Part, Assembly)
p
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The Columns button on the Reports tab opens the Reports Columns window, which
allows you to define the columns and the data types (Fig. 45-B). Data is populated from
the properties of the items in the Estimating tab.

D

= 3.0 Reparts
=3 Repaorts for ALL Items.
| | HHasl A8 Trems by Type, by Folder)
i All Ttems (by Type)
el Al Items (by Folder, by Type)
e, Al Ttems (b Division)
=13 Reparts for ALL Parts
el Al Parts (by Location)
T, Al Parts (by Divison]
ped, Al Parts (by Like Ttems)
1w All Parts (by Foider)
=1 Reports for Parts
s, Mateial Parts (by Locator)
i, Labor Parts (by Lke ftems)
e, Equipment Parts (by Like Items)
i Subcsntract Parts (by Like Ttems)
T, Materials Part (by Lie ltems)
el Material Parts (by Folder)
=@ Legacy Reports
=(3 Basic Takeoff Reports
a'.‘i Takeoff with Markup by Folder
i, Takeoff with Markup by Type
e Takeoff Cost vs Sel
il Takeoff Cost
T, Takeoff with Markup
i TakesfF Summary
=13 Detad Reparts
=1 2 Detaled Subcontracts
[mi Subcontract Summary List

i, Subcontract Cost vs Sell
= 2 Detaled Material Reports

1w, Subcontract Summary by Fok© | |
ik, Subcontract Costing by Folde © |

i, Material Summary - Like Item:

Print Page Report [ICe ns | Refresh Expand Collapse  Report Export Export Export Export Export Export To Print
Preview Setup Settings | | Data All All Designer | To Excel toCSV toXML toHTML toPDF Excel Template
Report Actions Export
Report Layouts <« | Preview GridView | settings |
“H+OZH 9.0 Reports\Reports for ALL Ttems\All Items (by Type, by Folder)

! ERepor‘ts olumns

l+ezo

x|

Name

-

< <] [<]|<][<]

T E2 1 2 T E 1 ] [ T T )

Show Units

:llﬂlls.:an.m

agz s
ok
|Peue, 220,00

Group Summary | Group Format | Group Footer Format

IDeujz,#20.00 |

I
-

Figure 45-B
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Clicking on Customize (found in the bottom-right corner of the Grid View tab) opens

the Filter builder window (Fig. 45-C). New conditions and groups can be added and

removed or modified using Data and commands from the drop-down menus. Data is

populated from the visible columns in the report, and those columns pull Data from

the properties of the items in the Estimating tab.

9.0 Reports\Repo

Preview  Grid View Setﬁngsl

ks for ALL Ttems\ All Items (by Type, by Folder)

T &
Foder

‘E Filter builder - [untitled flt] >

OR  <root>

------ D I=Takeoffltern eguals True
> D Type in { Material , Labor , Equipment, Subcontract, Other , Part, Assembly )
------ D AND  applies to the following conditions

------ D Data like <empty=
------ D AND  applies to the following conditions

------ D Data like =empty=
| press the button to add a new condition

g
i
;
2
i
o
g

«

Add Condition
Add Group

Remove Row

E Data like <empty=

|Z| Data: ke <empty .| Data like! <empty>
Data - |:| — equals ~

Icon ¥ === |does not equal

MName Data

ItemPath ¥ |Z| — |is less than or equal to
m Type i press the bjis greater than

Description - iz greater than or equal to

like
Sr?ts not like
Cost Each i blank
Markup % iz not blank

Price Each between
Markup Each % not between W

Figure 45-C
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The Report Settings button opens the Format Report window and allows you to set up
the formatting for the View, Behavior, Formatting, Styles, Preview Cards, and any

Charts (Fig. 45-D).

ating Lists Templates  Settings | Reports | Help Plugins [search

| Columns Refresh Expand Collapse

heoeoen aaag s w

Export Export Export Export Export
To Excel toCSV toXML to HTML

Report

Data All All Designer

f - Report Actions

ft Profes:

to PDF
Export

siona

D

Expaort Ta
Excel Templ3

=0 Reparts for ALL Itams
[ ] -—p_.:g_mmnwmc,wruua)
i, All Ttems (by Type)
i, il Items (by Folder, by Type)
il Al Items (by Division)
= 1) Reparts for ALL Parts
p:!.l\lpwh{bﬂuulim}
{u, All Parts (by Division)
pell. All Parts (by Like Items)
nel All Parts (by Fokder)
=122 Reparts for Parts
i, Material Parts (by Location)
i, Labor Parts (by Like [tems)
e, Equipment Parts (bry Like Items)
e, Subcontract Parts (by Like [tems)
T, Materials Part (by Lie Items)
el Material Parts (by Folder)
= @ Legacy Reports
=123 Basic Takeoff Reports
bl TakeofF with Markup by Folder
e, Takeoff with Markup by Type
s, Takeoff Cost vs Sel
i, Takeoff Cost
el Takeoff with Markup
i, TakeofF Summary
= {2 Detal Reports
=1 {2 Detaied Subcontracts

hwl, Subconiract Cost vs Sel
=12 Detailed Masterial Reports

bl Subcontract Summary List |
bl Subcontract Summary by Fok ;
fud. Subcontract Casting by Folde

Preview Grid View | settings |
9.0 Reports\Reports for ALL Ttems\ All Items (by Type, by Folder)

{£} Format Report

Im Behaviors | Formatting | Styles | Preview | Cards | Charts

Adodal

[ sov

_, =

«| Footers

|+ Group Footers

il _| Expand Buttons | [Fora
_| Filter Bar

On Every Page

|| Headers
|# | Footers
(& Tye || Filter Bar

XS 4.8n

[58 Quatire

|4 Challengs |

e —————yryy——y—y ey y—————

| Title Properties. .| | Footote Properties...

g

Figure 45-D
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Once you have filtered the data and set up the report settings and columns the way
you want, the Page Setup button on the Reports tab opens the Page Setup window
and allows you to set up page orientation, print order, shading, paper size, and the
paper source (Fig. 45-E). You can preview the report by clicking on Print Preview at the
bottom of the Page Setup window or the Print Preview button on the Reports tab
ribbon-bar.

“) Home #a : View Estimating Lists Templates Settings | Reports | Help Prugins > et
= e © @ U L bl K &)
gal Gl : c O ol @
Print | Page | Report Columns Refresh Expand Collapse Report Export Export Export Export Export Export T
Preview | Setup | Settings Data Al All Designer | ToExcel toCSVY toXML toHTML toPDF  Excel Templ
Report Actions Export
Report Layouts «i Preview Grid View | settings |
EH+024% | 9.0 Reports\Reports for ALL Items\ All Items (by Type, by Folder)
- @ soneus
_._"]FlmfurALL[u'rs m E{.’ Page Setup %
| | [k AlTtems Gy Type, byFolder) | [§1con — Name
i, AN Items (by Type) =F, e 0
ik Al Items (by Folder, by Type) = _'fp' . “ .{s.':'ﬁ‘mﬁig“a Page | Margins | Header | Foater | Sealing
ol AN Tterms (by Division) 3 |Lobby 101 - Paper — O :
TR Aire Oyt = rot oot || I
bl Al Parts (by Location) | [ [glvent ] = ) Portrait
neil, All Parts {by Division) |5 | =] Legal Lareecape
pad All Parts (by Like Items) | M| Roof Arem E El as
i, All Parts (by Fokder) 57 |Restrooms [E] Japanese Postcard
=) Reparts for Parts |EDRestRoom The | ] s nh
bl Material Parts (by Location) | | |G|Offices i
imd Labor Parts (by Like Ttams) | C37|Game Room | i o
e, Equipment Parts (by Like Ttems) |GplExtenorsiang | | | |
il Subcontract Parts (by Like Items]) 37 |Exterior Rock [E] custom size
1l Materials Part (by Like Items) | 52Ducting 1 Print Order
| iml, Material Parts (by Folder) | | 53| Conference Room | | Ry L
7 @ Legacy Reports 3| Common Room —
= -;_)_BfchalneuHRmB .I:'.'J..ﬁr!a y Width: T . _] ) Over, then down
s, TakeofF with Markup by Folder (iBplAves 1 : :
i, Takeoff with Markaup by Type e Heght: 11.001n * | | shading
E Iﬁgg“:wm |FE] Type : Crdle (SUM=0.00, 9 Print using gray shading
. e =] Type : Count (SUM=14.00,
i s = Faldar : Takeoff (SUM=
ok, TakeofF Summary s Evice: Sl NS
e Datad Reparts _|_|§{interor Doors [ x |[ e
=1 £ Detaled Subcontracts [ e e
Figure 45-E

171



Clicking Print Preview opens the Preview PlanSwift Report window and allows you to
make further refinements before you print the report (Fig. 45-F).

|2 Preview Planswift Report _ O X

| File view Format Go

CE USSR B ERN EEODE M M| V] e e T | e

[E—— 0.5n Top:| 0.5 Rght|  0.5n| Botom:| 0.5 Header:|  0.25m| Foote:|  0.25m

Teon Name + Description |ty [Units  CostEach Madup% PriceEach PriceTotsl  Division
Type : Area(SUM=8099.80, $91,422.95)
Folder : Sample Plan Takeoffs(SUM=000.85, $12.945.21)

1) Reports for ALL Items
ik, Al Ttems (by Type, by
i, All Ttems (by Type)

B e o im|].,ubby 101 900.85(SQ FT $12.50| 15 $1437 $12,94521)
y Folder, 1 | L | L
bl Al Ttems (by Division] Folder : Takeof{SUM=7198 95, S78,471.74)

=@ 5:1.'“.-.’1‘?:,’;:@) £ | Vent 8.89|SQFT $0.00 0 $0.00 50.00
1o, AllParts (by Divison) £ Roof Area | 37946/sQFT $320 15| $368 $13,96288
3 :M g '-:’:7“3 £ |Restrooms [Floor Tile 276,14 SQFT $1520 15| s1748 $4.82693

Parts Fi - | |
€3 Reports fir Parts ()| Rest Room Tile | 260s3[sQFT s12.78 15| su $3,966.79
i, Material Parts (by Locaton) [ |Offces 234 Accoustical Ceiling T~ 32274 SQFT 520.00 15 52300 $745.02
E:,l (Game Room | Drywall Ceiling 627.59 SQFT $10.90 15 $12.53 §7,863.70
7] Exterior Siding Vinyl Siding 403.44(SQFT $1125 15| s 524639

e, Materials Part (by Like Items)| - - . 1
i, Matesil Parts (by Foldes) (07 |Exterior Rack |Rver Rock | 26491/sQFT $30.00 15| 53450 $9,139.40
'@ Legacy Reports [ Ducting 2716/ SQFT $0.00 [ $0.00 50.00

[= ) Basic Takeoff Reports T e

B Takeoffuith i (7] Conference Room |Carpet 505.54|SQ FT $9.00 15| s103s $523234
g Takeoff with Markup by Type| [77]|Common Room |Hardwood Flooning 696.43 SQFT 52599 15| §20.89 520,816.29

Takeoff Cost vs Sel i e i
o TekeoffCost 7 Area 0/SQFT $0.00 0 $0.00 50.00
Tl Takeoff with Markup | Area 0/SQFT $0.00 0| $0.00 $0.00

% E ;mrrmw £ Ara [ 0/sQFT | so0o00 of 50.00 50.00 1

Type - Circle(SUM=0.00, 50.00)

Type : Count(SUM=14.00, $1,932.00)

" Folder: Takeoff§{SUM=14.00, $1,952.00)

I': Ihltem;Dm Solid Care T 18EA 512000 15]  swzsoo]  siex00 00
Type : Joist Too SUM=0,

" Type LaborSUM-IOLS, S840

 Type:Linea(SUM=15.7,$3940201)

Folder : Takeoff{SUM=1209.57, $39,602.01)

Iz |Linear [ so00] of  soo0 50.00]
177 nterior Wals Typical Metal Framed Wall 525,00 (RS 846314
1-; Footing 538,00 5| se  siane
1-; Exterior Walls 536,00 5 ses0  s1sss
|- [Extesior Taim 2000 5] 5300 XE

E -:rw!..:\mm' SUM-uZ.??,m.J?) - -

" Folder: Sample Plan Takeoffs(SUM=15277, $2,069.47)
® 9 | Hardwood Flooring [405QFT perbox, 12°x3"[  2477[Box(s) | 83645 15 seas $1,608.07 9 Finishe:

2 |Cetling Grid 1300 SQ FT per Box [ YBows) | sam0 1 see 147,68 9 Finishes
&9 | Acoustical Ceiling Tile ';i"xi"ﬁu | 24EA | 8220 15 5283 §313.72 9 Finishe:

" Type:PricePerSQFT(SUM=000,5000) ' ' ' ' ) ;
Foldes : Takeof(SUM=0.00, 50.00)

| @Peresorr ] o | e o wwwm ,
i quots Page:| 1) of | 2| rPages| PapersSee:| 85inx1ln|  Stats: Resdy

Figure 45-F
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Report Designer

Once you have set up your report with the basic report engine, you can click on
Preview to see the report data as you set it up with the basic report designer (Fig. 45-
G). Notice that when you click on Preview, the only Report Actions group buttons now
available are the Page Setup and the Report Designer button.

Note: The Report Designer button will not be visible until it is turned on in the
Interface Settings available on the Settings tab of the Main ribbon-bar menu.) When

the Show ReportDesigner checkbox is checked, the Report Designer button is
displayed on the Reports tab. Before the button is displayed, you are asked to confirm
that this is an advanced tool that may require additional training that is not covered

under the annual maintenance agreement.

The Print Preview, Columns, Refresh Data, Expand All and Collapse All buttons are
only associated with the basic report engine, and so they are not selectable. The Page
Setup button opens the Page Settings window, also shown in Fig. 45-G, where you can
set page size, orientation, and margins for the current page or for all pages.

“3) Home Page Toolgf View Estimating Lists Templates Settings Reports | Help Plugins ~=*~
s
- | ] B EE [l (X2 -
| 0 & &G&E &8 &8 8 =
G Page eshy Report | Export Export Export Export Expot  ExpotTo  Print
Sef a Designer | ToBxcel toCSV toXML toHTML toPDF Excel Template
Report fons Export
Report Layouts S, Freven | G vew | Sets | << page 1ot
- + 0%
; - All Items (by Type, by Folder)
Type: Area
Folder: Sample Plan Takeoffs
lcoName Description aty units GostEach Markup % Price Each Price Total _Division
(m  Lobby 101 90085 SQFT $1250 1500 $14.57 §12.04521
90085 $12.945.21
Folder: Takeoff
lco  Name Descrguon C}E! Units. CostEach Maﬂ(ue'h Price Each Price Total DW_D‘SIOI\
(m vent 880 SQFT 0.0 000 5000 5000
(m Roof Area 26 SQFT 0 1500 sa68 $13.96288
(m  Restrooms Floor Tile 276 TBWgQ FT 1520 1500 1748 482603
(im Rest Room Tile 26985 SQ ‘PEQESE&\HQS % t‘M 70 $3,966.79
(m  Offices 214 Accoustical Celling Tile 2274 SQFT | 23,00 §7.423.02
(im  Game Room Drywall Celing 62759 SQFT | o 3] 1253 $7.863.70
(m  Exterior Siding Vinyl Siding 40544 SQFT | yatr [ Jem §1204 $5.246.39
(im  Exterior Rock River Rock 26491 SQFT | meght |21 |am §34 50 $9,139.40
(m  Ducting 27.16 SQFT 5000 5000
(m  Conference Room Campet 50554 SQFT | Oportat ~ #1035 $5.232.34
(m  Common Room Hardwood Floofing 60643 SQFT | @tandscae i2089 2081629
(m  Area 000 SQFT | Mwans = 5000 5000
(m Area 000 saFT | Ut L= R [t ;g0 5000
To [1 Jom  Botm |1 |om
(m Area 000 SQFT 5000 5000
ther
715895 i $TBATTT4
8.099.80 s $91.42295
Type: Circlk
Folder: Take: |I] Cancel
lco Name Description Qty Units Costeacn Markup % Pnce Each Price Total Division
(m New Count 000 EA 5000 000 5000 5000
11192018 5 i Page 1 of 4
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Clicking on Settings allows you to enter bid information and terms and conditions (Fig.
45-H). This button is also associated with the Report Designer engine, so information
that is entered here will be available when you click on the Report Designer button.
The four reports indicated in the Reports Layouts window are reports that have been
created by the Report Designer. These reports can be used, copied, and modified, and
the information in the Settings screen will apply only to those and to any copies made
from them. The Settings information is not associated with any of the 9.0 Reports or
the Legacy Reports in the Report Layouts window.

‘o_' Home Page Tools View Estimating Lists Templates Settings Repors Help Plugins e PlanSwif
Cy B B B By
) | E R g ez O 5] =
Page - S r Refre pan cJult: Report Export Export Export Export xport Export To Print
Setup Setting ata A i Designer | ToExcel toCSV toXML to HTML Excel Template
Report Actions Export
-R'pon La)luu‘s -\e- | Preview | Grid view  Setiings ]
= + 028 | Company Information
‘e sdectod Prepwre: Terms and Conditrs:
+ 4 |egacy Reporis ABC Company v m Terms are here.
e, Quote Suwmw‘_ Bidl Prepared By:
el Quote (by Division) 1— Yoher Smithh
e, Quote
iud DI Cost Select Target Customer: =
it ;
30 Days "
Default Sales Tax Rates:
Gales Tax 1 Sales Tax 2
|6.85 0.00
Taxable Items
[#] Material
Equ-pmem D‘Iher
[+ Labar [ ] subcontract

Figure 45-H
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Clicking on the Report Designer button opens the SwiftReport window (Fig. 45-1),

which shows a default report design.

@ swittReport - Untitled fr3
File Edit Report View Help

DSdBlEnml s L@

i -] T avial

[ X |_/Code (Do Page1

~ [ Page1
* -£ ReportTitiel
o P A Memol
£ MasterDatal
~ -3 GroupHeadsrl
i P A Memo2
3 Grouptieader2
A Memo3
A MemoS
e A Memo7
A Memog
LA Memoll v
>

<

ReportTitle: ReportTilel

All Items (by Type, by Folder)

1=
Pagel: ThixReportPage

Type: [EstData."Type"]

EstData, Type™

AEMBE>»IHQREOG

Properties | Events
BadkPicture ot assigned) |

BottomMargi 1
Color M dione
Colmns 0
DataSet  {Not assigned)
Duplex  dmiione
EndlessHeighl] False
EndlessWidth[ ] False

EIFont (rFont)

EFrame  (TfErame)
LargeDesignt[] False
LefiMargin 1
wirrorvargine ] False
Name  Pagel
Orientation  polandscape
OutneText
PageCount 1
PaperHeight 21,59
Papersize  Legal
PaperWidth 35.56
PrintlfEmpty (¢ True
PrintCnPrevic False
Resetpaget [ False
Rightiargn 1

0

Tag

TitleBeforerielv] True
TopMargn 1
Visible True

BackPicture
The background page picture

Centmeters 11,77, 087

[Es [EstDataName']

" Description

" [EstData. Description’]

Folder: [EstData.
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If you click on the Preview button in the SwiftReport Window, a Preview window
opens (Fig. 45-J), showing the same data you developed using the simple report engine
(see Fig. 45-G). Use the Report Designer tools from here to modify the report as
required. Note that you may need additional training to utilize Report Designer. Please
contact PlanSwift for this training.
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Figure 45-K shows an example of a Reports Design report showing a Quote (by

Division) layout.
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Plugins Overview

PlanSwift was designed to be expandable through the addition of plugins. Plugins allow
you to quickly and easily customize your PlanSwift platform and differentiate you from
your competition. Plugins are comparable to apps for a smart phone because they
enhance the capabilities of PlanSwift’s core utility.

Plugins, or add-ons, include custom applications and custom content. Custom
application plugins are of three main plugin types: Shell Execute, Executable, and Script
Code. Custom content plugins can include templates, parts, assemblies, lists,
estimating layouts, and reports. Plugins can be either content-only (such as any Starter
Pack), or an application only (such as SwiftMaps or Excel Import Tool), or a
combination of both content and an application (such as EarthWorkPro).

Clicking on the Plugins tab (Fig. 46-A) opens the PlanSwift Plugin Store, where you can
select from various plugins. Starter Packs contain a large library of prebuilt templates,
parts, and assemblies, which can be modified to users’ specific needs. Utilizing a starter
pack is a good starting point for building custom parts and assemblies. Each plugin has
its own User Guide with instructions for installation and use and a compendium listing
all included parts and assembilies.
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Fig. 46-A
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Advanced Features Overview

The Advanced Features Overview will cover the buttons on the Page tab, the Tools tab,
View tab, Lists tab, and Settings tab.

Page Tab

The Page tab allows for page manipulations, such as adding, renaming, rotating,
flipping, inverting, cropping, copying, setting the origin and offset origin, and closing
(Fig. 47-A).

y4
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00 6 06000 0 90D OO

Figure 47-A

1. The Add Pages button is covered under Importing Additional Pages in this User
Guide.

2. The Batch Rename Pages button is covered under Batch Renaming Multiple
Pages in this User Guide.

3. The Add Pages From Planroom button is not implemented.

4. The Rotate Left and Rotate Right buttons rotate the page left or right 90
degrees each time they are clicked on. These buttons do not function if the page
has any objects (such as takeoffs, notes, etc.) on it. The Undo button does not
undo a rotation.

5. The Rotate 180 button rotates the page 180 degrees. This button does not
function if the page has any objects (such as takeoffs, notes, etc.) on it. The
Undo button does not undo a rotation.

6. The Level button allows you to click on two Points on the page and have the
drawing leveled to those two Points. Items such as takeoffs are also leveled. The
Undo button does not undo any change in level.
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7. The Batch Rotate Pages button opens the Batch Rotate window (Fig. 47-B). The
Batch Rotate Pages tool rotates both the page and the takeoff items. You can
start the rotation at the first page, the current page, or the selected page (or
pages). To select multiple pages, hold the Ctrl key down to select the pages
(from the Pages, Bookmarks window) that are to be rotated before clicking on
the Batch Rotate Pages button. Select Rotate Left, Rotate Right, or Rotate 180,
then click on Start to begin the rotations. A status bar shows the progress. The
Undo button does not undo any batch rotations.

(®) Start with first page (®) Rotate Left ;
() Start with current page () Rotate Right
() Selected pages () Rotate 180

v Start x Cancel

Figure 47-B

8. The Flip Vertically and Flip Horizontally buttons flip the currently displayed page
and any takeoff items either vertically or horizontally. The Undo button does not
undo flips.

9. The Invert button inverts the page color, so black becomes white and white
becomes black. Takeoff colors remain the same. Click Invert a second time to
un-invert a page.
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10. The Crop as New Page button allows you to select an area on a page and copy
that area to a new page:
a. Click on one corner of the area to be cropped (Fig. 47-C).
b. Drag a box over the area to be cropped.
c. Inthe Properties — [New Page] window, give the new page a name.
d. Click on Ok to create the page.
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o
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Name
or ooy 4
Imput Advanced Form O Cancel
-'_-:_ —1_ L T & T 0 T —] . - — __:_ ..... B ht! -'
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] e e B ey S | i e i ¥ S— S . S f i
I 1l (] i fu I
1} i i [ L] I
It 1 U [l 1 !
e = 4 i Iy v
] [l " o i I
¥ 1 i 1 t I
i it ] i | i oy TOPOF BB 4
] ] ] | : U

Figure 47-C

11. The Copy to Clipboard button allows you to select an area on a page (by
dragging a box) and copying that area to the Clipboard. You can then paste it
into any other application.

12. The Set Origin button is used (rarely) to set the grid origin Point.

13. The Offset Origin button is used (rarely) to set an offset to a grid origin Point.

14. The Close Page button closes the currently displayed page.
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Tools Tab

The Tools tab provides tools that allow you to rotate and flip takeoff items, calculate
the pitch and angle of two Points, calculate the angles and lengths of legs of triangles,
convert PDF to TIF files, zip and unzip jobs (covered here), attach an Excel file to a job,
open an Excel file in a job, and save a screenshot (Fig. 48-A).

|5earch | |

A?) Home Page @ Tools | View Estimating Lists Templates Settings Reports Help Plugins

[ [tals] |

£ = A A Y T I E @
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Rotate Rotate Flip Flip Pitch  Triangulate PDF to TIF Zip Unzip Attach Excel Open Excel Save
Left Right  Vertically Harizontally Converter Swiftlob  Swiftlob File to Job File in Job Screenshot

Takeoff [tem Calculations Convert Zip Excel Files Other

O 0 00 ©

0O 0 0

Figure 48-A

1. The Rotate Left and Rotate Right buttons will rotate a selected takeoff item (or
items) left or right.

2. The Flip Vertically and Flip Horizontally buttons will flip a selected takeoff item
(or items) either vertically or horizontally.
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3. The Pitch button measures the pitch of any two Points clicked on. To measure
the pitch of two Points:
Click on the Pitch button on the Tools tab (Fig. 48-B).

a.
b.
C.

Click on the first Point.

Click on the second Point (remember to press the M key on the keyboard

to enlarge an area if needed).

. A window opens showing the Pitch and the Angle.
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Figure 48-B
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4. The Triangulate button measures the angles and lengths of a triangle’s legs. To
obtain the measurements of a triangle’s legs and angles:
a. Click on the Triangulate button on the Tools tab (Fig. 48-C).
b. Click on the first Point of the triangle.
c. Click on the second Point of the triangle.
d. Click on the third Point of the triangle. The values of the angles and
lengths of the legs are displayed.
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Figure 48-C
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5. The PDF to TIF Converter button provides an easy way to convert PDF files to TIF
files. To convert PDF files to TIF files:
a. Click on the PDF to TIF Converter button (Fig. 48-D).
b. This opens the PDF to TIF Converter window.
c. Click on Select Folder and navigate to the PDF file location.
d. Select the PDF file to be converted to TIF.
e. Select the output folder. The DPI for TIF Files and Format (grayscale) of
the output can also be selected.
Click on Convert.
The converted files are listed in the lower window.
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6. The Attach Excel File to Job button allows you to attach an Excel file to the
PlanSwift job and stores it under Attachments. To attach an Excel file to a job:
a. Click on Attach Excel File to Job button on the Tools tab (Fig. 48-E).
b. Navigate to the location where the Excel file is stored.
c. Click on the file to be attached.
d. Click on Open.
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Figure 48-E

e. The Excel file is stored in the Attachments window (Fig. 48-F).
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Figure 48-F
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7. The Open Excel File in Job button allows you to easily open an Excel file. To open
an Excel file:
a. Click on the Open Excel File in Job button on the Tools tab (Fig. 48-G).
b. Navigate to where the Excel file is.
c. Click on the Excel file to be opened.
d. Click on Open. Excel will open the selected file.
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Figure 48-G
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8. The Save Screenshot button captures the contents of the PlanSwift plan
window, allows you to save it (as a JPG, JPEG, TIF, or BMP) with a name of your
choice and in a location of your choice. To capture a screenshot:

a. Click on Save Screenshot from the Tools tab (Fig. 48-H).

b. Navigate to where you want the screenshot saved.

c. Enter afilename for the screenshot.

d. Select the image type (JPG, JPEG, TIF, or BMP).

e. Click on Save to save the screenshot in the location you specified.
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View Tab

The View tab has two groups of buttons: Show/Hide and Adjustments. The buttons in
the Show / Hide group do exactly what they say: they show and hide labels, items,
overlays, dimensions, notes, and cut-lines (#1 of Fig. 49-A). The Adjustments group
tools are more advanced (#2 of Fig. 49-A). To adjust labels, it’s important to
understand what a label is: a label is a special annotation that is created when a
takeoff item is created (#3 of Fig. 49-B). By default, labels are not displayed. To display
a label for a takeoff item, right-click on the takeoff item you want the label displayed
for, then select Show Label from the drop-down menu (#4 of Fig. 49-B). The default
settings for Labels, Notes, and Dimensions can be changed by clicking on Annotations
in the Settings tab.
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Figure 49-A
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The Adjust Notes, Adjust Dimensions, and Adjust Labels buttons (Fig. 49-C) are

explained next.

L
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Figure 49-C
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1. The Adjust Notes button allows you to change the properties of notes. To
change the properties of a note:
a. Click on Adjust Notes from the View tab (Fig. 49-D).
b. This opens the Adjust Notes window. The Font Color, Font, Background
Color, and Border Color are self-explanatory.
c. Change the Height of the font (“2” is twice as high as “1”).
d. Sliding the slider bar to the right lightens the transparency; left darkens it.

Qq} A |
Hide Ajust Adjust Adjust
LitLines Labels Dimensions | Motes

Adjustments

Adjust Motes

Fort:
|I' Arial

This is a 512 pitch
roaf.

12

5

Figure 49-D
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2. The Adjust Dimensions button changes the properties of dimension lines (Fig.
49-E). To change the properties of a dimension line:
a. Click on the Adjust Dimension button.
b. This opens the Adjust Dimensions window. The Font and Font Color are
self-explanatory.
c. Change the Height of the font (“2” is twice as high as “1”).
d. Change the Line Color of the dimension line.
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Figure 49-E
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3. The Adjust Label button changes the properties of all labels on a page (Fig. 49-F).

To change the properties of a label:

a.
b.

Click on the Adjust Labels button on the View tab.

This opens the Adjust Labels window. The Font, Font Color, Background
Color, and Border Color are all self-explanatory. After you select a
Background Color, sliding the transparency slider bar to the right lightens
it; left darkens it.

Select the height of the Font; a “2” is twice as high as a “1”. Enter a “2”.

. Figure 48-F shows the Height changes implemented.
. It also shows the Background Color changed and the Transparency slider

moved to the left.
The result with the larger font and lighter blue background is shown here.
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Figure 49-F
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Lists Tab

The Lists tab (Fig. 50-A) provides tools that allow you to create and edit drop-down
menus for lists of items you need to enter frequently (for example, stud sizes). You can
create new lists, delete lists, change the properties of lists, and create new folders or
subfolders for the lists. The types of lists that can be created are Simple Lists, Lists
from MS Access File Tables, and ADO Query Lists. The creation of a simple list,
deleting, viewing properties, and creation of folders and subfolders is covered below.
PlanSwift recommends a training class to use these more advanced features.

/

.
ﬁ) Home Page Tools View Estimating @ Lists | Templates

26 Fx =

Mew Delete Properties Mew
Folder ~
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Figure 50-A
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1. The New button opens the New List — Select List Type window from which you
select the list type (Fig. 50-B). To select a list type:
a. Click Simple List.

b. Click Next.
c. Inthe New Simple List window, enter a name for the list.
d. Click Next.
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Folder -
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Figure 50-B
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e. Enter your list items in the window. If your lists include formulas, check
the Parse Formula box (Fig. 50-C).

#3| Home Page Tools View Estimating Lists  Templates
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Figure 50-C

2. The Delete button deletes any list or folder that is selected. Right-clicking any list
displays a drop-down menu that allows you to delete a list or folder.

3. The Properties button displays the Properties—[listname] window (Fig. 50-D),
where more advanced features (Input, Advanced, and Form) are available. The
properties button is also available by right-clicking any list or folder. PlanSwift
recommends a training class to use these advanced features.

Input Advanced Form Ok Cancel

Figure 50-D

4. The New Folder button allows you to create a folder or subfolder. The top half
of the button creates a folder at the same level as any selected list or folder. The
drop-down half of the button creates a sub-folder to any selected list or folder.
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Settings Tab

Customizing the Interface

The Interface selection (Fig. 51-A) on the Settings tab of the ribbon-bar menu provides
a way to change different settings.
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—— - |rterface Blus w
- Z00m .-"_F'ar‘l [ ] Shaw Under The Hood Screen %
- Apnotations
- Graphics [ | Shows Tupes Tabin Templates Screen

- Takeoff Tools
- Shapping [ ] Show Full Screen Cursor

NF't_if_i':ati':'nS i [#] Dirawe Crozs Hairs Curzor on Image
- Digitizer T ablet

- Property Groups Large Scroll Bars
- Advanced ﬁ Show Flying Toal Hints
Shawe Hower Hints

=[] Show Dev Toalz on Fluginz Tab

Show Brawse Far Jab

ﬁ Dizable Job Locking [requires Lsername when active].

Show ReportDesigner

et [..#| Dizable Eztimage Grid Overtyping

[ ] Show Auto Count Taool

— [ ] Enable Exstended DFI Range for TIFs

Figure 51-A
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1. The Color Scheme provides three color schemes: blue, silver, and black (Fig. 51-
B).

f‘?) Home Page Tools View Estimating Lists Templates @ Settings = Reports Help Plugins joexd --I

License
Manager ~

Licensing

“_‘?) Home Page Tools View FEstimating Lists Templates Settings = Reports Help Plugins preis .!

License
Manager ~

Licensing

Home Page Tools View Estimating Lists Templates Reports Help Plugins

License
Manager *

Figure 51-B
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2. The Show Under The Hood Screen displays the UTH (Under-The-Hood) tab after
a password is entered (Fig. 51-C). Going "Under-The-Hood" allows the
programmer to link to PlanSwift software to develop applications that work with
PlanSwift. Under-The-Hood provides a programmer the capability to link to
PlanSwift software to develop applications that work with PlanSwift. This tab is
used for accessing the Application Programming Interface (API) and is for
developers only. PlanSwift’s technical support team does not support going
under-the-hood. You are on your own! Additional APl information is available
here. We recommend that data be backed up before venturing into the API.

My Warning: Making changes to data Under The Hood can cause data
corruption/floss, and could even cause PlanSwift to crash. Use at your own risk

PlanSwift will not be resposible for lost or incorrect data.

Waming / Disclaimer

[P ]| 2 coen

40‘:- Home Page Tools View Estimating Lists Templates Seftings Reports Help U-TH

&y N
Properties Copy Paste Delete | Refresh Bulk Update Browse to

Properties  PlanSwift Folder
Custom 1

-

4 2

Mame

-
-

@) |Settngs
Job

+ {0 |Storages

#10) [Plugns

+ 'Q-. _Types

i L, nits

# O Lsts

+ ) [Types

H{%| [Reports

+ (1] |Developers

] |[Hatches

#0) |[Estmating

+ | | Textures
i) |Contacts

Figure 51-C
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3. The Show Types Tab in Templates Screen (Fig. 51-D) displays the Types tab in
the Templates screen. The Types tab allows you to make universal changes to
default items. PlanSwift recommends additional training to use this feature.

ﬂj Home Page Tools View Estimating Lists Templales | Seftings Reports Help |
w [1 e 9
Mew MNew  Mew Mew Mew Mew Mew MNew Mew fi
Folder - Item - Area- Linear~ Segment- Count- Assem Part-  Type
G Sample Templates | () Sample Parts | @ Sample Assembles | &
MName |Description |{Price Each Color |
| R ] Area Dropdown ]
0,00 L]
0.00 —
0.00 I
I
I
I
I
I
I
I
.00 N
a.00 ——
0.00 L]
0.00 F—
_ 0.00
&5 Beam Material 0.00
= 3 [Count Dropdown : —
+ * |Labeled Count 0,00
@ [5caled Count 0,00 —
* s |Crde 0.00 I
il [50uare 0.00
« Diamand |o.00 —
¥ [Plus 0.00 ——
A Triangle 0.00 —
= {2 |Linear Dropdown —
B ol Area 0.00 I
i Linear Cubec Yards £ |o.00 —
=+ (2 [segment Dropdown —
& | Segment Cubic Yards 0.00 I
B wiall avea [ 0.00 (!
i+ |Hip-valey Tool 0.00 ——;
Figure 51-D
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4. The Show Full Screen Cursor, when checked, causes the cursor crosshairs to
extend across the page’s entire area. The upper diagram shows just the cursor;
the lower diagram shows the full-screen cursor (Fig. 51-E).

CYTesE W A TR

1. There shall be & landing or fioor on each shde of each axtenor aoor.

Thia wichth of each landing shall not be less than the door served. Every

larding shall have a minimuem denension of 36 inchas (314 mm)

maasured in the diracion of iravel. Extanior landings shall be permifled o+
1o have & slope nol 1o excesd 14 unil vertical in 12 uits horizontal

(2-percent], 2008 IRC Section RI11.3

When & stairway of bwo o fewer risers i3 locabed on the exerior side of a
door athar than the required axil doar, a landing is not requined for tha
exterior sioe of the door provided the door other than an exienon siom
or soreen door does not swing over the siaireay.

The exteror landing at an exierior doorway shall not be more than

-3 inches (186 mm) below the 1op of (he threshaold, provioed the: door
citwr than an exterior storm door or screen door does not swing over the
landing

Thie heightl ol oors al exterior doors ather than the exil door required by
sechion A311.4.1 shall not ba mora than 7 34 inches (193 mm) lower
than the op of the threshold,

Thia wicth of aach landing shall not bo less than e door sarved. Every
larding shall have & minimuem demengion of 36 inches (914 mm)
measured in the direciion of travel

2. Basements, habitable atlics and every sleeping room shall have at
laas! ong opaFable BMEMgENncy BSCADE and resCue opening. Whase 8y
basemants contain one or Mone sleeping rooms, EMeNgency egress
and rescue openings shall e requirsd in each sieeping room. Where

Egress & Exit Notes

1. There shall be a landing or floor on each side of each exterior door.
Thias wicth of sach landing shall not ba less than the door served. Every
lardirg shall have a minimum demension of 36 inches (914 mm)
maagurad in the diraction of travel. Extarior landings shall ba parmitied #
1o Nl & Slope not 10 excied 164 unit vertical In 12 units horzontal
(2-parcent]. 2009 IRC Saction A311.3

When a stairway of fwo or lewer risers |s localed on the exterior side of a
So0r ather than 1he required axil d0or, & landing i ot requIngd kar Tha
exierior side of the door provided the doos other than an exienor siom
of Screen door does Mol swing over the Siareay.

The extersor landing at an exerior doomway shall not be more than

7-3/ inches. (196 mm| below the jop of ihe threshald, provided the door
other than an exterior storm door or scresn door does not Feing ower the
laschioss

Thix height of foors &l extenor doors other than 1he exil door requined by
secion R311 4.1 shall not be more than 7 34 inches (183 mm) lower
thiasn thie top of thn threshold,

\ E
A

Thia width of asch landing shall nol ba less than e door Sarved. Every
landing shall have a minimum demension of 36 inches (914 mm)
measured in the direction of iravel

2. Basemants, habitable attics and svery sleaping room shall have at -
|8321 Ong Oparable SMEergency SSCADE and reScud opanng. Whana * 6-'1 1”5
bﬁmmm:wmnumummvg mmgannyaumu

Figure 51-E
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5. The Draw Cross Hairs Cursor on Image is not Implemented.
6. The Large Scroll Bars, when checked, become twice as wide (Fig. 51-F).

A1.2 A1.2

Kese 1M 10" — 14" = 107

Figure 51-F

7. The Show Flying Tool Hints, when checked, shows the flying tool hints (Fig. 51-
G). Hover the cursor over the tool to see the hint.

CEan
H

i [

Arga Lingar

Area

Figure 51-G
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8. The Show Hover Hints, when checked, shows the takeoff hints when you hover
the cursor over a takeoff (Fig. 51-H).

Game Room Carpet
Section

L 369.94

Area [369.94 5Q FT
Linear Total| 77,16 FT
| Point Count | 4.00 EA

Figure 51-H

9. The Show Dev Tools on Plugins Tab, when checked, shows the developer tools
(Export Plugin Package) button on the Plugins tab (Fig. 51-I). This tool is for
developers only and are not included in PlanSwift support.

#3) Home Page Tools View Estimating Lists Templates Seftings Reports Help  Plugins i [

# = A # € o B~ SR

Tools  Import Plugin  Uninstall Home Back Forward Refresh | Export Plugin @ Upload to
Manager Package Plugin Package Plugin Store
Plugin Tools MNavigate / Developer Tools
Figure 51-1
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10. The Show Browse For Job, when checked, displays a Browse button (#a in
Figure 51-J) on the Open Job window (#b) that allows you to navigate (using the
Select Job Folder window, #c) to other locations where jobs are stored.

= .

Tools View Estimating Lists Templates Settings Reports Help Plugins

QaaQqJ

|Search

= M

e/

Sample Plan - PlanSwift 30 Viewer
Sample Flan - Zone Tool Plugin
Sample Plan - User Guide Complete
27855, 1950 W. Senior Citiren Center
Happy Kids Day Care Center
Savers Savings and Loan Buiding
Lexington Commercial Building
Sterng Diamond Company

Miller Concert Hall

Battle Lines Tour Company

Azalion Flrweer Comnany

E-E Show Me How

—

Print  Email Back Fwd Zoom Fit Zoom Zoom Pan Scale  Dimension Area  Linear Segment Count Single  Send Digitize: New Annotations  Highlighter Note  Owes|
Job Page In  Out = * - * = Ciick = Data Record = Section - -
lob Havigate Zoom / Pan Measure Takeoff Record Annatations
Pages, Bookmarks “ :
T+Oo0BcLOS @ Openlob x
?ach: | * g D_; o — = I
:‘J}] A1 1 Community Center - Sample Plans e | ~ | 36.00 284,00
| A1.2 Floor Plan - Sample Plans o "
! I‘ED Carpet Brown s 1706.7 sc: ; e Local | Delete Properties Move Copy Refresh Columns & Close .
1706.7 537 v a : J
11 Footing w30m M 9 To- To- & Sclect Job Folder O =
£ Game Room Carpet woxr Y Locations ; S
£ Rest Room Tie msar WY ~ [ Deskiop
111 Outside wal Area MLE R ¥ Search: -l OneDive - Planswit Soitware LLC
«* 36 Door Cut Out 167 MV » - [ DaveHansen
2 # 60 by & Door Cut Out 9.0 =T v icon_[Hame ! > - By ThsPC
£ ConferenceRoom Carpet 9940 M Rand's Warchouse e > py Librares
| &1.4Roof Plan - Sample Plans - oE e Sample Flan : ; ok
8] 2.1 Exterior Blevation - Samle Plans @ Stucco firish work for SLC Center Shuceo
il E1.0 Bectrical Fan - Samgie Plans b Community Play¥ard Project East side play area
&l M2. 1 HVAC Plan - Sample Plans & i iy
= ] L1.0 Landscaps Plan - Samle Plans i@ St )
¢ Tree Count woe MY Sample Plan - BuiderTREND
{dl ©1.15ite Plan - Sample Plans - Sampie Plan - Export to Excel by Page

Figure 51-J
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11. The Disable Job Locking has not been implemented.

12. The Show ReportDesigner, when checked, displays the Report Designer button
on the Reports tab (Fig. 51-L). Before the button is displayed, you are asked to
confirm that this is an advanced tool that may require additional training that is

not covered under the annual maintenance agreement.

Sonfirm Y

o The feature you are enabling is an advanced tool for building

custom reports within PlanSwift. The training and support of
this tool are not covered under the annual maintenance
agreement. Support and training on this tocl requires a web
training package. If you already have a web training package
you are welcome to call and schedule some training on the
Report Designer. Please feel free to use this tool on your own.,
Documentation can be found on the Fast Report website,
wwwfast-report.com

If you would like to purchase a 3 hour package and schedule
some training, please call us at 1-888-752-6794 x 1

In crder to enable this tool, you must click "yes" to confirm
that you have read this message and understand how this
tool is supported. If you click "ne” the tool will not be
enabled.

-.‘_"e:) Home Page Tools View Estimating Lists Templates Settings Reports

o) B 45

Print Page Report Columns Refresh Expand Collapse  Report Export
Preview Setup Settings Data All All Designer To Excel
Report Actions

I

1

Figure 51-L
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13. The Disable Estimate Grid Overtyping, when checked, does not delete existing

text in an estimating field when the field is edited. When it is not checked, any

text in a field is deleted and replaced by newly entered text.

14. The Show Auto Count Tool, when checked, shows the Auto Count tool in the
Takeoff group on the Home tab ribbon-bar (Fig. 51-M).

L.

- -

Area Linear Segment

-

0, 2,
e® /4
Count  Auto

T Count

Takeoff

Figure 51-M

15. The Enable Extended DPI Range for TIFs, when checked, enables higher ranges

of DPI to be entered when pulling in plans.
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Configuring Language and Measurement Type Defaults

The General option under the Settings tab on the Main ribbon-bar menu allows you to
set your Language (Deutsch, English, Espanol, Italiano, or Francais) and Measurement
Type (English or Metric) defaults (Fig. 51-N).

I .
-"‘5‘ Home Page Tools View Estimating Lists Templates | Settings | Reports Help Plugins

Licenze
Manager ~
Licensing
N
----- [rata Storage
General
- Company
- Kepboard Hatkeys Automatically open the last job when PlanSwift opens
- Interface Autamatically open the first page of a job when opening
- £oom .-".F'an [] Automatic jurnp ta the last view when opening a page
- nnotations ; i -
- Graphics [] Automatically remove license when exiting
- T akeoff Tools [] Use Internet Explaorer Prasy S ettings
- Snapping
- Motifications Englizh Metric

- Digitizer T ablet Dizplay:  English > Dafault Urits:

- Property Groups
- Advanced Entry: | English )

Language / teasurement Type /Default Currercy

Englizh « | [ Englizh “| |4 -
Deutzch

b etric

E zpafiol
| [talianio
Francais

Figure 51-N
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Managing Data Storage

PlanSwift saves jobs to your local drive by default to this location:

C:\Program Files (x86)\PlanSwift10\Data\Storages\Local\Jobs

The Data Storage option under the Settings tab on the Main ribbon-bar menu allows

you to setup New Storage Locations (Fig. 51-0). You can go to the New Data Storage

article in our PlanSwift Knowledge Base for further instructions, or you can call
PlanSwift for assistance (888-752-6794, Ext. 2).

"o Home Page

License

\ Manager -
“ Licensing

Data Storage
General
Compary
Keyboard Hotkeys
Indesface
Zoom f Pan
Armotations
Graphics
Takeoli Tools
Snapping
Notfication:
Digitizes T ablet
Fropesty Groups
Advanced

Data Storage Locations

1) Mew FolderStonage

[ Automatic Job Mumbering for Mew Jobs

Tools View Estimating Lists Templates Seflings Reports Help Plugins

/

Properties

Mew Storage

Storage Properties
Name
New FolderStorage
Cokor

Folder

Browse For Folder ‘-———

I~
i

(o]

@
2

|
|
i % This PC
[

{BB Desktop

OneDrive - Planswift Software LLC

Libraries
MNetwork
Control Panel
Recycle Bin

Make New Folder

Cancel

" Click on these three

dots to open Browse
For Folder window

Cancel

Figure 51-0
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https://support.planswift.com/support/solutions/articles/5000497582-new-data-storage

Right-Click Menus

PlanSwift includes numerous right-click menus to provide greater functionality and
shortcuts that help to do takeoffs and estimating more easily. Examples of them are
shown below:

1. Right-click initiated on a tab (Fig 52-A):

ﬂ;- Huméack } Eslimating Lists
[ ST—" |
258, & Q ¢
New Open Print Email Back Fwd Zoom
lob A
lob Havigalte
Figure 52-A

Note: The Undock right-click menu can only be initiated on the Estimating, Lists,
Templates, Settings, Reports, Help, and Plugins tabs. It cannot be initiated on
Home, Page, Tools, or View tabs.

2. Right-click initiated on blank space of page canvas (Fig. 52-B):

# New Tab
Show Legend

Bl New Section

o 1) Paste

=== Continue With

"} Undo

CORRADR A0

Figure 52-B
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3. Right-click initiated on a takeoff area (Fig. 52-C):

Show Label

0 Add More Points

B Mew Section

[Z] Subtract From Section (P2P)
Subtract from Section (BOX)

Single Click Subtract Section

Copy
Paste

Delete

0O & &/

Add Point
Add Arc Point

Order 2
Edit Hyperlink...
Send Data L4

Go To ltem in Estimating

e @0

Go To ltem in Takeoff Surnmary

soo Continue With

i Undo

Figure 52-C
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4. Right-click initiated on Pages, Bookmarks, Notes, Takeoff Summary, Templates,

Parts, Attachments, and Inputs windows (Fig. 52-D):

¥ «ll

Pages, Bookmarks

_ — Pages > |
TORSULOS Bookmarks » Undock |
Search: |
Reset Layout Dock Left
EHE AL 1 Community Center -Sa... b ey Dock Riaht
. [ Lobby 101 9008 — act 1
[*1 Exterior Trim wesr MY fie Dock With > <none>
7 Exterior Rock w49 Y I ot e 4 e i1 it e Takeoff Surnmary
3 Exterior Siding 4054507 [l 9 Wi g e e Notes
-] Restrooms 276. 1= T iy T g P i e .

Figure 52-D

5. Right-click initiated on a page in Pages, Bookmarks window (Fig. 52-E):

P Bookmarks «
F+ABCNLOS
Search: *
-l B D r
E£J Lobby 101 & Pproperties
1#1 Exterior Trim
7 Exterior Rodk 1 Copy

L_J Exterior Sidng | 55 Paste
EJ Restrooms
£ Game Rocm
£3 Offices

% * Interior Doors Sort by Name

L.J Conference Rooy a Delete

™% QOpen in new tab

11 Exterior Wals

141 Interior wialls Update Labels

£ Common Roam T T I
Figure 52-E
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6. Right-click initiated on a takeoff item in Pages, Bookmarks window (Fig. 52-F):

43 Home  Page Tools View Estimating Lists Templates Settings Reports Help Plugins = E
== = B s
2 4
- 3|, QaAQ I -
e D‘p!l'l. Pririt Email Back Fawel Zoom Zoom .Z-Dﬂ-l'l'l Pari Scale Dimensian Aregs Limnear Sﬂ'qﬂ'l
lob F‘ngr In = E ® ¥
lab Mavigale Loom / Pan Fleasure
Pages, Bookmarks “
=E+O08RNOS
ch *

E LlTIﬁvaW'm;f E:'? GEt StartEd tOdav w"
| igﬁmﬁ Properties

links, keyboard hotk
LJ“:*' " . Watch our Tutorial Vid

L“' offic (%, Paste
o % Inter

&9 conf ™® Open in new tab D Getting Started D Annotatic

11; E;:: # Go To Page r

& conl ¥ Sort by Name 3 Start a New Project D Creating :
il I:aneia i I
2l AL2rq & Delete D Open Existing Projects 3@ Overlay a
'“: ::"::: Update Labels

Figure 52-F

212



7. Right-click initiated on Snap (Fig. 52-G):

Enable S5nap to Points

Snap to PlanSwift paoil

OO O

Snap to CAD points

O Hover to Snap Axis

'sm|mimeum Verity Ponts |

Figure 52-G

8. Right-click initiated on AutoScroll (Fig. 52-H):

4] | [»
b ~—
T Templates -E[ AutoScrolling
EiParts | Thick Scroll Range
& Attachments | )
= B Visible Scroll Bars

!Et Visible Scroll Arrows |-

| | internet Connected lﬂ
| | ]

Figure 52-H

9. Right-click initiated on Takeoff Summary takeoff (Fig. 52-1):

57 New Area Il
3

171 Exterior Trm ¥ Properties

g k. Go To Page 4

G0 Res Sort by Name

£ Game Room

53 Offices @ Delete

: ® Interior Doors Py e

£ conference Room .

1*1 Exterior walls Copy

1*1 intericr Wals .

3 Common Room Duplicate Ctr

Q}‘ Carpet Brown Paste

3 Carpet Brown

[*1 Foating | Paste as Sub-ltem

7 Roof Area I

7 Rest Room Tie xoes

F: Name =}

[1 Lnear coo M@ |

i, New Segment 000 M 9[+]
Pages, Bookmarks J
Takeoff Summary -
Hotes A

Figure 52-1
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10. Right-click initiated on a layout in Estimating Layouts window (Fig. 52-J):

Estimating Layouts
TH+QC R

<<| PlanSwif

Mame

2 |5§

Basic Layout Properties

i, Waste % Copy

a‘ Round Qtys Paste
----- i Item o

Figure 52-J

11. Right-click initiated on an Estimating item in the layout (Fig. 52-K):

Estimating Layouts  « | PlanSwift Layouts\Basic Layout /
- H + g : # MName Description
@ Plansmift L - L:J-{h|53mple Plan Takeoffs |
e e =53 |Lobby 101 ‘
a - JErp—
Waste %% i
k. Round Gty @ |Celing Grid S
a Item = ¥ [Hardwood Flooring Delete
a‘ Divisian Gﬁ, Install Ceiling Grid and Tiles Sort By MName
a Assembly Total {4 |Installation Contract
- C
a Multiply and Location - [ | Section oRy
a‘ Takeoff View = I:] |Exter|ur Trim Paste
a- Wall Area 1. |Section Paste as Sub-Iltem
il Qty and Qty 2 1. |section
a, WES 1. |section Columns...
b, TokeoffData L. |Section Fill Down
a Default 1., |section -
[+ PS Layouts =3 I:] |Exter|ur Rock i
..... |Sechun Fill Sequence
| T

Figure 52-K
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12. Right-click initiated on an Estimating total (Fig. 52-L):

15,63

433,53 |SQ FT

I .

o0 om a  so.00|  s0.00)
wo  Average o] w0 000 mem
£0.0 Count a . £0.00 £0.00
$0.0 0 $0.00 00 .
T e "o s0.00]  s0.00 mmm
Min (0| $0.00)  $0.00 NN
0l .00 00| .

MNone L« #nol

— £1769,12

Figure 52-L

13. Right-click initiated on an Estimating Name column (Fig. 52-M):

N\

Estimating Layouts | PlanSwift Layouts\Basic WN
| B0 ) Hame: S —
E _H S (= ] IZlDescnptlon
=8 PlanSwift Layouts =
Effebbyor Zlmx
o, Waste % o Contract .
i, Round Qtys & |Hordwood Flooring ﬂ Price Each
b, Ttem £ & |Ceiing Gnd E O
i, Devision @ |Acoustical Celing Tie Price Total
i, Assembly Total G:P st Ceing Grid and Ties Lisiear Total
. Multigly and Location
i, Takeoff View 5 () [Resdennal lan Takeoffs Wall Area
bl sl Area B [rea -
i, Gty and Qty 2 @ (e [+] cotor
» &g rea ay?2
i, TakeofF Data & irea _
el Defauilt 0 [ares OC Spacing
LS LR €3 ares Multiply
7 |Area
¥ Roof Area Unit Qry
CJ |area Units
£ [Area g
3 [area E Units
EJ Area Units
g :’r: Unit Price
7 |area 3 Cgst Each
G |Area
€7 |Area 3 Markup %
By area Location
£ |Area Ty
£7 [Area Division
p Item #
£ |area
EJ |Area Units
3 |Area nath
7 |Area Leng )
3 Mine Wall Height
& jaren L # of Wall Sides
€3 |Area :
€3 New Area ‘Width
49 [Three - gerage Length
=4 [*1 [Exterior Trim
T Toecaon Depth
L fectim Thickness
L. |Section
L. [secoon Area
IL- Point Count
€3 [Exterior Rock
W Waste %
3 [Exterior Siing SubDiyision

3 Name
[¥] cost Total

Timestamp
Round Quantities

Best Fit All

Figure 52-M
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14. Right-click initiated on a Templates window template (Fig. 52-N):

Templates ”»
BHBOO
€9 Samole Assembies v]

=M Custom Advanced Assemblies

Figure 52-N

15. Right-click initiated on a Lists window list (Fig. 52-0):

#3) Home Page Tools View Estimating = Lists

New Delete Properties MNew

Folder -
Lists

| ] Parse Formula

T 2x4
11 (2x6
2x8

- 0
) Bectrical # Properties
Mew
) Delete

Figure 52-0

216



16. Right-click initiated on a Templates assembly (Fig. 52-P):

dnjmmepane- Tools View Estimating Lists Template

B °®

New New  New New New New
Area - Linear~ Segment- Count~

: 1= [Water Line Stub Properties...
157 [Temporary Fencing Delete

+ * [Temp. Utiity Pole

Reload

% £202.4 Demalition (Div 02.40.C
#2030 Conaete v 03.00.00  Sort By Name

% £2(03.2 Concrete Reinforang [

O[040 Mosowy O oacoo P

4 23|05.0 Metals (Div 05.00.00) Paste

#100/05.4 Metal Framng (Bv 05+ Paste As Sub-Item
#12|06. 1 Rough Carpentry (Div ¢

#1120(08.2 Finish Carpentry (Div 0 Columns...

# 2[07.2 Thermal insutation w

# (22(07.3 Roofing Div 07.30.00) Fill Down

& £2(07.4 Siding (Dw 07.40.00) | Fill With

#10|08.0 Openings v 0B.00.0 ) Saquence

# £2(09.2 Gypsum Board (iv 09 : y

Figure 52-P

17. Right-click initiated on a Templates Sample Assembly Name column (Fig. 52-Q):

) Home Page Tools View Estimating Lists

New New
Linear - Segment -

Name

Description

@ ZWxZLxl1”

& 10" wall Angle (price
@ 12 Mans (priced EA
& |4 T (priced £8) Color
& 2T (priced EA) Phase
& | T 12 ga. Hanger Wi
7 |ACT Labor (priced p Copst Each

Price Each

[

£ A b oo e Waste %

% |7 |concrete Footing Assen

# 1 | Wood Framing Assembly Markup %

-1 |Drywall wal Assembly Diyision

[# [=1 |Interior Trim Assembly

([ |Painted Wal Qty

[ [y Biock wall Jcon
Assembly Total
Round Qtys
Best Fit All

Figure 52-Q
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18. Right-click initiated on any tab inside of the Templates tab (Fig. 52-R):

#3) Home Page Tools View Estimating Lists Templates | Setiin

—

O ¥ I1 -
EW Mew  New Mew Mew Mew Mew
Area - Linear - Segment - Count- Assemb

£3leasq Lelete Tab

€2/527  Export
F
g % Compile Tab
£3|5QR Hide Tab
C3|sqF b | O
r7 sqA|_Hidd Tabs Sample Takeoff Templates
B .;jihgmn‘rmﬁ‘s & Parts and Assemblies
#00 [Unear Takeofls T
# I3 | Count Takeoffs Links I|
# {2[010 Gen Requrements O 01.00.9  How To Examples
# {)|02.4 Demolition (Div 02.40.00)
5 £5(02.0 Concrete (Div 03.00.00) Test Template

Figure 52-R

19. Right-click initiated on a Report Layouts report (Fig. 52-S):

Properties

p.i Al Ttems (by Folder, by Type)

Figure 52-S
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Developer Overview

PlanSwift includes a powerful Scripting Interface feature that allows you to create your
own ribbon-bar buttons and assign scripts to them.

PlanSwift does not provide technical support or advanced training for the Developer

Tools or the Tools Manager. This overview is for developer use only. You are on your
own!

Before using Developer Tools and the Tools Manager be sure to back up your jobs. To
use the Scripting Interface, follow the steps below.

1. Click on Plugins on the PlanSwift Main menu ribbon-bar (Fig. 53-A).

"‘}:',J Home | page Tools View Estimating Lists Templates Settings Reports Help Plugins Search

S, QaaQQf - < My

Mew  Open Print  Email Back Fuwrd Zoom Fit Zoom Zoom Pan Scale Dimension Area  Linear Segment
Job Page In Cut i 2 i i
Job Mavigate Zoom / Pan Measure Take
Pages, Bookmarks “

ow" Videos |

i- Read Our I

- . P - e

Figure 53-A

2. Click on the Tools Manager on the Plugins ribbon-bar menu (Fig. 54-B).

f“_"‘) Home #Page Tools View Estimating Lists Templates Settings Reports Help | Plugins 5

L] P |
= A €

s [ )
Tools Import Plugin -~ Uninstall Home Back Forward Refresh

Manager Package Plugin
Plugin Tools MNavigate

Figure 53-B
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3. In the Tools Manager window (Fig. 53-C), click on the green plus (+). Note that
the yellow folder icon allows a new folder to be created for storage of plugins.
The blue gear icon allows the viewing of properties for any plugin in the window
below. The red "X" icon allows for a plugin to be deleted. The green triangular
icon allows a selected plugin to be executed.

Figure 53-C

4. In the Properties - [New Plugin] window, give the new plugin a name, such as
“My Plugin” or whatever name you choose for the new plugin (Fig. 53-D).

- Propertie%w Plugin] x H
Name I

Icon Largelcon

Plugin Type
Executable -

Executable

Parameters

OnStartup

On Ribban Bar

Input Advanced Form Ok Cancel

Figure 53-D
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5. Select the Plugin Type by clicking on the Plugin Type selection arrow and then
selecting Script Code from the drop-down menu (Fig. 53-E).

#* Properties - [New Plugin] = r

Hame
My Plugin

Icon Largelcon

\ =5

Sheld Execute
Executable

Parameters

OnStartup

On Ribbon Bar

Input Advanced Form Ok Cancel |

Figure 53-E

6. The Plugin Type is now displayed as Script Code (#a in Fig. 53-F). Double-clicking
on the Icon (#b) or the Largelcon (#c) allows the selection of a small Icon or a
Largelcon.

“* Properties - [Mew Plugin] >

Name
My Plugin
Icon Largelcon

- .

Plugn Type §
fscript Codel -
Seript Code

Edt

OnStartup

On Ribbaon Bar

Input Advanced Form Ok Cancel

Figure 53-F
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7. You can select where you want the new icon to appear (Fig. 53-G):
a. OnStartup (executes the plugin upon PlanSwift startup)
b. OnImage Menu (adds your plugin to the right-click menu)
c. On Ribbon Bar (adds your plugin to the ribbon-bar)
d. Ribbon Tab (specifies a default tab for PlanSwift and is not customizable)
e. Ribbon Group (Specifies the ribbon group and is customizable).

% Properties - [Mew Plugin]

Mame
|I"«'11,-I Flugin |
Icon Largelcon
Plugin Type
Script Code -
Script Code
Edit
[] OnStartup
o—p [7] On Image Menu
Ribbon Tab Ribbon Group
[vf On Ribbon Bar Tools| - ||'“'|‘r' Plugin -
Home
Page |
—_ View
Input Advanced Forn Estimating || Ok Cancel
Lists
Templates
Settings ~
Figure 53-G
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8. Click on the Tools tab on the Main Ribbon-bar menu, and you will see the new
"My Plugin" plugin displayed in the Takeoff Item group (Fig. 53-H).

e
Tools | view Estimating Lists Templales Sellings Reports Help Plugins
— —_— - [ &
N w A | \f_g 1 4. ¥ m =
Flip 1 Pitch | Thangulate POF to TIF Iip Unzip Attach Excel Open Excel Save My
rtically nta Converter Swiftlob  Swiftlob File to Job File in Job Screenshot Plugin
tltem Caleulations Carvert ip Excel Files Cther My Plugin
“
T © @
X
Frona ¥, & Tools Manager = |
poaa |
o0 M ¥ O+ B0 b
loe o000l 7
e1ss IR e |
1290 M Meme |
wao: = ) Update Costs
134,58 =
x5 WV
1576« 1A
1400 0 ¥
om 269 W §
187.3 W 7
Figure 53-H

9. Double-click on My Plugin in the Tools Manager window to re-open the
Properties - [My Plugin] window (Fig. 53-I). Click on Edit.

& Properties - [My Plugin]

x|

Name
My Plugin

Icon

Piugin Type
Script Code

Script Code

OnStartup

On Image Menu

Ribbon Tab

w On Ribbon Bar Tooks

Input Advanced Form

Largelcon

v

Ribbon Group
* | My Phugin -

Ok Canicel

Figure 53-I

223



10. This opens the Script Code - Script Editor window (Fig. 53-J). The large Script
Editor window on the right is where the plugin code is written. The Code
Explorer window will list variables and procedures as they are coded into the
Script Editor window. The Help window contains the COM Object Model and
Scripting selections available to use in the Script Editor window. Clicking on the
"+" symbol opens the folder and subfolders. Click on the "+" left of COM Object
Model, then click on the "+" left of the IPlanswift folder.

& Script Code - Script Editor - O X
“ % Run =] Execution Point & Trace Into *@ Toggle Break [ Edit Parameters EM
Pause [ Reset Script &' Return | Save To File
Accept Save Cancel View Br Settings
S - % Compile | "7 Step Over Run To ol BI__oad From File 2
Close Script Run Script Debug Script Break Points Script Parameters

Code Explorer / Help « N

@

\7) Scripting

Figure 53-J
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11. Clicking on CurrentVersion (#a of Fig. 53-K), then clicking on the question mark
(#b), opens the CurrentVersion window (#c), which provides the name of the
Declaration and its description with a Source Code example. Source code may
be copied and pasted into the Script Editor window and then modified as
needed, or the CurrentVersion selection can be double-clicked on and will
appear in the Script Editor window at the cursor's last position. The Close Script,
Run Script, Debug Script, Break Points, and Script Parameter ribbon-groups
provide the tools needed for scripting.

& Script Code - Script Editor . 0
v b e 7 Run & Trace Into ‘@ Toggle Break {2l Edit Parameters &j
Reset Script " Rett kil Save To File ;
Accept Save Cancel » . W Rraa Settings
% Compile = 'g*Step Over Run Tc ; 2 Load From File
Close Script Run Script Debug Scrnipt Break Points Script Parameters
Code Explorer / Help « -
& CurrentVersion - O X
CurrentVersion ~
Declaration: CurrentVersion;
@ !—\Q Returns the current version of the active PlanSwift application.
< COM Obj
= Planswft Source Code:
About
Begrlipdate
BegnFormulaUipdate e
CancelToal MaT . :
CoseXcs sVersion: string;
CompareVersion begin ) ) )
Copyltem sVersion := PlanSwift.CurrentVersion:

Currentviewport
Deleteltem

Figure 53-K
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Managing PlanSwift Licenses

Activation and How Licenses Work

When you first download PlanSwift, you are given a customer number and pin number
(through email) that will give you full and free access to PlanSwift features for two
weeks. After that period, PlanSwift reverts to a viewer-only mode unless you contact
PlanSwift and purchase a license for the software. Upon payment and activation,
PlanSwift is restored to its full functionality.

If you have PlanSwift installed on more than one computer but have only one license
(or you have fewer licenses than you have computers that PlanSwift is installed on),
then the PlanSwift license can be removed (deactivated) from an activated computer
and then reactivated on a different computer. PlanSwift requires reactivation at least
every ninety days and can be modified to be a shorter reactivation period within the
My Account customer portal. The deactivated PlanSwift software will then have
Viewer-only mode capabilities. The software title bar to the right of the ribbon-bar tab
shows whether you are in Viewer mode or not (Figure 54-A).

b

Figure 54-A
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Activating PlanSwift

To activate PlanSwift (see Figure 54-B):

1. Start PlanSwift.
Click on the Help tab.
Click on Activate PlanSwift Professional.
The Activate Product window appears.
Enter your Customer #.
Enter your Pin #.

N o v ks wN

Click on Activate Now.

Seftings Reports  Help | Plugins ==

® 2 0 # .

#3) Home Page Tools View Estimating Lists Temy

# ~ 2]

]
Activate PlanSwift

Your Customer # ; dave.hansen@plansw

Home Back Forward Refresh Check for Remaote About Report Feature
Professional Updates Assistance aBug Request
Navigate Licensing About Beta Tools Support

Activate Product

'\Q Activate Product

Product: Professional 10.2

Customer # hansEﬂE'lanswift.a:-j.' Suppor-t Options

Pin# [sssssssssss Feel free to give us a call at 888-752-6794 Option 2.

If for any reason this form is having troubles, you
can manually activala tha softwara with an
aciivation coda.

Forgot Codes?
f*i showMeHow  Manual Activation

Figure 54-B

227



8. The Successfully Activated window appears upon successful activation (Fig. 54-
C). The reactivation date, by default, is ninety days from the day you last
activated (although the date could be sooner if you or your account
administrator has modified it in My Account).

Successfully Activated ‘—Q o |

Successfully Activated

y Online Tutorial Videos

Figure 54-C

9. If your computer is not connected to the internet, then click on the Manual
Activation button (Fig. 54-B) to open the Manual Activation window (Fig. 54-D).
You can use another connected device, such as a smart phone, to obtain an

activation code.

Manual Activation 4—0 X

& This software is protected by security codes.
Please enter a valid Activation Code.

You can obtain an Activation Code via a web browser,
https: /A planswift. com/activate

Product: Professional 10.2
Computer ID: Your Computer ID here

Activation Code: Your Activation Code here

) Activate #¢ Cancel

Figure 54-D
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Removing a PlanSwift License

To remove a PlanSwift license:
1. Click on the Help tab on the Main tab ribbon-bar (Fig. 54-E).
Click on the Software License Options button.
Select Remove License from the drop-down menu.
Click on Ok in the Remove Product License window to remove the license.
You are informed that the licensing has been removed from your computer.

vk wn

J 1

ting Lists Templates Seftings Reports “e%gins e E

Software License | Check far te About  Report Feature
Options - Updat Assistance a Bug Request

Navigate Remaove License About Beta Tools
Re-enter Activation Code

#%) Home Page Tools View

L ~

Home Back Forward Refresh

Rermove Product License ‘—o w0 | Remove Product License

This will remove the licensing of Licensing of
Professional 10.2 Professional 10.2
from this computer., [ | has been successfully removed from this
computer.

Are you sure you want to continue?

[P | | 98 cone

Figure 54-E

To activate PlanSwift on a computer that is in Viewer mode, see Activating PlanSwift.
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Automatically Removing a PlanSwift License

If you use PlanSwift on more than one computer, PlanSwift can automatically remove a
license when it is closed so that it can then be activated on a different computer. To
automatically remove a license, click on the Settings tab, click on General, and then

click on Automatically remove license when exiting (Fig. 56-G).

License
Manager ~

Licensing

- Diata Shar
- General
- Compan

- |nterface

- Zoom # Pan
- Annokations
- Graphics

- Takeoff Tools
- Shapping

%‘ Home Page Tools

- Fevboard Haotkeps

View Estimating Lists Templates | Settings | Reports

General

Automatically open the last job when PlanSwift opens
Autamatically open the first page of a job when apening

[ ] Automatic jump to the lazt view when opening a page

dutomatically remove license when exiting

[ ] Usze Internet Explorer Prosy Settings

Figure 54-F
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Re-activating, Removing, and Deleting Plugin Licenses

PlanSwift plugin licensing is handled in the Settings tab (Figure 54-G) by clicking the
License Manager. This opens the License Manager window where you can Re-activate,
Remove License, or Delete a license. Click on the plugin, then click on the button for
what you want to do. Deleting the license does not uninstall the plugin.

10/) Home/ﬂ Tools View Estimating Lists Templates @ Settings | Reports Help Plugins Search

Licenze
Manager ~
Licensing
- Data Storage | License Manager
- General
- Cormpany .
 Keboard Holkeys O License Status & Reaciae g
- Interface Concrete Starter Pack 1.0 ¢ 5/28/2018
. iii:t;,zz: General Contractor Starter Pa... # License has expired.
---Eriphi;ST | Masonry Starter Pack 1.0 % 6/8/2018 ¥ Remove License €
g Professional 10.1 $ 3/15/2018
- Motifications i
Dt ot Professional 10.2 «” 10/26/2018 ® ookt
- Property Groups SWI&MEDS 1.0 R 6}’13}’20 18
+Advanced . ZoneTool 1.1 ¥ 7/25/2018

Figure 54-G

231



My Account

PlanSwift provides a My Account portal to access licensing, support, and company
account settings. Click on the Help tab on the ribbon-bar menu to display Support

Options (Fig. 55-A). Click on My Account and login (or create an account) to view the
My Account window.

ﬁ} Home Page Tools View Estimating Lists Templates Settings Reports  Help | Plugins kol || Linck

ol < ® 2 0 # «

Home Back Forward Refresh Software License  Checkfor  Remote About Report  Feature
Options = Updates  Assistance aBug Request

Mavigate Licensing About Beta Tools Supg

Your Customer #: dave.

Support Options

Feel free to give us a call at 888-752-6794 Option 2.

a” »

My Account® Tutorial Videos#'

Figure 55-A
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The My Account window (Fig. 55-B) allows you to access support and view and change
your account details and password. The information on licensing is found under

Licenses.

1. The Licenses tab in My Account displays the current licenses and activations of

your licenses.

vk wnN

Click on the arrow to view your activations by computer name and by username.
Shows the total number of Seats in your company.
Allows you to Download the install file for PlanSwift software.

Allows you to temporarily activate PlanSwift in cases where users have forgotten

to deactivate the licensing on another installed machine (Temporary Override
may only be used once per month per company account).

e planswift

he #1 Takeoff & Estimating Software

[RelciolU))

Home This page will display your licenses!

Account

My User o

licenses.

/ PLANSWIFT LICENSES

PLANSWIFT PLUGINS

Here you will find all the information needed for all of your PlanSwift licenses, plugins, or Bid Organizer

©0

|

Licenses
Description Type Expires Maintenance Seats Download
Expiration
Support
¥ Professional 10.2 License |:gn 19th, 2019  Jan 19th, 2019 10 o
TEMPORARY OVERRIDE
Activation Date Computer Name User Name Expiration Date Activation Type
Jan 3rd, 2018 DH- DH Jan 10th, 2018 User: dave @planswift.com
Mar 13th, 2018 NATE Natg Mar 20th, 2018 User: nate. @planswift.com
Mar 23rd, 2018 [ Kristi Mar 30th, 2018 User: kristi dplanswift.com
Mar 28th, 2018 DH o DH Apr 4th, 2018 User: dave @planswift.com
Iar 30th, 2018 Tyson. Apr 6th, 2018 User: Tyso @planswift.com
May 18th, 2018 F ™ Kade May 25th, 2018 Pin:
Oct 1st, 2018 I Dave Qct 8th, 2018 User: dave @planswitt.com
Figure 55-B
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FAQ

Question: I've read this User Guide, and | still have questions. What do | do?

Answer: We highly recommend new users purchase a training package because
training is customized to each user. We offer one-on-one training and classroom

training. Contact training@PlanSwift.com or at 1-888-752-6794 Ext. 4.

Question: Why is my digitizer stuck in box mode?

Answer: The button controlling Box Mode is only visible at the bottom of the
PlanSwift window when Digitizer Record is on (Fig. 56-A). The Record Mode
button toggles between Box and Point-to-Point (Fig. 56-B).

Digitizer Mew
Record ™ | Section ™
Record

Figure 56-A

]m|m| FreeHand |".-'erif'_.r F‘nint5| Record Mode: Point To Point |

|ﬁ|m| FreeHand |V'3Fif'.-' F‘nints.l Record Mode: Box |
Figure 56-B
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mailto:training@PlanSwift.com

Question: Why does a Confirm Dimensions Properties box keep popping up whenever
| am using the Dimension tool?

Answer: First, check that PlanSwift is activated. Second, if PlanSwift is activated,
go to the Settings tab on the ribbon-bar menu, click on the Takeoff Tools group,
and uncheck the Confirm when recording dimensions box (Fig. 56-C).

‘"ﬁj‘ Home Page Tools View Estimating Lists Templates | Settings
License
Manager 7
Licensing
- [rata Storage
- General Takeoff Tools
- Company
- Keyboard Hotkeys Default Transparency
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Count
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Less [ | Mare
Yerfy pointz when recording
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Figure 56-C
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Question: Why do | get an error message when | try to import PDF drawings?

Answer: Go back and try adding the page again using the Add Pages feature (Fig
56-D), and try lowering the DPI (dots per inch) by 50. The optimum range is 50-
300 DPL. If the problem persists, call Technical Support at 1-888-752-6794 Ext. 2.

# Add Pages

Convert Settings

Select the settings for converting image files to be used by PlanSwift,

PDF
Canwvert POF files ta TIF

DFI far TIF Files:

Fiecommended |

Format: | Grayscale (16 shades) ~

“note: Although PlanSwift will load ROE-filee aena oo
per fionmance.

sk km ek b

to TIF for better
50-300 DPI is the optimum range.—|

Other Formats
Corvert Cal files to TIF
Corvvert DUV files to TIF

“note: PlanSwift will not be sble to load these formats if they are not converted.

bulti-Page TIF

Split mult-page TIF filez into 2eparate files

Large TIF files
Downgize large TIF files

Fage Maming
Iz Page Mame O efault [Title][-[Pa#]

*Use [Title] for the image title, [pg#] for the page number, and [-] for 3 dash if there is a page # Add
sdditional text 35 necessany to the formuls.  Single images will not display a3 page numbsr.

Show Me
E > E How Back Mext

Cancel

Figure 56-D

236



Question: How do | set a custom scale that is not listed in the drop-down list?

Answer: Click on the Scale button on the Home tab ribbon bar (Fig. 56-E), click
on the Auto tab in the Scale window, select the scale closest to the scale you
want. Click in the field with the value and edit it to your custom value.
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Search: X Standard “LF-5 U Metic | Auta "
EHE] A1.1 Community Center -5a.., H - € S v| |
-7 Lobby 101 900.9 sg T . - |
. . WARNING: Automatic setting of scale is only as
I:I Excterior Trim 108.9 /m - EJ accurate as the scanned in drawing. MAKE SURE
-7 Exterior Rock a0 Y ¥OU DOUBLE CHECK SEVERAL DIMENSIONS ON
q . - THE PAGE TO MAKE SURE THE SCALE WAS SET
Exterior Siding 4054 Y ACCURATELY.
-] Restrooms 276.1 %y FT o
I3 Game Room 6276 Il Q h
-] Offices 32277 I Y
-4 ® Interior Doors o= Y [ 4pply Scale to ol pages. Clear Scale
-] Conference Room  505.5 Pl v Automnatically create dimenszion line
-[*1 Exterior Walls 61 Y
Show Me
- 11 Interior Walls 244 Y E bE How “ Cancel
Cﬁ Commaon Boom 095,44 =0 T - J

Figure 56-E

Question: It seems like PlanSwift has so many features: how does a particular feature
apply to me?

Answer: PlanSwift is designed to be as basic as you need it to be and powerful
enough to grow as your business grows. While a feature may not apply to you
directly, knowing the use of the feature may help you in a way you never
anticipated. We highly recommend purchasing a training package to discover
how particular features can apply to you.
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Question: When | try to activate, | get a message that says: “No Internet Connection.”

Answer: Manually activating PlanSwift can resolve most issues related to this
message (Fig. 56-F). Closing the No Internet Connection window opens the
Manual Activation window (Fig. 56-G). If your computer is not connected to the
internet, you can use another connected device, such as a smart phone, to
obtain an activation code via a web browser using this hyperlink:
https://www.planswift.com/activate.

Or you can call PlanSwift to obtain an activation code over the phone (888-752-
6794, Ext. 2).

If your internet is connected and a firewall is preventing PlanSwift from
connecting to the internet, then click on the hyperlink (Fig. 56-G) in the Manual
Activation window and follow the instructions (see Fig. 56-H) from there.

PlanSwift has detected that you are currently not connected to the internet or
a firewall may be preventing PlanSwift from connecting to the internet.

You must have a working connection to fully utilize the PlanSwift Help
System, Licensing Servers or to obtain program updates.

If you require assistance please contact your PlanSwift support
representative.

If you feel that this is a firewall issue please check your firewall settings or
contact your system administrator to add PlanSwift to your firewall exception
rules.

Figure 56-F
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Manual Activation >
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Activation Code: |

5 Activate 3¢ Cancel

Figure 56-G

gra planswift

The 1 Takeoff & Estimating Software

Software Activation Step 1

Computer ID:
Customer #/ Email:

Pin #/ Password:

Next Step —>

Figure 56-H
Question: When | try to activate, | get a “No condition met” message?

Answer: Make sure there are no space characters when entering your customer
number.

Question: Why can’t | activate and use my plugin? A message says the license is active
on another computer.
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Answer: Plugins have their own licensing that needs to be removed from the
computer it is activated on and then reactivated on the computer you are using.
To remove plugin licensing, click on the Settings tab and then License Manager.
Select the plugin, then click on Remove License (Figure 56-I).
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Figure 56-I
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Question: | keep forgetting to deactivate PlanSwift when | want to switch which
computer | am working on. Is there an automatic way of doing this?

Answer: Yes. Under Settings, General, click on Automatically remove license
when exiting (Fig. 56-J).
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Figure 56-J

Question: Why do | get a conversion error?

Answer: A conversion error happens when you have an impossible conversion in
the INPUT/OUTPUT Column on the property. For example, PlanSwift can covert
Feet to Inches simply by selecting FT in the Input box, and IN in the Output box,
but PlanSwift cannot convert feet to square meters or meters to cubic yards
because a dimension is missing.
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Question: Why do | get a loopback error as a result?

Answer: A loopback error occurs when you are trying build a formula and you
use a property in a loop. For example, if you drag and drop the QTY property
into the Cost Each property and then drag the Cost Each property back into the
QTY property, that would result in a loop.

Question: Why do | get a syntax error as a result?

Answer: A syntax error usually occurs because of an incorrect character or
characters in the Formula Box. For example, if you left off a bracket [ ] when
trying to inherit a property, ([Area]/([Length * [Width]), or if your formula had

two multiply signs ([Area]/([Length] ** [Width]), both of those would result in a
syntax error.
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